




SAFE (Foundation Design)
COURSE CODE: CE 0732-3202                                                                                                CREDIT: 01

CIE MARKS: 30

SEE MARKS: 20

CLO 01 Differentiate between d ifferent foundation types like iso lated footings,
comb ined footings, mat foundations, and p ile foundations.
CLO 02 Create accurate 3D models of foundations in CSI SAFE, incorporating so il
properties and load ing cond itions.
CLO 03 Conduct structural analysis of foundations to determ ine stresses, deformations,
and safety factors. Design foundations to meet relevant codes and standards.
CLO4 Analyze the results of the analysis to assess the performance of the foundation and
identify potential issues.



Sl. Course Contents Hours CLOs

1 Introduction to csi SAFE software & foundation
-An introduction to the csi SAFE software, a powerful too l
for the analysis and design of foundations and geotechnical
structures.

10 CLO 1

2 Design of Iso lated Sing le Co lumn Footing
-Design and analysis of iso lated sing le co lumn footings
using the SAFE software, includ ing load comb ination checks
and detailing .

10 CLO2,C
LO 3,
CLO4

3  Design of Comb ined Footing
-Application of the SAFE software for structural analysis and
design of comb ined footings to support multip le co lumns,
considering so il-structure interaction and load comb inations.

35 CLO2,C
LO 3,
CLO4

4  Design of Mat Foundation
-Principles and practices for designing mat foundations,
covering so il-structure interaction, load d istribution,
structural analysis, detailing , and construction
considerations.

30 CLO2,C
LO 3,
CLO4



5 Design of Pile  and Pile cap
-Exploration of princip les and methodo log ies for designing
p iles and p ile caps for various load ing cond itions

30 CLO2,C
LO 3,
CLO4
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Week Topic Teaching Learning
Strategy

Assessment
Strategy

CLOs

1 Introduction to csi SAFE software &
foundation

Lecture, Oral
presentation

Lab Test, Quiz
and Report

CLO 1

2-4 Design of Iso lated Sing le Co lumn Footing Lecture, Discussion Lab Test, Quiz
and Report

CLO 2

5-6 Design of Comb ined Footing Lecture, Discussion Lab Test, Quiz
and Report

CLO 3

7-9 Design of Mat Foundation Lecture, Discussion Lab Test, Quiz
and Report

CLO 3

9-11 Design of Pile  and Pile cap Lecture, Discussion Lab Test, Quiz
and Report

CLO 3

12-13 Practice, Review/Reserved Day Lecture, Discussion Lab Test, Quiz
and Report

CLO 4

14-15 Lab Report Assessment, Self study Lecture, Discussion Lab Test, Quiz
and Report

CLO 4

16-17 Lab Test, Viva, Quiz, Overall Assessment, Skill
Development Test (Competency)

Lecture, Discussion Lab Test, Quiz
and Report

CLO 4



Introduction to csi SAFE

 software & foundation 

         Week 1
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1. Introduction 
 
Foundations are components of a structure which ultimately transfer loads from 
the superstructure safely into the soil. Foundations are alternatively named as 
footings. Depending on the mechanism and the depth of the soil to which the loads 
are transferred, foundations can be broadly categorized into shallow foundations 
and deep foundations. Shallow foundations are those where the foundation loads 
are transferred to a soil at shallow depth and where the load transfer mechanism is 
predominantly through resistance of the soil at the bottom of the foundations. The 
depth of shallow foundations is usually less than their largest dimension. 
Foundations which transfer the superstructure load to a soil layer found a large 
depth are said to be deep foundations. The resistance soil force on deep 
foundations is generated through two mechanisms; namely, tip resistance and side 
friction. This tutorial is entirely about shallow foundations. 
 
Depending on the number and arrangement of columns they support and their 
geometry, shallow foundations can be classified into isolated, combined, strip and 
mat. 
 
Isolated footings (or as sometimes called spread or single footings) are footings 
which support only one column. The load from the column may be only 
concentrated load, only moment or a combination of concentrated load and 
moment. The shape of the footings may be square, rectangular or circular. 
 
Combined footings are footings which support a number of columns along a single 
row. The number of columns is usually two. However, more than two columns can 
also be present on combined footings all aligned along a single row. The ratio of 
the longer side to the shorter side of these foundations shouldn’t be considerably 
large. The shape of combined foundations can be either rectangular or trapezoidal. 
 
Strip foundations are those foundations where the shorter dimension of the 
foundation is negligible as compared to the longer dimension. The load on strip 
foundations may come either from a number of columns are from a long wall. 
 
Mat foundations are foundations which support many columns arranged in more 
than one row i.e. in two dimensions. These foundations may support all the 
columns of the entire building or a number of columns from portion of the 
building. 
 
During this tutorial, it is assumed that the user has prior knowledge about the 
theoretical design process of shallow foundations. 



Design of isolated Single Column Footing
                 

     Week 2-3
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2. Isolated (Single) Footing 
 

In this part of the tutorial, an isolated footing will be designed in three different 
ways. First, a square isolated foundation will be designed using the built-in model 
of the software itself. Then a rectangular isolated foundation will be designed using 
grids. Lastly, a circular foundation will be designed by importing the geometry from 
AutoCAD. In all sections, a design problem will be given first and the procedures 
which will be followed to carry out the design process in SAFE program will be 
detailed. 

2.1. From the Built-in Model 
 

 

STEP 
1: 

Creating the Model 

To create a footing model from the built-in program, there are three ways.  

a. Go to File menu and click on New Model … 

b. Click on the icon  . This icon is the first among the list of icons just 
below the menu bar. 

c. Simply click on the Ctrl and N keys simultaneously (Ctrl+N). 

Performing one of the above three ways results in the popping-up of the 
following ‘New Model Initialization’ window. 

Design a square isolated footing with the following parameters: 
• Dimension of the footing: 2.5mX2.5m 
• Dimension of the column: 0.5mX0.5m 
• Ultimate bearing capacity of the soil : 100kN/m2 
• Maximum allowable settlement of the foundation: 10mm 
• Concentrated load (DL) : 300kN 
• Concentrated load (LL): 140kN 
• Grade of concrete: C-25 (25MPa 28-day characteristics cube strength) 
• Grade of reinforcement bar (rebar): S-300 (300MPa characteristics yield 

strength) 
• Overall thickness of the foundation: 500mm 
• Concrete cover : 50mm 
• There are no bending moments on the column 
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Figure 1 

This window consists of two parts: the ‘Design Data’ part and the ‘Initial Model’ 
part. In the ‘Design Data’, there are ‘Design Code’, ’Design Preferences’, 
‘Project Information’ and ‘Units’. 

The ‘Design Code’ consists of a list of selected design codes from many countries. 
Depending on the suitability of the code for your country, you may select one 
among the list of codes. The design code which follows similar design philosophy 
to my country code is BS 8110-1997. So, this design code is selected. 

After selecting the design code, it is better to first select the units to be used in the 
design and analysis process. These units can be selected by clicking on the 
‘Modify/Show’ button in front of ‘Units’. The following window pops up when 
the button is clicked. To choose metric units, click on ‘Metric Defaults’ button. 
The click results is metric units for best practices to be selected. It can be observed 
that, even though all the units are metric, they are not consistent. To select a 
preferred consistent unit, click on the ‘Consistent Units’ button. In this ‘Units’ 
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window, the decimal places and minimum number of significant digits for any 
quantity can also be modified. 

 

Figure 2 

By clicking on the ‘Modify/Show’ button in front of the ‘Project Information’, 
information regarding the project, the company and the model can be entered. 

By clicking on the ‘Modify/Show’ button in front of the ‘Design Preferences’, 
the user preferences regarding the design code, concrete cover for slabs and beams, 
post-tensioning can be changed. The following ‘Design Preferences’ window 
pops-up when the button is clicked. The ‘Min. Cover Slabs’ tab of the window 
may be of interest for this particular problem as footings will be modelled as slabs. 
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Thus, click on this tab. This is the tab where the concrete cover and preferred rebar 
size will be entered. 

 
Figure 3. 

In the ‘Min. Cover Slabs’ tab, for ‘Non-Prestressed Reinforcement’ , both the 
‘Clear Cover Top’ and ‘Clear Cover Bottom’ should be set to 50mm as the 
concrete cover in this design problem stated to be 50mm. The ‘Preferred Bar Size’ 
can be set to any reasonable value. Here, the ‘Preferred Bar Size’ is set to 20 which 
is the diameter of the rebar in mm which will be used as the main reinforcement in 
the foundation. Leave the rest at they are. 

Once everything is set correctly in the ‘Design Data’ box, go to the ‘Initial Model’ 
box and select the suitable model. Since, an isolated (single) footing will be designed 
click on the big square button just above ‘Single Footing’. The button itself shows 
a plan view of an isolated footing. When the button is clicked, the following ‘Single 
Footing’ window will pop up. In this window, there are three boxes: ‘Plan 
Dimensions’, ‘Load’ and ‘Properties’. 
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In the ‘Plan Dimensions’ box, the footing and column dimensions will be entered. 
While entering the footing dimension, it is the distance from the center of the 
column to each of the edge which will be entered not the actual dimension of the 
footing. Since the column is located centrally on a 2.5mX 2.5m square footing, the 
distance from the center of the column to all the edges of the footing will be 1.25m. 
Thus, set all the values of ‘Left Edge Distance’, ‘Right Edge Distance’, ‘Top 
Edge Distance’ and ‘Bottom Edge Distance’ to be 1.25m. These values may be 
accordingly changed depending on the location of the column on the footing. 

 
Figure 4. 

The text field in front of the ‘Load Size (Square)’ is the field where the column 
size for square columns will be entered. Since in this design problem, the column 
is of dimensions 500mmX500mm, enter 500 in the text field as the unit is already 
in mm. For column shapes other than square, just enter a preliminary column 
dimension and you can change both the shape and size of columns at a later time. 

In the ‘Load’ box, enter the concentrated loads and moments in the column 
depending on their type as ‘Dead’ or ‘Live’. In this particular problem, there is 
300kN concentrated dead load and 140kN concentrated live load with no 
moments. Thus, enter these values as shown in Fig. 4. 

In the ‘Properties’ box, the footing thickness and the subgrade modulus of the soil 
will be entered. The footing thickness of the footing is given to be 500mm. Thus, 
enter this value as shown in fig. 4. However this value may be revised depending 
on the punching shear requirements at a later time. The subgrade modulus of a soil 
is the ratio of the increment of contact pressure to the corresponding change in 
settlement. In the absence of a supportive test to determine its value, it can also be 
safely approximated by the ratio of the bearing capacity of the soil to the maximum 
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permissible settlement in the soil. In this particular problem, the subgrade modulus 
can be approximated by 100kN/m2/10mm = 10000kN/m3. Thus enter this value 
in the text field in front of the ‘Subgrade Modulus’. Then press the ‘OK’ button. 
This exits the ‘Single Footing’ window and a plan view of the foundation will be 
displayed on the main screen. You can zoom in and zoom out using the wheel of 
your mouse or using the tool bar under the menu bar. 

 
Figure 5 

The column shape and dimensions can be changed at this stage. The column is 
shown at the center of the plan view in Fig.5 with somewhat darker color. Changing 
the originally square column to rectangular column is a pretty easy process and 
there are different options to do that. The simplest one is to draw the column from 
the ‘Draw’ menu. For this, delete the existing column with unwanted shape and go 
to ‘Draw’ menu and click on ‘Quick Draw Areas Around Points’. Or simply click 

on the equivalent icon  on the left hand side tool bar and the following window 
will pop up. 

 
Figure 6 
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In this window, change the ‘Shape of Object’ to the shape that you want and the 
property to ‘STIFF’, enter the dimensions and click on the footing where you want 
the column. 

The other way to change the shape of columns is to left click on any edge, then 
right click on the left clicked edge and a ‘Point Object Information’ window pops 
up. In the ‘Geometry’ tab of this window, you can change the X,Y,Z coordinates 
of the corner to any desired value. Through similar process on other corners of the 
column, the shape of the column can be converted into any desired quadrilateral or 
triangular shape. To change the column into other shapes and sizes, hover over the 
column in the plan view and right click on any point inside the column. On the 
right click, the following window pops up.  

 
Figure 7 
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Then by clicking on the ‘Geometry’ tab, any edge of the originally ‘Straight’ side of 
the square can be changed to some selected geometric shapes. 

STEP 2: Defining Material Properties 

The materials which are involved in the design of the footing should be defined 
before the analysis. These materials are the concrete, the reinforcement bar (rebar) 
and the soil which is already defined. Thus, the concrete property and the rebar 
property will be defined here. 

The material definition can be carried out in two ways. 

The first one is through the ‘Define’ menu in the menu bar. The other one through 
the model explorer on the left hand side of the home window. To define material 
properties through the former method, click on ‘Define’ menu and again click on 
‘Materials…’ resulting in the following window depending on prior material 
definitions. 

 
Figure 8 

The list in the ‘Materials’ box may not be exactly as it appears in your widow. 
However, that doesn’t bring any change in the outcome of the design process as 
you can customize this list any time. 

The ‘Add New Material Quick…’ button allows you to define materials quickly 
from a list of pre-defined materials. The ‘Add New Material’ button allows you 
to define materials by changing their properties. The ‘Add Copy of Material’ 
button allows you to define a material with same property as an already defined 
material. The ‘Modify/Show Material’ button displays the property of an already 
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defined material with the possibility of modification. The ‘Delete Material’ button, 
when active, deletes a defined material property. 

For this particular problem, we will define concrete and rebar properties through 
the ‘Add New Material’ button. Thus, click on this button. This can also be 
achieved by right clicking on ‘Materials’ on the model explorer and selecting ‘New 
Material’. The following window pops up in ether cases. 

 

 
Figure 9 

This is the window where material properties are defined. First, let us define the 
concrete property which will be used in the design. Put any name for the material 
in the text field in front of ‘Material Name’. But, it is important to make sure that 
the concrete with the defined material name is assigned for the footing. For this 
particular problem, let the name of the concrete to be used be ‘C25’. Since we are 
defining a concrete, the ‘Material Type’ should be set to ‘Concrete’.  
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The unit weight of reinforced concrete may vary depending of the design code of 
your country. Thus, enter the unit weight of reinforced concrete stipulated in your 
country code in the text field in front of ‘Weight per Unit Volume’. For this 
particular example, we will use 25kN/m3. 

For C-25 concrete, the modulus of elasticity according to BS 8110-1197 is around 
29GPa. Thus, enter this value in the text field in front of ‘Modulus of Elasticity, 
E’. If you selected another design code in step 1 while creating the model, you 
should refer to actual value of this parameter from the code and enter it accordingly. 
Be aware of the units though. 

The values of Poisson’s ratio and coefficient of thermal expansion may also be 
defined in the design code and should be entered accordingly. For this particular 
problem, a value of 0.2 for ‘Poisson’s Ratio, U’ and a value of 10x10-6/oC for 
‘Coefficient of Thermal Expansion, A’ will be entered. The ‘Shear Modulus, G’ 
will be automatically calculated in an uneditable text field. 

The grade of concrete for this particular problem is C-25 which is a concrete with 
28 day characteristics cube compressive strength of 25MPa. The concrete 
designation may be different for different country codes but the concept is the 
same. Therefore, enter 25 in the text field in front of ‘Concrete Cube 
Compressive Strength, fcu’. 

If a lightweight concrete is used, check on ‘Lightweight Concrete’ and enter the 
corresponding ‘Shear Strength Reduction Factor’ in the space provided. 

When you press on ‘OK’, a concrete material with the above properties will be 
added to the list of materials. This material will be assigned for the footing before 
the analysis. 

After defining the concrete property, the program returns to the window shown in 
Fig. 5. To define a rebar property, we will follow the same procedure as we followed 
while defining the concrete property. Since a new rebar property will be defined, 
click on the ‘Add New Material…’ button. A ‘Material Property Data’ window 
pops up and when you change the ‘Material Type’ to ‘Rebar’, the window appears 
to look like the following. 
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Figure 10 

 

Change the ‘Material Name’ to any name you want. Here, we name it ‘S300’. The 
material type should be ‘Rebar’. The weight per unit volume of steel is stipulated 
in the design code. For BS 8110-1197, the weight per unit volume is 77.0085kN/m3. 
Thus, enter this value in the text field in front of ‘Weight per Unit Volume’. The 
modulus of elasticity for reinforcement bars according to the same design code is 
200GPa. Thus enter this value in the text field in front of ‘Modulus of Elasticity, 
E’ considering the unit. 

In the ‘Other Properties for Rebar Materials’ box, two quantities are mentioned: 
minimum yield stress and minimum tensile stress for the reinforcing material. The 
values of these parameters will be specified in the design code which you defined 
earlier. If the code assumes that the rebar material exhibits elastic perfectly plastic 
behavior, the values of these two quantities will be the same. The grade of steel to 
be used for this particular example is S-300. The yield stress for this type of 
reinforcement bar is 300MPa. Since the design code of my country assumes that 
rebars exhibit elastic perfectly plastic behavior, the minimum tensile stress will also 
be 300MPa. Thus enter 300 in both text fields in front of the ‘Minimum yield 
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stress, Fy’ and ‘Minimum Tensile Stress, Fu’. Then press ‘OK’ in both 
‘Material Property Data’ and ‘Materials’ windows concluding the material 
definition step. 

STEP 3: Defining Footing and Column Properties 

After defining the material properties, the footing and column properties can be 
defined. This definition can take place in two ways: from the menu bar and from 
the model explorer. In SAFE software, footings are modelled as ‘footings’ and 
foundation columns are modelled as ‘stiff’.  

To define footing and column properties from the menu bar, go to ‘Define’ menu 
and click on ‘Slab Properties…’. The following window will pop up. 

 
Figure 11 

In the ‘Slab Property’ box, two foundation components are listed. The names in 
this box for your particular design may be different from the list of names in the 
box. The ‘FOOTING’ corresponds to the bottom slab portion of the foundation 
and ‘STIFF’ corresponds to the foundation column. The ‘Add New Property…’ 
button prompts the user to enter new properties for the footing and foundation 
column while the ‘Add Copy of Property…’ copies the property of an existing 
slap. The ‘Modify/Show Property…’ allows the user to show the property of an 
existing component with the possibility of modification. When the ‘Delete 
Property’ button is active, it allows the user to delete an existing slab property. 

In this case, we use the ‘Modify/Show Property…’ button. However, one can 
also use the ‘Add New Property…’ button. To use ‘Modify/Show Property…’ 
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button, highlight the foundation component to be modified like the ‘FOOTING’ 
is highlighted in Fig. 8 and click on this button. Since ‘FOOTING’ is highlighted, 
we will be modifying the footing property. The following window appears after the 
click. 

 
Figure 12 

The ‘Property Name’ will be automatically assigned to ‘FOOTING’. The ‘Slab 
Material’ should be set to the concrete grade which is defined in step 2. Since the 
name of the concrete material defined in step 2 for this particular problem is ‘C25’, 
a material with this name should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Footing’ as we are 
modifying the footing property. The ‘Thickness’ value should be set to the same 
value as the one which is used while creating the model. Since the thickness of the 
footing is 500mm, this value is entered in the text field corresponding to 
‘Thickness’. As footings are modelled as thick plates, check the ‘Thick Plate’ 
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option. The ‘Orthotropic’ check box is selected when a footing with irregular 
dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window in Fig. 11 gets activated. Now, the property of the 
foundation column will be modified. To do this, highlight ‘STIFF’ in the ‘Slab 
Property’ box and click on the ‘Modify/Slab Property…’ button. The following 
window appears after the click. 

 
Figure 13 

The ‘Property Name’ will be automatically assigned to ‘STIFF’. The ‘Slab 
Material’ should be set to the concrete grade which is defined in step 2. Since the 
name of the concrete material defined in step 2 for this particular problem is ‘C25’, 
a material with this name should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Stiff’ as we are 
modifying the footing property. The ‘Thickness’ value should be set to the same 
value as the one which is used while creating the model. Since the thickness of the 
foundation column and the footing are equal, the thickness of the ‘Stiff’ is 500mm, 
this value is entered in the text field corresponding to ‘Thickness’. As foundation 
columns are modelled as thick plates, check the ‘Thick Plate’ option. The 
‘Orthotropic’ check box is selected when a column with irregular dimension is to 
be used. 



 

17  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window in Fig. 8 gets activated. Again press ‘OK’ and exit the 
window for defining the footing and foundation column. 

STEP 4: Defining Load Patterns, Load Cases and Load Combinations 

The loads on the foundation should be defined accordingly before the analysis. 
First, the load pattern should be defined. This can be done from the ‘Define’ menu 
or from the ‘Model Explorer’. This time, we will do it from the model explorer. 
In the model explorer, expand ‘Load Definitions’ and you will see ‘Load 
Patterns’. When you expand ‘Load Patterns’, you will see ‘DEAD’ and ‘LIVE’. 
At the end, the model explorer appears to look like: 

 
Figure 14 

Now, right click on ‘Load Patterns’ and click on ‘New Load Pattern’ and the 
following window pops up. 
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Figure 15 

In the ‘Load Patterns’ window, two load patterns are already defined: ‘DEAD’ 
and ‘LIVE’. The ‘Type’ of the ‘Load’ should also be changed accordingly. There 
are many options for type of loading. The ‘Type’ for dead loads should be set to 
‘DEAD’ and for live loads ‘LIVE’. If there are other types of load patterns on the 
foundation such as earth quake load, you can add the load pattern with the ‘Add 
Load Pattern’ button. You can also delete any undesirable load pattern using the 
‘Delete Load Pattern’ button. Since in this example, we have only dead and live 
loads, we will leave the existing load patterns as they are. The ‘Self Weight 
Multiplier’ value should also be changed accordingly. This value imparts the option 
whether to include or exclude the self-weight of the foundation in addition to 
external loads. If the self-weight of the foundation is already included as an external 
dead load or if you want to exclude the effect of self-weight from the analysis, the 
value under ‘Self Weight Multiplier’ should be set to zero. In this example, we 
will consider the self-weight as an additional load to the external dead load. Thus, 
the value under ‘Self Weight Multiplier’ for the ‘DEAD’ load is one. For the 
‘LIVE’ load, it will be zero. Press ‘OK’ and the window will be exited. 

After this, the load cases will be defined. Load cases are used to dictate the way the 
loads are applied (statically or dynamically) or the way the structure responds 
(linearly or non-linearly) for the defined load patterns. To define a load case, go to 
‘Define’ menu and click on ‘Load Cases…’. The following window will pop up 
after the click. 
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Figure 16 

The load patterns which were defined earlier will automatically appear in the list of 
‘Load Case Name’ of the ‘Load Cases’ window. The ‘Load Case Type’ column 
shows the way in which each load pattern will be applied during analysis. If you 
want to modify this, highlight the load pattern for which you are going to change 
the load case type and click on the ‘Modify/Show Case…’ button. If you click 
this button, the following window will appear. In this window, you can change the 
way the load is applied from the ‘Load Case Type’ box. The way the structure 
responds can also be selected from the ‘Analysis Type’ box. This problem ‘Static’ 
is for the ‘Load Case Type’ and ‘Linear’ is selected for the ‘Analysis Type’ since 
the load is static and the foundation responds linearly. The scale factor for the dead 
load in the ‘Loads Applied’ box will be left as one. Press ‘OK’ and exit the window. 

The load case type for the live load should also be ‘Linear Static’. Otherwise, it 
should be changed by clicking the ‘Modify/Show Case…’ button to linear static 
case. If both the load case types are as desired click ‘OK’ and exit the ‘Load Cases’ 
window. 
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Figure 17 

Definition of the load combinations will be the next step. Two load combinations 
will be considered in this example for ultimate limit state and serviceability limit 
state. To define load combinations, go to ‘Define’ menu and click on ‘Load 
Combinations…’ and the following window pops up. 

 
Figure 18 
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New load combinations will be added through the ‘Add New Combo…’ button. 
Here, two load combinations will be added; one for the ultimate limit state the other 
for the serviceability limit state. When the ‘Add New Combo…’ button is clicked, 
the following window appears. 

 
Figure 19 

In the ‘Load Combination Data’ window, any name can be given for the load 
combination. The ‘Combination Type’ should be set to ‘Linear Add’ as the 
component loads (dead and live) will be added linearly. However, there are also 
other options from the drop down menu in front of ‘Combination Type’. In the 
window shown in Fig. 19, the two loads (dead and live) should be activated below 
the ‘Load Name’ column of the ‘Define Combination of Load Case/Combo 
Results’ box. The values in the ‘Scale Factor’ column correspond to the partial 
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safety factors for load for the failure mode under consideration. These partial safety 
factors are specified in the design code of your country. In the design code of my 
country, the partial safety factor for dead loads for ultimate limit sate case is 1.3 and 
for serviceability limit state is 1 for the cases where there are only dead and live 
loads. For such load patterns, the partial safety factor for live loads for ultimate 
limit sate case is 1.6 and for serviceability limit state is 1. Thus, enter a value of 1.3 
in front of ‘DEAD’ and 1.6 in front of ‘LIVE’ in ‘Scale Factor’ column. The 
failure condition which is being under consideration can be defined by selecting 
and deselecting the check boxes in the ‘Design Selection’ box. Since the above 
scale factors are for the ultimate limit state, check on ‘Strength (Ultimate)’. The 
‘Load Combination Data’ window for the serviceability limit state looks like the 
following window. 

 
Figure 20 
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STEP 6: Drawing Design Strips 

Design strips determine the way in which different quantities related to the 
reinforcement calculation are calculated. Forces are integrated across the design 
strips. Thus, the larger the width of coverage of the design strips within the given 
structure, the higher will be the calculated values of the bending moments and shear 
forces. Thus, an optimum width of strip is required compromising the safety and 
economical requirements. The width of the design strip will be specified in the 
design code. According to the code of my country, the width of design strips for 
isolated foundations is 1m. Thus, a one meter design strip will be drawn in both X 
and Y directions on the foundation. These design strips in X and Y direction are 
usually defined in SAFE software as layer A and layer B. 

Before drawing design strips, existing design strips, if any, should be deleted. To do 
this, follow the following command: ‘Select’>’Select’>’Properties’>’Design 
Strip Layers’. This results in the following ‘Select Design Strip Layers’ window. 

 
Figure 21 

In this window, select all layers and press ‘OK’ and the window will be exited while 
any existing design strips are selected. Then press the ‘Delete’ key. This deletes any 
existing design strips. After this, new layers of design strips in both X and Y 
directions will be drawn. 

To draw the design strip, go to the ‘Draw’ menu and click on ‘Design Strips’ and 
the following window pops up. 
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Figure 22 

In this window, the ‘Strip Layer’ should be selected to be either ‘A’ or ‘B’. But if 
‘A’ is for design strip in X direction ‘B’ should be for Y direction and vice versa. 
Since we are drawing a strip around the column to consider maximum moment and 
shear forces, the ‘Strip Design Type’ should be set to ‘Column Strip’. The width 
of the strip will be 1m in both directions and since the column will be centrally 
located, all the widths will be set to 0.5m. To draw the design strip in the X 
direction, without closing the window, left click at the center of one side of the 
footing on the plan view parallel to the Y axis and again left click at the center of 
the parallel side and right click. This creates a design strip in X direction. In doing 
so, if you can’t snap to the center of the side of the footing, you can modify the 
snap options by clicking on the ‘Snap Options…’ command from the ‘Draw’ 
menu and adjusting the options which you want to snap to. The design strip in Y 
direction can also be drawn in a similar procedure after changing the ‘Strip Layer’ 
to ‘B’. 

You can display the design strips by setting the display options by clicking on ‘Set 
Display Options…’ from the ‘View’ menu or by simultaneously clicking on ‘Ctrl’ 
and ‘W’ keys or by just clicking on the set display options icon  from the tool 
bar below the menu bar. This results in the following window: 
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Figure 23 

Then, check on ‘Labels’, ‘Show Width’ and ‘Show Stations’ in the ‘Design Strip 
Objects’ box and press ‘OK’ and the following window appears displaying the 
design strips in the two directions. 

 
Figure 24 
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STEP 7: Assigning Slab Data, Support Data and Load Data 

The slab data, support data, and load data which are defined in the previous steps 
should be assigned to the corresponding structural component. The way to do this 
is first to select the component and next to assign the slab property, support 
property or loads accordingly. The selection can be done by clicking on the 
component from the plan view or through the ‘Select’ menu. The latter option 
assures that the component is selected exactly as selection by clicking may result in 
incorrect selection. Thus, all the selections here will be done from the ‘Select’ 
menu. The assignments will be discussed as follows: 

a. Assigning slab data to the footing 
Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘Footing’ and 
press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Slab Data’>’Properties…’. Then select ‘FOOTING’ and 
press ‘OK’. 
 

b. Assigning slab data to the foundation column 
Select the foundation column through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘Stiff’ and press 
‘OK’. Then assign the footing property through the following strings of commands 
‘Assign’>’Slab Data’>’Properties…’. Then select ‘STIFF’ and press ‘OK’. 
 

c. Assigning support data to the footing 
Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘Footing’ and 
press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Support Data’>’Soil Properties…’. Then select ‘SOIL’ 
and press ‘OK’. 
 

d. Assigning reinforcement data to the design strips 
Select each design strip through the following strings of commands 
‘Select’>’Select’>’Properties’>Design Strip Layers…’. Then select ‘A’ or ‘B’ 
(one at a time) and press ‘OK’. When you right click on the selected strip layer, the 
‘Slab-Type Area Object Information’ window pops up. In the ‘Design’ tab of 
this window, set the ‘Rebar Material’ to ‘S300’ and press ‘OK’. Do this for both 
strips. 

e. Assigning load on the foundation column 
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To assign load on the foundation column, right click on the point at the center of 
the foundation column and a ‘Point Object Information’ window pops up. In this 
window, click on the ‘Loads’ tab. Then click on ‘Reset All’ button to delete any 
existing loads. 

 
Figure 25 

 
The dead load and the live load can be assigned through the ‘Assign Load…’ 
button. The procedure is: click on ‘Assign Load…’ button, then select ‘Force 
Loads’ then press ‘OK’ then select either ‘DEAD’ or ‘LIVE’ depending on which 
load you want to enter its value then enter its value accordingly and in the right 
direction (axis), then select ‘Add to Existing Loads’ and press ‘OK’. While doing 
this, the foundation column dimensions should be entered in the ‘Size of Load for 
Punching Shear’ box of ‘Point Loads’ window. You can also delete any forces 
which are wrongly entered through ‘Delete Existing Loads’ radio button option. 
In this example, since the dead load is 300kN and the live load is 140kN, these 
values are entered in the Gravity Direction. 
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STEP 8: Running the Analysis 

After this, the analysis can be run. But, make sure that the footing and the 
foundation column are assigned with the correct rebar material. To do this, right 
click anywhere in the plan view of the footing and the ‘Slab-Type Area Object 
Information’ window will pop-up. 

 
Figure 26 

In the ‘Design’ tab of this window, set the value of ‘Rebar Material’ to ‘S300’. 
Do this for the column foundation, and both design strips as well. After this, go to 
the ‘Run’ menu and click on the ‘Run Analysis’ command. 

STEP 9: Displaying the Output 

Once the analysis is run, the output will be displayed. Particularly, the punching 
shear design is of great importance as the footing cannot be designed without the 
punching shear requirement being adequately satisfied. To do this, go to the ‘Run’ 
menu and click on ‘Run Analysis & Design’ command or simply click on the ‘F5’ 
key. When you do this, you will be prompted to save the model, if you haven’t 
already don this. When you save the model, the following window showing the 
displacement of the soil in a banded figure will be displayed. 
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Figure 27 

To display the punching shear ratio, go to the ‘Display’ menu and click on ‘Show 
Punching Shear Design’. After this, the punching shear ratio will be displayed in 
the plan view around the foundation column as in the following figure. 

 
Figure 28 

As can be noticed from the figure, the punching shear ratio is 0.3088. Generally, a 
punching shear ratio less than one indicates the concrete thickness is adequate to 
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resist punching shear and a value greater than one indicates that the punching shear 
capacity is exceeded somewhere along the critical section. For economical design, 
it is recommended to keep the punching shear ratio between 0.95 and 1 as very 
small values of punching shear ratio means excess concrete thickness is used. 
However, if the punching shear ratio is greater than one, the thickness of the 
concrete should be increased and the foundation should be re-designed. A detailed 
quantitative description of the foundation design can also be obtained by right 
clicking on the plan view shown in Fig 28 as shown below. Several trial may be 
made by zooming in and out to get the quantitative description. 

 
Figure 29 

Through the ‘Display’ menu, relevant quantities can be displayed on the screen. 
For instance, the ‘Display’>’Show Strip Forces’ command or by simply clicking 
the ‘F8’ key, the following window will be displayed. 
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Figure 30 

In this window, the ‘Load Case/Load Combination’ box provides with radio 
buttons to select for which particular load case or load combination that we want 
to display the output. The ‘Component’ box contains four radio buttons to select 
which quantity to display. The ‘Show Forces For These Strip Layers’ box allows 
us to select the strip layer for which the quantity is displayed. Both strip layers can 
be selected at the same time. From the ‘Scaling’ box, we can select whether 
automatic scaling or user defined scaling is used while displaying the diagram. The 
‘Display Options’ box allows us to fill or not to fill the diagram and to display or 
not to display the values on the diagram. For the preferences shown in Fig. 30, the 
following diagram will be displayed. 
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Figure 31 

The ‘Display’>’Show Slab Design…’ command results in the window shown in 
Fig 32. In this window, several options can be set in order to display the footing 
design in the way we wanted to. The ‘Choose Display Type’ box allows us to 
select the ‘Design Basis’ between ‘Strip Based’ and ‘Finite Element Based’. 
Unless some differences in the way the design is displayed, there is no difference in 
the amount of reinforcement between these selections. Through the ‘Display 
Type’ in the same box, it can be selected whether to display flexural reinforcement 
or shear reinforcement. This box also allows us to impose or not to impose 
minimum reinforcement during the design. The ‘Rebar Location Shown’ box 
allows us to select which reinforcement, top or bottom or both, to be displayed. 
The ‘Reinforcing Display Type’ box allows us to set the manner in which the 
amount of reinforcement is displayed. The option whether to show the reinforcing 
envelop diagram and the reinforcing extent can be set by the check boxes in the 
‘Reinforcing Diagram’ window. The strip layer direction for which the amount 
of reinforcement is displayed can be chosen from the ‘Choose Strip Direction’ 
box. The ‘Display Options’ box allows us whether to display output in filled 
diagram or not and whether the values at controlling stations will be displayed or 
not. If we want to display the amount of reinforcement above some specified 
reinforcement bar area or spacing, we can use the options in the ‘Show Rebar 
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Above Specified Value’ box. When the ‘Typical Uniform Reinforcing 
Specified Below’ radio button is selected, the ‘Typical Uniform Reinforcing’ 
box get activated. In this box, we can set a specific value above which the 
reinforcement amount will be displayed. The reinforcement diagram output, for the 
options set in Fig. 32, will be shown below in fig. 33. 

 
Figure 32 
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Figure 33 

As can be noticed from the footing design diagram in fig. 33, the top reinforcement 
across strip layer A is 0mm2/m for top reinforcement and 1090mm2/m for bottom 
reinforcement. 

The design outputs can also be displayed in tabular format by clicking on the ‘Show 
Tables…’ menu item from the ‘Display’ menu or by just clicking on the equivalent 

icon  from the tool bar below the menu bar and the following window will 
pop up. 
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Figure 34 

In this window, we can select any of the model definitions or analysis results or 
design results and press ‘OK’ to display the quantity which we want to have a look 
at. By using the right hand side buttons in the window, the load patterns and the 
load cases can be selected. 

STEP 10: Detailing 

After running the analysis and after checking that the results are reasonable, the 
detailing will be done. However, before running the detailing, the detailing 
preferences can be set from the ‘Detailing’ menu. From the ‘Detailing 
Preferences…’, the likes of dimensional units and material quantity units can be 
selected. From ‘Slab/Mat Detailing Preferences…’, the likes of rebar 
curtailment options, the rebar detailing options, rebar selection rules and preferred 
rebar sizes can be selected. The ‘Drawing Sheet Set-up…’ menu allows us to set-
up the contents of the drawing sheet. The ‘Drawing Format Properties…’ allows 
us to set some formats in which the output displayed. 
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To run the detailing, go to ‘Run’ menu and click on ‘Run Detailing…’ or 
simultaneously press  ‘Shift’ and ‘F5’ keys or just click on the run detailing icon 

 from the tool bar just below the menu bar. Then, the ‘Run Detailing 
Options’ window pops up so that we set the detailing options. Set the detailing 
options which you want and click ‘OK’. 

Once the detailing is run, the detailing can be displayed. The detailing display 
options can be best accessed from the ‘Model Explorer’. When expanded in full, 
the ‘Detailing’ tab of the model explorer looks like: 

 
Figure 35 

By clicking on any of the options from the detailing tab, a desired detailing can be 
displayed. For instance, by double clicking on the ‘Footing Table’, the following 
detail of footing can be shown. 
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Figure 36 

Apart from this detail, other details can also be shown.  

STEP 11: Reporting 

The last step of foundation design is reporting. Before creating the report, the 
report preferences should be set up. To do this, go to the ‘File’ menu and click on 
‘Report Set-up…’ and the following window pops up. 

In this ‘Report Setup Data’ window, the user preferences regarding the reporting 
such as the report output type, the report page orientation and the report items can 
be set along with the load patterns and load combinations. Once the preference is 
set, the report can be created by clicking on ‘Create Report’ command in the ‘File’ 
menu. The ‘Advanced Report Writer’ command in the same menu can be used to 
set some advanced reporting formats. 
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Figure 37 

This concludes the tutorial for the design of single footing using the built-in model. 

2.2. Using Grids 
 

STEP 1: Creating the Model 

Design a rectangular isolated footing with the following parameters: 
• Dimension of the footing: 2mX3m 
• Dimension of the column: 0.4mX0.6m 
• Allowable bearing capacity of the soil : 100kN/m2 
• Maximum allowable settlement of the foundation: 10mm 
• Concentrated load (DL) : 275kN 
• Concentrated load (LL): 175kN 
• Bending moment (dead) in the long direction (My, DL):50kNm 
• Bending moment (live) in the long direction (My, LL):25kNm 
• Grade of concrete: C-30 (30MPa 28-day characteristics cube strength) 
• Grade of reinforcement bar (rebar): S-400 (400MPa characteristics yield 

strength) 
• Overall thickness of the foundation: 500mm 
• Concrete cover : 50mm 
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To create a footing model by using a grid, there are three ways. Go to ‘File’ menu 

and click on ‘New Model …’ or just click on the icon  . This icon is the first 
among the list of icons just below the menu bar or simply click on the ‘Ctrl’ and 
‘N’ keys simultaneously (Ctrl+N). 

Performing one of the above three ways results in the popping-up of the 
following ‘New Model Initialization’ window. 

This window consists of two parts: the ‘Design Data’ part and the ‘Initial Model’ 
part. In the ‘Design Data’, there are ‘Design Code’, ’Design Preferences’, 
‘Project Information’ and ‘Units’. 

The ‘Design Code’ consists of a list of selected design codes from many countries. 
Depending on the suitability of the code for your country, you may select one 
among the list of codes. The design code which follows similar design philosophy 
to my country code is BS 8110-1997. So, this design code is selected. 

After selecting the design code, it is better to first select the units to be used in the 
design and analysis process. These units can be selected by clicking on the 
‘Modify/Show’ button in front of ‘Units’. The following window pops up when 
the button is clicked. To choose metric units, click on ‘Metric Defaults’ button. 
The click results in metric units for best practices to be selected. It can be observed 
that, even though all the units are metric, they are not consistent. To select a 
preferred consistent unit, click on the ‘Consistent Units’ button. In this ‘Units’ 
window, the decimal places and minimum number of significant digits for any 
quantity can also be modified. 
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Figure 38 

By clicking on the ‘Modify/Show’ button in front of the ‘Project Information’, 
information regarding the project, the company and the model can be entered. 

By clicking on the ‘Modify/Show’ button in front of the ‘Design Preferences’, 
the user preferences regarding the design code, concrete cover for slabs and beams, 
post-tensioning can be changed. The following ‘Design Preferences’ window 
pops-up when the button is clicked. The ‘Min. Cover Slabs’ tab of the window 
may be of interest for this particular problem as footings will be modelled as slabs. 
Thus, click on this tab. This is the tab where the concrete cover and preferred rebar 
size will be entered. 
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Figure 39 

In the ‘Min. Cover Slabs’ tab, for ‘Non-Prestressed Reinforcement’ , both the 
‘Clear Cover Top’ and ‘Clear Cover Bottom’ should be set to 50mm as the 
concrete cover in this design problem stated to be 50mm. The ‘Preferred Bar Size’ 
can be set to any reasonable value. Here, the ‘Preferred Bar Size’ is set to 20 which 
is the diameter of the rebar in mm which will be used as the main reinforcement in 
the foundation. Leave the rest at they are. 
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Figure 40. 

Once everything is set correctly in the ‘Design Data’ box, go to the ‘Initial Model’ 
box and select the suitable model. Since an isolated (single) footing will be designed 
from grids click on the big square button just above ‘Grid Only’. The button itself 
shows crossing grids. When the button is clicked, the following ‘Coordinate 
System Definition’ window will pop up.  

The footing in this example is rectangular with centrally located column. The grid 
which will be created will be boundaries of the outer edges of the footing and the 
outer edges of the foundation column. As a result, there is uneven spacing between 
the grids. To create such grids with uneven spacing, it is better to create it by 
clicking the ‘Edit Grid’ button. When you click this button, a ‘Coordinate System’ 
window will pop up. In the ‘Display Grid Data as’ box, two radio buttons are 
there to choose between ‘Ordinate’ and ‘Spacing’. These are the options how the 
location of different grids is defined. If the ‘Ordinate’ option is selected, the X and 
Y-coordinates of the grids will be entered. If the ‘Spacing’ option is selected, the 
spacing between the grids will be entered. If the grids are irregular in shape with 
non-vertical and non-horizontal grids, they can be defined in the ‘General Grid 
Data’ box by entering the XY coordinates of the starting and ending points. 
Regular grids can also be defined by this option too. 
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Figure 41 

In this example, the length of the footing is 3m and the column dimension is 0.6m 
in x direction. The distance between the left face of the footing and the left face of 
the foundation column is 1.2m. The same is true for the distance between the right 
face of the footing and the right face of the foundation column. To limit the footing 
and the column in x-direction, the grids should have x-coordinates of 0, 1.2, 1.8 
and 3. 

The length of the slab is 2m and the column dimension is 0.4m in y direction. The 
distance between the bottom face of the footing and the bottom face of the 
foundation column is 0.8m. The same is true for the distance between the top face 
of the footing and the top face of the foundation column. To limit the footing and 
the column in y-direction, the grids should have x-coordinates of 0, 0.8, 1.2 and 2. 
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Figure 42 

The ‘Model Datum’ is the level of the model in z-direction. Any value can be set 
to this. Set the ‘Story Height Above’ value to some reasonable non zero value, say 
2, and set the ‘Story Height Below’ to 0 as there will be no story below the footing. 
Then press ‘OK’ and the grids will be displayed on the ‘Plan View’ window as 
below: 
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Figure 43 

STEP 2: Defining Material Properties 

The materials which are involved in the design of the footing should be defined 
before the analysis. These materials are the concrete, the reinforcement bar (rebar) 
and the soil support. Thus, these properties will be defined here. 

The material definition can be carried out in two ways. 

The first one is through the ‘Define’ menu in the menu bar. The other one through 
the model explorer on the left hand side of the home window. To define material 
properties through the former method, click on ‘Define’ menu and again click on 
‘Materials…’ resulting in the following window depending on prior material 
definitions. 

The list in the ‘Materials’ box may not be exactly as it appears in your widow. 
However, that doesn’t bring any change in the outcome of the design process as 
you can customize this list any time. 

The ‘Add New Material Quick…’ button allows you to define materials quickly 
from a list of pre-defined materials. The ‘Add New Material’ button allows you 
to define materials by changing their properties. The ‘Add Copy of Material’ 
button allows you to define a material with same property as an already defined 
material. The ‘Modify/Show Material’ button displays the property of an already 
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defined material with the possibility of modification. The ‘Delete Material’ button, 
when active, deletes a defined material property. 

 
Figure 44 

For this particular problem, we will modify the existing ‘C30’ concrete using the 
‘Modify/Show Material’ button and define a new rebar property through the 
‘Add New Material’ button.  

Highlight ‘C30’ in the ‘Materials’ box and click on the ‘Modify/Show Material’ 
button. This can also be achieved by right clicking on ‘Materials’ on the model 
explorer. The following window will pop up. 

This is the window where concrete properties will be modified. Put any name for 
the material in the text field in front of ‘Material Name’. But, it is important to 
make sure that the concrete with the defined material name is assigned for the 
footing. For this particular problem, let us keep the name of the concrete as ‘C30’. 
Since we are defining a concrete, the ‘Material Type’ should be set to ‘Concrete’.  

The unit weight of reinforced concrete may vary depending of the design code of 
your country. Thus, enter the unit weight of reinforced concrete stipulated in your 
country code in the text field in front of ‘Weight per Unit Volume’. For this 
particular example, we will use 25kN/m3. 
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Figure 45 

For C-30 concrete, the modulus of elasticity according to BS 8110-1197 is around 
32GPa. Thus, enter this value in the text field in front of ‘Modulus of Elasticity, 
E’. If you selected another design code in step 1 while creating the model, you 
should refer to actual value of this parameter from the code and enter it accordingly. 
Be aware of the units though. 

The values of Poisson’s ratio and coefficient of thermal expansion may also be 
defined in the design code and should be entered accordingly. For this particular 
problem, a value of 0.2 for ‘Poisson’s Ratio, U’ and a value of 10x10-6/oC for 
‘Coefficient of Thermal Expansion, A’ will be entered. The ‘Shear Modulus, G’ 
will be automatically calculated in an un-editable text field. 

The grade of concrete for this particular problem is C-30 which is a concrete with 
28 day characteristics cube compressive strength of 30MPa. The concrete 
designation may be different for different country codes but the concept is the 
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same. Therefore, enter 30 in the text field in front of ‘Concrete Cube 
Compressive Strength, fcu’. 

If a lightweight concrete is used, check on ‘Lightweight Concrete’ and enter the 
corresponding ‘Shear Strength Reduction Factor’ in the space provided. 

When you press on ‘OK’, a concrete material with the above properties will be 
added to the list of materials. This material will be assigned for the footing before 
the analysis. 

After modifying the concrete property, the program returns to the window shown 
in Fig. 44. To define a rebar property, we will follow the same procedure as we 
followed while defining the concrete property. Since a new rebar property will be 
defined, click on the ‘Add New Material…’ button. A ‘Material Property Data’ 
window pops up and when you change the ‘Material Type’ to ‘Rebar’, the window 
appears to look like the following. 

 
Figure 46 
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Change the ‘Material Name’ to any name you want. Here, we name it ‘S400’. The 
material type should be ‘Rebar’. The weight per unit volume of steel is stipulated 
in the design code. For BS 8110-1197, the weight per unit volume is 77.0085kN/m3. 
Thus, enter this value in the text field in front of ‘Weight per Unit Volume’. The 
modulus of elasticity for reinforcement bars according to the same design code is 
200GPa. Thus enter this value in the text field in front of ‘Modulus of Elasticity, 
E’ considering the unit. 

In the ‘Other Properties for Rebar Materials’ box, two quantities are mentioned: 
minimum yield stress and minimum tensile stress for the reinforcing material. The 
values of these parameters will be specified in the design code which you defined 
earlier. If the code assumes that the rebar material exhibits elastic perfectly plastic 
behavior, the values of these two quantities will be the same. The grade of steel to 
be used for this particular example is S-400. The yield stress for this type of 
reinforcement bar is 400MPa. Since the design code of my country assumes that 
rebars exhibit elastic perfectly plastic behavior, the minimum tensile stress will also 
be 400MPa. Thus enter 400 in both text fields in front of the ‘Minimum yield 
stress, Fy’ and ‘Minimum Tensile Stress, Fu’. Then press ‘OK’ in both 
‘Material Property Data’ and ‘Materials’ windows concluding the material 
definition step. 

The other property which should be defined is the soil support. To define the soil 
properties, go to the ‘Define’ menu and click on ‘Soil Subgrade Properties’ menu 
item and the following window appears. 

 
Figure 47 

By using the buttons in this window, a new soil property or copy of soil property 
can be added. An existing soil property can also be modified or deleted. For this 
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problem, let us add a new soil property by using the ‘Add New Property…’ 
button. Thus, click on this button and the following window pops up.  

 
Figure 48 

In this window, set the property name to ‘SOIL’ and change the subgrade modulus 
to 10,000kN/m3. Because, the subgrade modulus which can be assume by the ratio 
of the bearing capacity by the allowable settlement for this particular example is so. 
Then press ‘OK’ in both the ‘Soil Subgrade Property Data’ and ‘Soil Subgrade 
Properties’ windows. 

STEP 3: Defining Footing and Column Properties 

After defining the material properties, the footing and column properties can be 
defined. This definition can take place in two ways: from the menu bar and from 
the model explorer. In SAFE software, footings are modelled as ‘footings’ and 
foundation columns are modelled as ‘stiff’.  

To define footing and column properties from the menu bar, go to ‘Define’ menu 
and click on ‘Slab Properties…’. The following window will pop up. 

The ‘Add New Property…’ button prompts the user to enter new properties for 
the footing and foundation column while the ‘Add Copy of Property…’ copies 
the property of an existing slap. The ‘Modify/Show Property…’ allows the user 
to show the property of an existing component with the possibility of modification. 
When the ‘Delete Property’ button is active, it allows the user to delete an existing 
slab property. 
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Figure 49 

In this case, we use the ‘Add New Property…’ button to add new slab properties 
for the footing and foundation column. Click the button and the following window 
will pop up. 

 
Figure 50 

The ‘Property Name’ can be assigned with any name; but, in this case, the property 
name which will be used is ‘FOOTING’. The ‘Slab Material’ should be set to the 
concrete grade which is defined in step 2. Since the name of the concrete material 
defined in step 2 for this particular problem is ‘C30’, a material with this name 
should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Footing’. The 
‘Thickness’ value should be set to the thickness of the footing defined in the 
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example. Since the thickness of the footing is 500mm, this value is entered in the 
text field corresponding to ‘Thickness’. As footings are modelled as thick plates, 
check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected when a 
footing with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Now, the property of the foundation 
column will be added. To do this, again click on the ‘Add New Property…’ button. 
The following window appears after the click. 

 
Figure 51 

The ‘Property Name’ can be any name but we use ‘STIFF’. The ‘Slab Material’ 
should be set to the concrete grade which is defined in step 2. Since the name of 
the concrete material defined in step 2 for this particular problem is ‘C30’, a material 
with this name should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Stiff’ as we are 
defining the property of column. The ‘Thickness’ value should be the foundation 
column thickness which is equal to the footing thickness. Thus, a value of 500 will 
be entered in the text field corresponding to ‘Thickness’. As foundation columns 
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are modelled as thick plates, check the ‘Thick Plate’ option. The ‘Orthotropic’ 
check box is selected when a column with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Again press ‘OK’ and exit the window for 
defining the footing and foundation column. 

STEP 4: Defining Load Patterns, Load Cases and Load Combinations 

The loads on the foundation should be defined accordingly before the analysis. 
First, the load pattern should be defined. This can be done from the ‘Define’ menu 
or from the ‘Model Explorer’. This time, we will do it from the model explorer. 
In the model explorer, expand ‘Load Definitions’ and you will see ‘Load 
Patterns’. When you expand ‘Load Patterns’, you will see ‘DEAD’ and ‘LIVE’. 
At the end, the model explorer appears to look like: 

 
Figure 52 

Now, right click on ‘Load Patterns’ and click on ‘New Load Pattern’ and the 
following window pops up. 
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Figure 53 

In the ‘Load Patterns’ window, two load patterns are already defined: ‘DEAD’ 
and ‘LIVE’. The ‘Type’ of the ‘Load’ should also be changed accordingly. There 
are many options for type of loading. The ‘Type’ for dead loads should be set to 
‘DEAD’ and for live loads ‘LIVE’. If there are other types of load patterns on the 
foundation such as earth quake load, you can add the load pattern with the ‘Add 
Load Pattern’ button. You can also delete any undesirable load pattern using the 
‘Delete Load Pattern’ button. Since in this example, we have only dead and live 
loads, we will leave the existing load patterns as they are. The ‘Self Weight 
Multiplier’ value should also be changed accordingly. This value imparts the option 
whether to consider or ignore the self-weight of the foundation in addition to 
external loads. If the self-weight of the foundation is already included as an external 
dead load or if you want to exclude the effect of self-weight from the analysis, the 
value under ‘Self Weight Multiplier’ should be set to zero. In this example, we 
will consider the self-weight as an additional load to the external dead load. Thus, 
the value under ‘Self Weight Multiplier’ for the ‘DEAD’ load is one. For the 
‘LIVE’ load, it will be zero. Press ‘OK’ and the window will be exited. 

After this, the load cases will be defined. Load cases are used to dictate the way the 
loads are applied (statically or dynamically) or the way the structure responds 
(linearly or non-linearly) for the defined load patterns. To define a load case, go to 
‘Define’ menu and click on ‘Load Cases…’. The following window will pop up 
after the click. 



 

55  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

 
Figure 54 

The load patterns which were defined earlier will automatically appear in the list of 
‘Load Case Name’ of the ‘Load Cases’ window. The ‘Load Case Type’ column 
shows the way in which each load pattern will be applied during analysis. If you 
want to modify this, highlight the load pattern for which you are going to change 
the load case type and click on the ‘Modify/Show Case…’ button. If you click 
this button, the following window will appear. In this window, you can change the 
way the load is applied from the ‘Load Case Type’ box. The way the structure 
responds can also be selected from the ‘Analysis Type’ box. This problem ‘Static’ 
is for the ‘Load Case Type’ and ‘Linear’ is selected for the ‘Analysis Type’ since 
the load is static and the foundation responds linearly. The scale factor for the dead 
load in the ‘Loads Applied’ box will be left as one. Press ‘OK’ and exit the window. 

The load case type for the live load should also be ‘Linear Static’. Otherwise, it 
should be changed by clicking the ‘Modify/Show Case…’ button to linear static 
case. If both the load case types are as desired click ‘OK’ and exit the ‘Load Cases’ 
window. 
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Figure 55 

Definition of the load combinations will be the next step. Two load combinations 
will be considered in this example for ultimate limit state and serviceability limit 
state. To define load combinations, go to ‘Define’ menu and click on ‘Load 
Combinations…’ and the following window pops up. 

 
Figure 56 
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New load combinations will be added through the ‘Add New Combo…’ button. 
Here, two load combinations will be added; one for the ultimate limit state the other 
for the serviceability limit state. When the ‘Add New Combo…’ button is clicked, 
the following window appears. 

 
Figure 57 

In the ‘Load Combination Data’ window, any name can be given for the load 
combination. The ‘Combination Type’ should be set to ‘Linear Add’ as the 
component loads (dead and live) will be added linearly. However, there are also 
other options from the drop down menu in front of ‘Combination Type’. In the 
window shown in Fig. 57, the two loads (dead and live) should be activated below 
the ‘Load Name’ column of the ‘Define Combination of Load Case/Combo 
Results’ box. The values in the ‘Scale Factor’ column correspond to the partial 
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safety factors for load for the failure mode under consideration. These partial safety 
factors are specified in the design code of your country. In the design code of my 
country, the partial safety factor for dead loads for ultimate limit sate case is 1.3 and 
for serviceability limit state is 1 for the cases where there are only dead and live 
loads. For such load patterns, the partial safety factor for live loads for ultimate 
limit sate case is 1.6 and for serviceability limit state is 1. Thus, enter a value of 1.3 
in front of ‘DEAD’ and 1.6 in front of ‘LIVE’ in ‘Scale Factor’ column. The 
failure condition which is being under consideration can be defined by selecting 
and deselecting the check boxes in the ‘Design Selection’ box. Since the above 
scale factors are for the ultimate limit state, check on ‘Strength (Ultimate)’. The 
‘Load Combination Data’ window for the serviceability limit state looks like the 
following window. 

 
Figure 58 
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STEP 6: Drawing the Footing Components and Design Strips 

The footing, the foundation column and a point where the loads will be applied on 
the foundation column should now be drawn on the grid. 

i. Drawing the footing 
Since the footing will be drawn around points and since the footing is 
rectangular, go to the ‘Draw’ menu and click on ‘Draw Rectangular 

Slabs/Areas’ or simply click on the equivalent icon  on the left hand 
side tool bar. The following window will appear on the screen after the click. 

 
Figure 59 

Making sure that the ‘Property’ is set to ‘FOOTING’, first click on the grid 
where one corner of the footing will be located. Then, without releasing the 
click, drag into the opposite corner of the footing to draw the footing. 

ii. Drawing the foundation column 
While the window in fig 59 is active, change the ‘Property’ to ‘STIFF’ and 
click on the grid where one corner of the foundation column will be located. 
Then, without releasing the click, drag into the opposite corner of the 
foundation column to draw the foundation column. 

iii. Drawing the point on the foundation column where the load will be applied 
Go to ‘Draw’ menu and click on ‘Draw Points’, then click on the mid-point 
of the footing and the point will be created. If the cursor could not snap to 
the midpoint, you can adjust the ‘Snap Options’ from the ‘Draw’ menu. 

After this, the design strips will be drawn. Design strips determine the way in which 
different quantities related to the reinforcement calculation are calculated. Forces 
are integrated across the design strips. Thus, the larger the width of coverage of the 
design strips within the given structure, the higher will be the calculated values of 
the bending moments and shear forces. Thus, an optimum width of strip is required 
compromising the safety and economical requirements. The width of the design 
strip will be specified in the design code. According to the code of my country, the 
width of design strips for isolated foundations is 1m. Thus, a one meter design strip 
will be drawn in both X and Y directions on the foundation. These design strips in 
X and Y direction are usually defined in SAFE software as layer A and layer B. 
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To draw the design strip, go to the ‘Draw’ menu and click on ‘Design Strips’ or 

simply click on the equivalent icon from the left hand sided tool bar and the 
following window pops up. 

 
Figure 60 

In this window, the ‘Strip Layer’ should be selected to be either ‘A’ or ‘B’. But if 
‘A’ is for design strip in X direction ‘B’ should be for Y direction and vice versa. 
Since we are drawing a strip around the column to consider maximum moment and 
shear forces, the ‘Strip Design Type’ should be set to ‘Column Strip’. The width 
of the strip will be 1m in both directions and since the column will be centrally 
located, all the widths will be set to 0.5m. To draw the design strip in the X 
direction, without closing the window, left click at the center of one side of the 
footing on the plan view parallel to the Y axis and again left click at the center of 
the parallel side and right click. This creates a design strip in X direction. In doing 
so, if you can’t snap to the center of the side of the footing, you can modify the 
snap options by clicking on the ‘Snap Options…’ command from the ‘Draw’ 
menu and adjusting the options which you want to snap to. The design strip in Y 
direction can also be drawn in a similar procedure after changing the ‘Strip Layer’ 
to ‘B’. 

You can display the design strips by setting the display options by clicking on ‘Set 
Display Options…’ from the ‘View’ menu or by simultaneously clicking on ‘Ctrl’ 
and ‘W’ keys or by just clicking on the set display options icon  from the tool 
bar below the menu bar. This results in the following window: 
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Figure 61 

Then, check on ‘Labels’, ‘Show Width’ and ‘Show Stations’ in the ‘Design Strip 
Objects’ box and press ‘OK’ and after drawing dimension lines by using the 
command ‘Draw’>’Draw Dimension Lines’, the following window appears 
displaying the design strips in the two directions. 

 
Figure 62 
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STEP 7: Assigning Slab Data, Support Data and Load Data 

The slab data, support data, and load data which are defined in the previous steps 
should be assigned to the corresponding structural component. The way to do this 
is first to select the component and next to assign the slab property, support 
property or loads accordingly. The selection can be done by clicking on the 
component from the plan view or through the ‘Select’ menu. The latter option 
assures that the component is selected exactly as selection by clicking may result in 
incorrect selection. Thus, all the selections here will be done from the ‘Select’ 
menu. The assignments will be discussed as follows: 

 
a. Assigning support data to the footing 

Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘FOOTING’ 
and press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Support Data’>’Soil Properties…’. Then select ‘SOIL’ 
and press ‘OK’. 
 

b. Assigning reinforcement data to the design strips 
Select each design strip through the following strings of commands 
‘Select’>’Select’>’Properties’>Design Strip Layers…’. Then select ‘A’ or ‘B’ 
(one at a time) and press ‘OK’. When you right click on the selected strip layer, the 
‘Slab-Type Area Object Information’ window pops up. In the ‘Design’ tab of 
this window, set the ‘Rebar Material’ to ‘S400’ and press ‘OK’. Do this for both 
strips. 
 

c. Assigning load on the foundation column 
To assign load on the foundation column, right click on the point at the center of 
the foundation column and a ‘Point Object Information’ window pops up. In this 
window, click on the ‘Loads’ tab.  
 
The dead load and the live load can be assigned through the ‘Assign Load…’ 
button. The procedure is: click on ‘Assign Load…’ button, then select ‘Force 
Loads’ then press ‘OK’ then select either ‘DEAD’ or ‘LIVE’ depending on which 
loads you want to enter their values then enter their values accordingly (both the 
concentrated load and the bending moment) and in the right direction (axis), then 
select ‘Add to Existing Loads’ and press ‘OK’. While doing this, the foundation 
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column dimensions should be entered in the ‘Size of Load for Punching Shear’ 
box of ‘Point Loads’ window.  
 

 
Figure 63 

 
You can also delete any forces which are wrongly entered through ‘Delete 
Existing Loads’ radio button option. In this example, since the dead concentrated 
load is 275kN and the dead bending moment is 50kNm about y-axis and since the 
live concentrated load is 175kN and the live bending moment is 25kNm about y-
axis, these values are entered in the Gravity Direction for the concentrated load and 
along y-axis for the bending moment. 

STEP 8: Running the Analysis 

After this, the analysis can be run. But, make sure that the footing and the 
foundation column are assigned with the correct rebar material. To do this, right 
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click anywhere in the plan view of the footing and the ‘Slab-Type Area Object 
Information’ window will pop-up. 

 
Figure 64 

In the ‘Design’ tab of this window, set the value of ‘Rebar Material’ to ‘S400’. 
Do this for the column foundation, and both design strips as well. After this, go to 
the ‘Run’ menu and click on the ‘Run Analysis’ command. 

STEP 9: Displaying the Output 

Once the analysis is run, the output will be displayed. Particularly, the punching 
shear design is of great importance as the footing cannot be designed without the 
punching shear requirement being adequately satisfied. To do this, go to the ‘Run’ 
menu and click on ‘Run Analysis & Design’ command or simply click on the ‘F5’ 
key. When you do this, you will be prompted to save the model, if you haven’t 
already don this. When you save the model, the following window showing the 
displacement of the soil in a banded figure will be displayed. 
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Figure 65 

To display the punching shear ratio, go to the ‘Display’ menu and click on ‘Show 
Punching Shear Design’. After this, the punching shear ratio will be displayed in 
the plan view around the foundation column as in the following figure. 

 
Figure 66 

As can be noticed from the figure, the punching shear ratio is 0.6401. Generally, a 
punching shear ratio less than one indicates the concrete thickness is adequate to 
resist punching shear and a value greater than one indicates that the punching shear 
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capacity is exceeded somewhere along the critical section. For economical design, 
it is recommended to keep the punching shear ratio between 0.95 and 1 as very 
small values of punching shear ratio means excess concrete thickness is used. 
However, if the punching shear ratio is greater than one, the thickness of the 
concrete should be increased and the foundation should be re-designed. A detailed 
quantitative description of the foundation design can also be obtained by right 
clicking on the plan view shown in Fig 67 as shown below. Several trial may be 
made by zooming in and out to get the quantitative description. 

 
Figure 67 

Through the ‘Display’ menu, relevant quantities can be displayed on the screen. 
For instance, the ‘Display’>’Show Strip Forces’ command or by simply clicking 
the ‘F8’ key, the following window will be displayed. 
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Figure 68 

In this window, the ‘Load Case/Load Combination’ box provides with radio 
buttons to select for which particular load case or load combination that we want 
to display the output. The ‘Component’ box contains four radio buttons to select 
which quantity to display. The ‘Show Forces For These Strip Layers’ box allows 
us to select the strip layer for which the quantity is displayed. Both strip layers can 
be selected at the same time. From the ‘Scaling’ box, we can select whether 
automatic scaling or user defined scaling is used while displaying the diagram. The 
‘Display Options’ box allows us to fill or not to fill the diagram and to display or 
not to display the values on the diagram. For the preferences shown in Fig. 68, the 
following diagram will be displayed. 
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Figure 69 

The ‘Display’>’Show Slab Design…’ command results in the window shown in 
Fig 70. In this window, several options can be set in order to display the footing 
design in the way we wanted to. The ‘Choose Display Type’ box allows us to 
select the ‘Design Basis’ between ‘Strip Based’ and ‘Finite Element Based’. 
Unless some differences in the way the design is displayed, there is no difference in 
the amount of reinforcement between these selections. Through the ‘Display 
Type’ in the same box, it can be selected whether to display flexural reinforcement 
or shear reinforcement. This box also allows us to impose or not to impose 
minimum reinforcement during the design. The ‘Rebar Location Shown’ box 
allows us to select which reinforcement, top or bottom or both, to be displayed. 
The ‘Reinforcing Display Type’ box allows us to set the manner in which the 
amount of reinforcement is displayed. The option whether to show the reinforcing 
envelop diagram and the reinforcing extent can be set by the check boxes in the 
‘Reinforcing Diagram’ window. The strip layer direction for which the amount 
of reinforcement is displayed can be chosen from the ‘Choose Strip Direction’ 
box. The ‘Display Options’ box allows us whether to display output in filled 
diagram or not and whether the values at controlling stations will be displayed or 
not. If we want to display the amount of reinforcement above some specified 
reinforcement bar area or spacing, we can use the options in the ‘Show Rebar 
Above Specified Value’ box. When the ‘Typical Uniform Reinforcing 
Specified Below’ radio button is selected, the ‘Typical Uniform Reinforcing’ 
box get activated. In this box, we can set a specific value above which the 
reinforcement amount will be displayed. The reinforcement diagram output, for the 
options set in Fig. 70, will be shown below in fig. 71. 
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Figure 70 

 
Figure 71 

As can be noticed from the footing design diagram in fig. 71, the top reinforcement 
across strip layer A is around 0mm2/m for top reinforcement and 790mm2/m for 
bottom reinforcement. 
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The design outputs can also be displayed in tabular format by clicking on the ‘Show 
Tables…’ menu item from the ‘Display’ menu or by just clicking on the equivalent 

icon  from the tool bar below the menu bar and the following window will 
pop up. 

 
Figure 72 

In this window, we can select any of the model definitions or analysis results or 
design results and press ‘OK’ to display the quantity which we want to have a look 
at. By using the right hand side buttons in the window, the load patterns and the 
load cases can be selected. 

STEP 10: Detailing 

After running the analysis and after checking that the results are reasonable, the 
detailing will be done. However, before running the detailing, the detailing 
preferences can be set from the ‘Detailing’ menu. From the ‘Detailing 
Preferences…’, the likes of dimensional units and material quantity units can be 
selected. From ‘Slab/Mat Detailing Preferences…’, the likes of rebar 
curtailment options, the rebar detailing options, rebar selection rules and preferred 
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rebar sizes can be selected. The ‘Drawing Sheet Set-up…’ menu allows us to set-
up the contents of the drawing sheet. The ‘Drawing Format Properties…’ allows 
us to set some formats in which the output displayed. 

 

To run the detailing, go to ‘Run’ menu and click on ‘Run Detailing…’ or 
simultaneously press  ‘Shift’ and ‘F5’ keys or just click on the run detailing icon 

 from the tool bar just below the menu bar. Then, the ‘Run Detailing 
Options’ window pops up so that we set the detailing options. Set the detailing 
options which you want and click ‘OK’. 

Once the detailing is run, the detailing can be displayed. The detailing display 
options can be best accessed from the ‘Model Explorer’. When expanded in full, 
the ‘Detailing’ tab of the model explorer looks like: 

 
Figure 73 
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By clicking on any of the options from the detailing tab, a desired detailing can be 
displayed. For instance, by double clicking on the ‘Footing Table’, the following 
detail of footing can be shown. 

 
Figure 74 

In this detail, the diameter of the reinforcement which is used is 10mm. If you want 
to change the diameter…. 

Apart from this detail, other details can also be shown.  

STEP 11: Reporting 

The last step of foundation design is reporting. Before creating the report, the 
report preferences should be set up. To do this, go to the ‘File’ menu and click on 
‘Report Set-up…’ and the following window pops up. 

In this ‘Report Setup Data’ window, the user preferences regarding the reporting 
such as the report output type, the report page orientation and the report items can 
be set along with the load patterns and load combinations. Once the preference is 
set, the report can be created by clicking on ‘Create Report’ command in the ‘File’ 
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menu. The ‘Advanced Report Writer’ command in the same menu can be used to 
set some advanced reporting formats. 

 
Figure 75 

This concludes the tutorial for the design of single footing using the grids. 
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2.3. From AutoCAD 
 

 

 

STEP 
1: 

Creating the Model 

To create a footing model from an AutoCAD file, first draw the plan view of the 
foundation on AutoCAD. In this case, it will be two concentric circles one with a 
radius of 0.3m (foundation column) and another with a radius of 1.2m (footing). 
When you draw the plan view on AutoCAD, make sure that you are drawing it on 
a new layer. If you want the origin of the SAFE mode to coincide with the center 
of the circular foundation, make the center of the circle coincide with the global 
origin of the AutoCAD file when you draw it. Then save the AutoCAD file in DXF 
format. To save an AutoCAD file in DXF format, go to ‘File’ menu in the 
AutoCAD file and click on ‘Save As’. At the bottom of the upcoming window, just 
below the text field where you will enter the file name, you will see ‘Files of type’ 
with a drop-down menu list. From the drop down menu list, select the option which 
has ‘(.dxf)’ at the end. Then enter the file name and save it at any location in your 
computer where you can easily remember close it. This saves the file in DXF 
format. 

Once you saved the AutoCAD file in DXF format, open the SAFE software and 
when you use the command ‘File’>’Import’>’.DXF/.DWG Architectural Plan’ 
or when you simultaneously click on ‘Ctrl’+’Shift’+’I’ keys, and you will be 
prompted to open a file.  Open the DXF file from the location where you saved it 
and the following window will pop up. 

In this window, just change the ‘CAD Drawing Units’ to ‘m’ since in the 
AutoCAD file is the model is drawn in meter units. Then press ‘OK’. 

Design a circular isolated footing with the following parameters: 
• Radius of the footing: 1.5m 
• Radius of the column: 0.3m 
• Allowable bearing capacity of the soil : 150kN/m2 
• Maximum allowable settlement of the foundation: 10mm 
• Concentrated load (DL) : 500kN 
• Concentrated load (LL): 250kN 
• Grade of concrete: C-20 (20MPa 28-day characteristics cube strength) 
• Grade of reinforcement bar (rebar): S-460 (460MPa characteristics yield 

strength) 
• Overall thickness of the foundation: 600mm 
• Concrete cover : 50mm 
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Figure 76 

Then, the following model appears in the plan view. 

 
Figure 77 
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After the model is created, the preferences regarding the units, the design codes 
and concrete cover should be entered. To change the units, click on ‘Units…’ 
button which is found in the right bottom corner of the main window and the 
following widow will pop up. In this window, click on ‘Metric Defaults’ and press 
‘OK’ as we will be using metric units. If you want to use U.S. units click on ‘U.S. 
Defaults’ and if you want to use a particular metric or U.S. unit consistently click 
on ‘Consistent Units…’ and select that particular unit which you want to use 
consistently. 

 

Figure 80 

To select the design code and other design preferences, go to ‘Design’ menu and 
click on ‘Design Preferences…’ and the following window will pop up. In the 
‘Code’ tab of this window, change the ‘Design Code’ to ‘BS 8110-1997’ or any 
other code which you want to design the circular foundation with. In the ‘Min. 
Cover Slabs’ tab, for ‘Non-Prestressed Reinforcement’ , both the ‘Clear Cover 
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Top’ and ‘Clear Cover Bottom’ should be set to 50mm as the concrete cover in 
this design problem stated to be 50mm. The ‘Preferred Bar Size’ can be set to any 
reasonable value. Here, the ‘Preferred Bar Size’ is set to #14 which is the bar 
number which will be used as the main reinforcement in the foundation. Leave the 
rest as they are and press ‘OK’. 

 
Figure 81. 

STEP 2: Defining Material Properties 

The materials which are involved in the design of the footing should be defined 
before the analysis. These materials are the concrete, the reinforcement bar (rebar) 
and the soil support. Thus, these properties will be defined here. 

The material definition can be carried out in two ways. 

The first one is through the ‘Define’ menu in the menu bar. The other one through 
the model explorer on the left hand side of the home window. To define material 
properties through the former method, click on ‘Define’ menu and again click on 
‘Materials…’ resulting in the following window depending on prior material 
definitions. 

The list in the ‘Materials’ box may not be exactly as it appears in your widow. 
However, that doesn’t bring any change in the outcome of the design process as 
you can customize this list any time. 
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The ‘Add New Material Quick…’ button allows you to define materials quickly 
from a list of pre-defined materials. The ‘Add New Material’ button allows you 
to define materials by changing their properties. The ‘Add Copy of Material’ 
button allows you to define a material with same property as an already defined 
material. The ‘Modify/Show Material’ button displays the property of an already 
defined material with the possibility of modification. The ‘Delete Material’ button, 
when active, deletes a defined material property. 

 
Figure 82 

For this particular problem, we will add new concrete and a rebar materials using 
the ‘Add New Material…’ button. Thus click on this button and the following 
window will pop up. 

This is the window where concrete properties will be modified. Put any name for 
the material in the text field in front of ‘Material Name’. But, it is important to 
make sure that the concrete with the defined material name is assigned for the 
footing. For this particular problem, let us use the name of the concrete as ‘C20’. 
Since we are defining a concrete, the ‘Material Type’ should be set to ‘Concrete’.  

The unit weight of reinforced concrete may vary depending of the design code of 
your country. Thus, enter the unit weight of reinforced concrete stipulated in your 
country code in the text field in front of ‘Weight per Unit Volume’. For this 
particular example, we will use 25kN/m3. 

For C-20 concrete, the modulus of elasticity according to BS 8110-1197 is around 
27GPa. Thus, enter this value in the text field in front of ‘Modulus of Elasticity, 
E’. If you selected another design code in step 1 while creating the model, you 
should refer to actual value of this parameter from the code and enter it accordingly. 
Be aware of the units though. 
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Figure 83 

The values of Poisson’s ratio and coefficient of thermal expansion may also be 
defined in the design code and should be entered accordingly. For this particular 
problem, a value of 0.2 for ‘Poisson’s Ratio, U’ and a value of 10x10-6/oC for 
‘Coefficient of Thermal Expansion, A’ will be entered. The ‘Shear Modulus, G’ 
will be automatically calculated in an un-editable text field. 

The grade of concrete for this particular problem is C-20 which is a concrete with 
28 day characteristics cube compressive strength of 20MPa. The concrete 
designation may be different for different country codes but the concept is the 
same. Therefore, enter 20 in the text field in front of ‘Concrete Cube 
Compressive Strength, fcu’. 
If a lightweight concrete is used, check on ‘Lightweight Concrete’ and enter the 
corresponding ‘Shear Strength Reduction Factor’ in the space provided. 
When you press on ‘OK’, a concrete material with the above properties will be 
added to the list of materials. This material will be assigned for the footing before 
the analysis. 
After adding a new concrete property, the program returns to the window shown 
in Fig. 82 To define a rebar property, we will follow the same procedure as we 
followed while defining the concrete property. Since a new rebar property will be 
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defined, click on the ‘Add New Material…’ button. A ‘Material Property Data’ 
window pops up and when you change the ‘Material Type’ to ‘Rebar’, the window 
appears to look like the following. 

 
Figure 84 

Change the ‘Material Name’ to any name you want. Here, we name it ‘S460’. The 
material type should be ‘Rebar’. The weight per unit volume of steel is stipulated 
in the design code. For BS 8110-1197, the weight per unit volume is 77.0085kN/m3. 
Thus, enter this value in the text field in front of ‘Weight per Unit Volume’. The 
modulus of elasticity for reinforcement bars according to the same design code is 
200GPa. Thus enter this value in the text field in front of ‘Modulus of Elasticity, 
E’ considering the unit. 

In the ‘Other Properties for Rebar Materials’ box, two quantities are mentioned: 
minimum yield stress and minimum tensile stress for the reinforcing material. The 
values of these parameters will be specified in the design code which you defined 
earlier. If the code assumes that the rebar material exhibits elastic perfectly plastic 
behavior, the values of these two quantities will be the same. The grade of steel to 
be used for this particular example is S-460. The yield stress for this type of 
reinforcement bar is 460MPa. Since the design code of my country assumes that 
rebars exhibit elastic perfectly plastic behavior, the minimum tensile stress will also 
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be 460MPa. Thus enter 460 in both text fields in front of the ‘Minimum yield 
stress, Fy’ and ‘Minimum Tensile Stress, Fu’. Then press ‘OK’ in both 
‘Material Property Data’ and ‘Materials’ windows concluding the material 
definition step. 

The other property which should be defined is the soil support. To define the soil 
properties, go to the ‘Define’ menu and click on ‘Soil Subgrade Properties’ menu 
item and the following window appears. 

 
Figure 85 

By using the buttons in this window, a new soil property or copy of soil property 
can be added. An existing soil property can also be modified or deleted. For this 
problem, let us add a new soil property by using the ‘Add New Property…’ 
button. Thus, click on this button and the following window pops up.  

 
Figure 86 
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In this window, set the property name to ‘SOIL’ and change the subgrade modulus 
to 15,000kN/m3. Because, the subgrade modulus which can be assume by the ratio 
of the bearing capacity by the allowable settlement for this particular example is so. 
Then press ‘OK’ in both the ‘Soil Subgrade Property Data’ and ‘Soil Subgrade 
Properties’ windows. 

STEP 3: Defining Footing and Column Properties 

After defining the material properties, the footing and column properties can be 
defined. This definition can take place in two ways: from the menu bar and from 
the model explorer. In SAFE software, footings are modelled as ‘footings’ and 
foundation columns are modelled as ‘stiff’.  

To define footing and column properties from the menu bar, go to ‘Define’ menu 
and click on ‘Slab Properties…’. The following window will pop up. 

The ‘Add New Property…’ button prompts the user to enter new properties for 
the footing and foundation column while the ‘Add Copy of Property…’ copies 
the property of an existing slap. The ‘Modify/Show Property…’ allows the user 
to show the property of an existing component with the possibility of modification. 
When the ‘Delete Property’ button is active, it allows the user to delete an existing 
slab property. 

 
Figure 87 

In this case, we use the ‘Add New Property…’ button to add new slab properties 
for the footing and foundation column. Click the button and the following window 
will pop up. 
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Figure 88 

The ‘Property Name’ can be assigned with any name; but, in this case, the property 
name which will be used is ‘FOOTING’. The ‘Slab Material’ should be set to the 
concrete grade which is defined in step 2. Since the name of the concrete material 
defined in step 2 for this particular problem is ‘C20’, a material with this name 
should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Footing’. The 
‘Thickness’ value should be set to the thickness of the footing defined in the 
example. Since the thickness of the footing is 600mm, this value is entered in the 
text field corresponding to ‘Thickness’. As footings are modelled as thick plates, 
check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected when a 
footing with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Now, the property of the foundation 
column will be added. To do this, again click on the ‘Add New Property…’ button. 
The following window appears after the click. 
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Figure 89 

The ‘Property Name’ can be any name but we use ‘STIFF’. The ‘Slab Material’ 
should be set to the concrete grade which is defined in step 2. Since the name of 
the concrete material defined in step 2 for this particular problem is ‘C20’, a material 
with this name should be selected from the list. 
 
In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Stiff’ as we are 
defining the property of column. The ‘Thickness’ value should be the footing 
thickness which is equal to 600mm. As foundation columns are modelled as thick 
plates, check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected 
when a column with irregular dimension is to be used. 
 
When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Again press ‘OK’ and exit the window for 
defining the footing and foundation column. 

STEP 4: Defining Load Patterns, Load Cases and Load Combinations 
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The loads on the foundation should be defined accordingly before the analysis. 
First, the load pattern should be defined. This can be done from the ‘Define’ menu 
or from the ‘Model Explorer’. This time, we will do it from the model explorer. 
In the model explorer, expand ‘Load Definitions’ and you will see ‘Load 
Patterns’. When you expand ‘Load Patterns’, you will see ‘DEAD’ and ‘LIVE’. 
At the end, the model explorer appears to look like: 

 
Figure 90 

Now, right click on ‘Load Patterns’ and click on ‘New Load Pattern’ and the 
following window pops up. 

 
Figure 91 
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In the ‘Load Patterns’ window, two load patterns are already defined: ‘DEAD’ 
and ‘LIVE’. The ‘Type’ of the ‘Load’ should also be changed accordingly. There 
are many options for type of loading. The ‘Type’ for dead loads should be set to 
‘DEAD’ and for live loads ‘LIVE’. If there are other types of load patterns on the 
foundation such as earth quake load, you can add the load pattern with the ‘Add 
Load Pattern’ button. You can also delete any undesirable load pattern using the 
‘Delete Load Pattern’ button. Since in this example, we have only dead and live 
loads, we will leave the existing load patterns as they are. The ‘Self Weight 
Multiplier’ value should also be changed accordingly. This value imparts the option 
whether to consider or ignore the self-weight of the foundation in addition to 
external loads. If the self-weight of the foundation is already included as an external 
dead load or if you want to exclude the effect of self-weight from the analysis, the 
value under ‘Self Weight Multiplier’ should be set to zero. In this example, we 
will consider the self-weight as an additional load to the external dead load. Thus, 
the value under ‘Self Weight Multiplier’ for the ‘DEAD’ load is one. For the 
‘LIVE’ load, it will be zero. Press ‘OK’ and the window will be exited. 

After this, the load cases will be defined. Load cases are used to dictate the way the 
loads are applied (statically or dynamically) or the way the structure responds 
(linearly or non-linearly) for the defined load patterns. To define a load case, go to 
‘Define’ menu and click on ‘Load Cases…’. The following window will pop up 
after the click. 

 
Figure 92 

The load patterns which were defined earlier will automatically appear in the list of 
‘Load Case Name’ of the ‘Load Cases’ window. The ‘Load Case Type’ column 
shows the way in which each load pattern will be applied during analysis. If you 
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want to modify this, highlight the load pattern for which you are going to change 
the load case type and click on the ‘Modify/Show Case…’ button. If you click 
this button, the following window will appear. In this window, you can change the 
way the load is applied from the ‘Load Case Type’ box. The way the structure 
responds can also be selected from the ‘Analysis Type’ box. This problem ‘Static’ 
is for the ‘Load Case Type’ and ‘Linear’ is selected for the ‘Analysis Type’ since 
the load is static and the foundation responds linearly. The scale factor for the dead 
load in the ‘Loads Applied’ box will be left as one. Press ‘OK’ and exit the window. 

The load case type for the live load should also be ‘Linear Static’. Otherwise, it 
should be changed by clicking the ‘Modify/Show Case…’ button to linear static 
case. If both the load case types are as desired click ‘OK’ and exit the ‘Load Cases’ 
window. 

 
Figure 93 

Definition of the load combinations will be the next step. Two load combinations 
will be considered in this example for ultimate limit state and serviceability limit 
state. To define load combinations, go to ‘Define’ menu and click on ‘Load 
Combinations…’ and the following window pops up. 
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Figure 94 

New load combinations will be added through the ‘Add New Combo…’ button. 
Here, two load combinations will be added; one for the ultimate limit state the other 
for the serviceability limit state. When the ‘Add New Combo…’ button is clicked, 
the following window appears. 

 
Figure 95 
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In the ‘Load Combination Data’ window, any name can be given for the load 
combination. The ‘Combination Type’ should be set to ‘Linear Add’ as the 
component loads (dead and live) will be added linearly. However, there are also 
other options from the drop down menu in front of ‘Combination Type’. In the 
window shown in Fig. 95, the two loads (dead and live) should be activated below 
the ‘Load Name’ column of the ‘Define Combination of Load Case/Combo 
Results’ box. The values in the ‘Scale Factor’ column correspond to the partial 
safety factors for load for the failure mode under consideration. These partial safety 
factors are specified in the design code of your country. In the design code of my 
country, the partial safety factor for dead loads for ultimate limit sate case is 1.3 and 
for serviceability limit state is 1 for the cases where there are only dead and live 
loads. For such load patterns, the partial safety factor for live loads for ultimate 
limit sate case is 1.6 and for serviceability limit state is 1. Thus, enter a value of 1.3 
in front of ‘DEAD’ and 1.6 in front of ‘LIVE’ in ‘Scale Factor’ column. The 
failure condition which is being under consideration can be defined by selecting 
and deselecting the check boxes in the ‘Design Selection’ box. Since the above 
scale factors are for the ultimate limit state, check on ‘Strength (Ultimate)’. The 
‘Load Combination Data’ window for the serviceability limit state looks like the 
following window. 
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Figure 96 

STEP 6: Drawing the Footing Components and Design Strips 

The footing, the foundation column and a point where the loads will be applied on 
the foundation column should now be drawn on the grid. 

i. Drawing the footing 
Since the footing will be drawn around points and since the footing is 
circular, go to the ‘Draw’ menu and click on ‘Quick Draw Areas Around 

Points’ or simply click on the equivalent icon  on the left hand side tool 
bar. The following window will appear on the screen after the click. 

 
Figure 97 
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Since the footing has circular shape, change the ‘Shape of Object’ to 
‘Circular Slab’. Make sure that the ‘Property’ is set to ‘FOOTING’. The 
value of the ‘Diameter [m]’ should be set to ‘3’ as the footing diameter is 
3m.Then, with great care take the cursor to exactly the center of the footing, 
and just make one left click. This draws the footing. 

ii. Drawing the foundation column 
While the window in fig 97 is active, change the ‘Property’ to ‘STIFF’ and 
the ‘Diameter [m]’ to 0.6. Then, with great care take the cursor to exactly 
the center of the column and just make one lift click. This draws the 
foundation column. 

iii. Drawing the point on the foundation column where the load will be applied 
Go to ‘Draw’ menu and click on ‘Draw Points’, then click on the mid-point 
of the footing and the point will be created. If the cursor could not snap to 
the midpoint, you can adjust the ‘Snap Options’ from the ‘Draw’ menu. 

After this, the design strips will be drawn. Design strips determine the way in which 
different quantities related to the reinforcement calculation are calculated. Forces 
are integrated across the design strips. Thus, the larger the width of coverage of the 
design strips within the given structure, the higher will be the calculated values of 
the bending moments and shear forces. Thus, an optimum width of strip is required 
compromising the safety and economical requirements. The width of the design 
strip will be specified in the design code. According to the code of my country, the 
width of design strips for isolated foundations is 1m. Thus, a one meter design strip 
will be drawn in both X and Y directions on the foundation. These design strips in 
X and Y direction are usually defined in SAFE software as layer A and layer B. 

To draw the design strip, go to the ‘Draw’ menu and click on ‘Design Strips’ or 

simply click on the equivalent icon from the left hand sided tool bar and the 
following window pops up. 
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Figure 98 

In this window, the ‘Strip Layer’ should be selected to be either ‘A’ or ‘B’. But if 
‘A’ is for design strip in X direction ‘B’ should be for Y direction and vice versa. 
Since we are drawing a strip around the column to consider maximum moment and 
shear forces, the ‘Strip Design Type’ should be set to ‘Column Strip’. The width 
of the strip will be 1m in both directions and since the column will be centrally 
located, all the widths will be set to 0.5m. To draw the design strip in the X 
direction, without closing the window, left click at the extreme left side of the 
footing on the plan view and again left click at the extreme right side of the footing 
and right click. This creates a design strip in X direction. In doing so, if you can’t 
snap to the extreme points on the footing, you can modify the snap options by 
clicking on the ‘Snap Options…’ command from the ‘Draw’ menu and adjusting 
the options which you want to snap to. The design strip in Y direction can also be 
drawn in a similar procedure after changing the ‘Strip Layer’ to ‘B’. 

You can display the design strips by setting the display options by clicking on ‘Set 
Display Options…’ from the ‘View’ menu or by simultaneously clicking on ‘Ctrl’ 
and ‘W’ keys or by just clicking on the set display options icon  from the tool 
bar below the menu bar. This results in the following window: 
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Figure 99 

Then, check on ‘Labels’, ‘Show Width’ and ‘Show Stations’ in the ‘Design Strip 
Objects’ box and press ‘OK’ and after drawing dimension lines by using the 
command ‘Draw’>’Draw Dimension Lines’, the following window appears 
displaying the design strips in the two directions. 

 
Figure 100 
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STEP 7: Assigning Slab Data, Support Data and Load Data 

The slab data, support data, and load data which are defined in the previous steps 
should be assigned to the corresponding structural component. The way to do this 
is first to select the component and next to assign the slab property, support 
property or loads accordingly. The selection can be done by clicking on the 
component from the plan view or through the ‘Select’ menu. The latter option 
assures that the component is selected exactly as selection by clicking may result in 
incorrect selection. Thus, all the selections here will be done from the ‘Select’ 
menu. The assignments will be discussed as follows: 

a. Assigning support data to the footing 
Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘FOOTING’ 
and press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Support Data’>’Soil Properties…’. Then select ‘SOIL’ 
and press ‘OK’. 
 

b. Assigning reinforcement data to the design strips 
Select each design strip through the following strings of commands 
‘Select’>’Select’>’Properties’>Design Strip Layers…’. Then select ‘A’ or ‘B’ 
(one at a time) and press ‘OK’. When you right click on the selected strip layer, the 
‘Slab-Type Area Object Information’ window pops up. In the ‘Design’ tab of 
this window, set the ‘Rebar Material’ to ‘S460’ and press ‘OK’. Do this for both 
strips. 
 

c. Assigning load on the foundation column 
To assign load on the foundation column, right click on the point at the center of 
the foundation column and a ‘Point Object Information’ window pops up. In this 
window, click on the ‘Loads’ tab.  
 
The dead load and the live load can be assigned through the ‘Assign Load…’ 
button. The procedure is: click on ‘Assign Load…’ button, then select ‘Force 
Loads’ then press ‘OK’ then select either ‘DEAD’ or ‘LIVE’ depending on which 
loads you want to enter their values then enter their values accordingly (both the 
concentrated load and the bending moment) and in the right direction (axis), then 
select ‘Add to Existing Loads’ and press ‘OK’. While doing this, the foundation 
column dimensions should be entered in the ‘Size of Load for Punching Shear’ 
box of ‘Point Loads’ window.  
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Figure 101 

 
You can also delete any forces which are wrongly entered through ‘Delete 
Existing Loads’ radio button option. In this example, since the dead concentrated 
load is 500kN and since the live concentrated load is 250kN, these values are 
entered in the Gravity Direction for the concentrated load and along y-axis for the 
bending moment. 

STEP 8: Running the Analysis 

After this, the analysis can be run. But, make sure that the footing and the 
foundation column are assigned with the correct rebar material. To do this, right 
click anywhere in the plan view of the footing and the ‘Slab-Type Area Object 
Information’ window will pop-up. 
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Figure 102 

In the ‘Design’ tab of this window, set the value of ‘Rebar Material’ to ‘S460’. 
Do this for the column foundation, and both design strips as well. After this, go to 
the ‘Run’ menu and click on the ‘Run Analysis’ command. 

STEP 9: Displaying the Output 

Once the analysis is run, the output will be displayed. Particularly, the punching 
shear design is of great importance as the footing cannot be designed without the 
punching shear requirement being adequately satisfied. To do this, go to the ‘Run’ 
menu and click on ‘Run Analysis & Design’ command or simply click on the ‘F5’ 
key. When you do this, you will be prompted to save the model, if you haven’t 
already don this. When you save the model, the following window showing the 
displacement of the soil in a banded figure will be displayed. 
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Figure 103 

To display the punching shear ratio, go to the ‘Display’ menu and click on ‘Show 
Punching Shear Design’. After this, the punching shear ratio will be displayed in 
the plan view around the foundation column as in the following figure. 

 
Figure 104 

As can be noticed from the figure, the punching shear ratio is 2.9199. Generally, a 
punching shear ratio less than one indicates the concrete thickness is adequate to 
resist punching shear and a value greater than one indicates that the punching shear 
capacity is exceeded somewhere along the critical section. For economical design, 
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it is recommended to keep the punching shear ratio between 0.95 and 1 as very 
small values of punching shear ratio means excess concrete thickness is used. 
However, if the punching shear ratio is greater than one, like in this example, the 
thickness of the concrete should be increased or the grade of the concrete should 
be increased and the foundation should be re-designed. A detailed quantitative 
description of the foundation design can also be obtained by right clicking on the 
plan view shown in Fig 104 as shown below. Several trial may be made by zooming 
in and out to get the quantitative description. 

 
Figure 105 

Through the ‘Display’ menu, relevant quantities can be displayed on the screen. 
For instance, the ‘Display’>’Show Strip Forces’ command or by simply clicking 
the ‘F8’ key, the following window will be displayed. 
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Figure 106 

In this window, the ‘Load Case/Load Combination’ box provides with radio 
buttons to select for which particular load case or load combination that we want 
to display the output. The ‘Component’ box contains four radio buttons to select 
which quantity to display. The ‘Show Forces For These Strip Layers’ box allows 
us to select the strip layer for which the quantity is displayed. Both strip layers can 
be selected at the same time. From the ‘Scaling’ box, we can select whether 
automatic scaling or user defined scaling is used while displaying the diagram. The 
‘Display Options’ box allows us to fill or not to fill the diagram and to display or 
not to display the values on the diagram. For the preferences shown in Fig. 106, 
the following diagram will be displayed. 
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Figure 107 

The ‘Display’>’Show Slab Design…’ command results in the window shown in 
Fig 108. In this window, several options can be set in order to display the footing 
design in the way we wanted to. The ‘Choose Display Type’ box allows us to 
select the ‘Design Basis’ between ‘Strip Based’ and ‘Finite Element Based’. 
Unless some differences in the way the design is displayed, there is no difference in 
the amount of reinforcement between these selections. Through the ‘Display 
Type’ in the same box, it can be selected whether to display flexural reinforcement 
or shear reinforcement. This box also allows us to impose or not to impose 
minimum reinforcement during the design. The ‘Rebar Location Shown’ box 
allows us to select which reinforcement, top or bottom or both, to be displayed. 
The ‘Reinforcing Display Type’ box allows us to set the manner in which the 
amount of reinforcement is displayed. The option whether to show the reinforcing 
envelop diagram and the reinforcing extent can be set by the check boxes in the 
‘Reinforcing Diagram’ window. The strip layer direction for which the amount 
of reinforcement is displayed can be chosen from the ‘Choose Strip Direction’ 
box. The ‘Display Options’ box allows us whether to display output in filled 
diagram or not and whether the values at controlling stations will be displayed or 
not. If we want to display the amount of reinforcement above some specified 
reinforcement bar area or spacing, we can use the options in the ‘Show Rebar 
Above Specified Value’ box. When the ‘Typical Uniform Reinforcing 
Specified Below’ radio button is selected, the ‘Typical Uniform Reinforcing’ 
box get activated. In this box, we can set a specific value above which the 



 

101  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

reinforcement amount will be displayed. The reinforcement diagram output, for the 
options set in Fig. 108, will be shown below in fig. 109. 

 
Figure 108 

 
Figure 109 
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As can be noticed from the footing design diagram in fig. 71, the top reinforcement 
across strip layer A is around 0mm2/m for top reinforcement and 790mm2/m for 
bottom reinforcement. 

The design outputs can also be displayed in tabular format by clicking on the ‘Show 
Tables…’ menu item from the ‘Display’ menu or by just clicking on the equivalent 

icon  from the tool bar below the menu bar and the following window will 
pop up. 

 
Figure 110 

In this window, we can select any of the model definitions or analysis results or 
design results and press ‘OK’ to display the quantity which we want to have a look 
at. By using the right hand side buttons in the window, the load patterns and the 
load cases can be selected. 

STEP 10: Detailing 

After running the analysis and after checking that the results are reasonable, the 
detailing will be done. However, before running the detailing, the detailing 
preferences can be set from the ‘Detailing’ menu. From the ‘Detailing 
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Preferences…’, the likes of dimensional units and material quantity units can be 
selected. From ‘Slab/Mat Detailing Preferences…’, the likes of rebar 
curtailment options, the rebar detailing options, rebar selection rules and preferred 
rebar sizes can be selected. The ‘Drawing Sheet Set-up…’ menu allows us to set-
up the contents of the drawing sheet. The ‘Drawing Format Properties…’ allows 
us to set some formats in which the output displayed. 

To run the detailing, go to ‘Run’ menu and click on ‘Run Detailing…’ or 
simultaneously press  ‘Shift’ and ‘F5’ keys or just click on the run detailing icon 

 from the tool bar just below the menu bar. Then, the ‘Run Detailing 
Options’ window pops up so that we set the detailing options. Set the detailing 
options which you want and click ‘OK’. 

Once the detailing is run, the detailing can be displayed. The detailing display 
options can be best accessed from the ‘Model Explorer’. When expanded in full, 
the ‘Detailing’ tab of the model explorer looks like: 

 
Figure 111 
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By clicking on any of the options from the detailing tab, a desired detailing can be 
displayed. For instance, by double clicking on the ‘Footing Table’, the following 
detail of footing can be shown. 

 
Figure 112 

In this detail, the diameter of the reinforcement which is used is 10mm. If you want 
to change the diameter…. 

Apart from this detail, other details can also be shown.  

STEP 11: Reporting 

The last step of foundation design is reporting. Before creating the report, the 
report preferences should be set up. To do this, go to the ‘File’ menu and click on 
‘Report Set-up…’ and the following window pops up. 

In this ‘Report Setup Data’ window, the user preferences regarding the reporting 
such as the report output type, the report page orientation and the report items can 
be set along with the load patterns and load combinations. Once the preference is 
set, the report can be created by clicking on ‘Create Report’ command in the ‘File’ 
menu. The ‘Advanced Report Writer’ command in the same menu can be used to 
set some advanced reporting formats. 
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Figure 113 

This concludes the tutorial for the design of single footing using a model 
imported from AutoCAD. 

  



Design Of Combined Footing
            
           
            Week 5-6
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3. Combined Footing 
 

In this part of the tutorial, a combined footing will be designed in three different 
ways. First, a rectangular combined foundation will be designed using the built-in 
model of the software itself. Then a trapezoidal isolated foundation will be designed 
using grids. Lastly, a rectangular combined foundation will be designed by 
importing the geometry from AutoCAD. In all sections, a design problem will be 
given first and the procedures which will be followed to carry out the design process 
in SAFE program will be detailed. 

3.1. From the Built-in Model 
 

STEP 
1: 

Creating the Model 

To create a footing model from the built-in program, there are three ways.  

d. Go to File menu and click on New Model … 

e. Click on the icon  . This icon is the first among the list of icons just 
below the menu bar. 

f. Simply click on the Ctrl and N keys simultaneously (Ctrl+N). 

Design a rectangular combined footing with the following parameters: 
• Dimension of the footing: 2.9mX5.8m 
• Dimension of first column: 0.3mX0.3m 
• Dimension of second column: 0.35mX0.35m 
• Distance between the columns: 4.5m 
• Distance between the center of the first column to the left edge: 0.15m 
• Ultimate bearing capacity of the soil : 100kN/m2 
• Maximum allowable settlement of the foundation: 10mm 
• Concentrated ultimate load on the first column : 650kN 
• Concentrated ultimate load on the second column: 1000kN 
• Grade of concrete: C-25 (25MPa 28-day characteristics cube strength) 
• Grade of reinforcement bar (rebar): S-300 (300MPa characteristics yield 

strength) 
• Overall thickness of the foundation: 500mm 
• Concrete cover : 50mm 
• There are no bending moments on the column 
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Performing one of the above three ways results in the popping-up of the 
following ‘New Model Initialization’ window. 

 

Figure 114 

This window consists of two parts: the ‘Design Data’ part and the ‘Initial Model’ 
part. In the ‘Design Data’, there are ‘Design Code’, ’Design Preferences’, 
‘Project Information’ and ‘Units’. 

The ‘Design Code’ consists of a list of selected design codes from many countries. 
Depending on the suitability of the code for your country, you may select one 
among the list of codes. The design code which follows similar design philosophy 
to my country code is BS 8110-1997. So, this design code is selected. 

After selecting the design code, it is better to first select the units to be used in the 
design and analysis process. These units can be selected by clicking on the 
‘Modify/Show’ button in front of ‘Units’. The following window pops up when 
the button is clicked. To choose metric units, click on ‘Metric Defaults’ button. 
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The click results is metric units for best practices to be selected. It can be observed 
that, even though all the units are metric, they are not consistent. To select a 
preferred consistent unit, click on the ‘Consistent Units’ button. In this ‘Units’ 
window, the decimal places and minimum number of significant digits for any 
quantity can also be modified. 

 

Figure 115 

By clicking on the ‘Modify/Show’ button in front of the ‘Project Information’, 
information regarding the project, the company and the model can be entered. 

By clicking on the ‘Modify/Show’ button in front of the ‘Design Preferences’, 
the user preferences regarding the design code, concrete cover for slabs and beams, 
post-tensioning can be changed. The following ‘Design Preferences’ window 
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pops-up when the button is clicked. The ‘Min. Cover Slabs’ tab of the window 
may be of interest for this particular problem as footings will be modelled as slabs. 
Thus, click on this tab. This is the tab where the concrete cover and preferred rebar 
size will be entered. 

 
Figure 116. 

In the ‘Min. Cover Slabs’ tab, for ‘Non-Prestressed Reinforcement’ , both the 
‘Clear Cover Top’ and ‘Clear Cover Bottom’ should be set to 50mm as the 
concrete cover in this design problem stated to be 50mm. The ‘Preferred Bar Size’ 
can be set to any reasonable value. Here, the ‘Preferred Bar Size’ is set to 20 which 
is the diameter of the rebar in mm which will be used as the main reinforcement in 
the foundation. Leave the rest at they are. 

Once everything is set correctly in the ‘Design Data’ box, go to the ‘Initial Model’ 
box and select the suitable model. Since, an isolated (single) footing will be designed 
click on the big square button just above ‘Combined Footing’. The button itself 
shows a plan view of a combined footing. When the button is clicked, the following 
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‘Combined Footing’ window will pop up. In this window, there are three boxes: 
‘Plan Dimensions’, ‘Load’ and ‘Properties’. 

In the ‘Plan Dimensions’ box, the footing and column dimensions will be entered. 
While entering the footing dimension, it is the distance from the center of the 
columns to each of the edge which will be entered not the actual dimension of the 
footing. Since the distance from the left edge to the center of the column is 0.15m, 
the ‘Left Edge Distance’ is set to 0.15m. The distance from the center of the 
second column to the right edge, if you calculate it from the dimensions of the 
footing, is 1.15m. Thus, the value of set all the values of ‘Right Edge Distance’ is 
set to 1.15m. Since the column is centrally located in y-direction, the values of ‘Top 
Edge Distance’ and ‘Bottom Edge Distance’ are set to be 1.45m.  

The radio button below ‘Load Spacing and Size’ should be set to ‘X Direction’ 
as the columns will be aligned in x-direction. The value of the ‘Spacing’ should be 
set to 4.5 as the distance between the columns is 4.5m. For the ‘Load Size 
(square)’, the dimensions of any of the columns can be entered and later it can be 
changed depending on the actual footing dimensions. 

 
Figure 117 

Since in this design problem, the dimension of the first column is 300mmX300mm, 
enter 300 in the text field as the unit is already in mm. For column shapes other 
than square, just enter a preliminary column dimension and you can change both 
the shape and size of columns at a later time. 

In the ‘Load Values’ box, enter the concentrated loads and moments in the 
column depending on their type as ‘Dead’ or ‘Live’. In this particular problem, the 
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loads on each column are factored or ultimate loads comprised of dead and live 
loads. But, the self-weight is not included. Since, the self-weight is regarded as a 
dead load and should be multiplied by a partial safety factor. Thus, it is better if we 
define the factored loads as live loads with partial safety factor of unity. Thus, set 
the value for ‘P’ of ‘Load1’ to be 650 and the value for ‘P’ of ‘Load2’ to be 1000 
in the live load column. 

In the ‘Properties’ box, the footing thickness and the subgrade modulus of the soil 
will be entered. The footing thickness of the footing is given to be 500mm. Thus, 
enter this value as shown in fig. 117. However this value may be revised depending 
on the punching shear requirements at a later time. The subgrade modulus of a soil 
is the ratio of the increment of contact pressure to the corresponding change in 
settlement. In the absence of a supportive test to determine its value, it can also be 
safely approximated by the ratio of the bearing capacity of the soil to the maximum 
permissible settlement in the soil. In this particular problem, the subgrade modulus 
can be approximated by 100kN/m2/10mm = 10000kN/m3. Thus enter this value 
in the text field in front of the ‘Subgrade Modulus’. Then press the ‘OK’ button. 
This exits the ‘Combined Footing’ window and a plan view of the foundation will 
be displayed on the main screen. You can zoom in and zoom out using the wheel 
of your mouse or using the tool bar under the menu bar. 

 
Figure 118 

STEP 2: Defining Material Properties 

The materials which are involved in the design of the footing should be defined 
before the analysis. These materials are the concrete, the reinforcement bar (rebar) 
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and the soil which is already defined. Thus, the concrete property and the rebar 
property will be defined here. 

The material definition can be carried out in two ways. 

The first one is through the ‘Define’ menu in the menu bar. The other one through 
the model explorer on the left hand side of the home window. To define material 
properties through the former method, click on ‘Define’ menu and again click on 
‘Materials…’ resulting in the following window depending on prior material 
definitions. 

 
Figure 119 

The list in the ‘Materials’ box may not be exactly as it appears in your widow. 
However, that doesn’t bring any change in the outcome of the design process as 
you can customize this list any time. 

The ‘Add New Material Quick…’ button allows you to define materials quickly 
from a list of pre-defined materials. The ‘Add New Material’ button allows you 
to define materials by changing their properties. The ‘Add Copy of Material’ 
button allows you to define a material with same property as an already defined 
material. The ‘Modify/Show Material’ button displays the property of an already 
defined material with the possibility of modification. The ‘Delete Material’ button, 
when active, deletes a defined material property. 

For this particular problem, we will define concrete and rebar properties through 
the ‘Add New Material’ button. Thus, click on this button. This can also be 
achieved by right clicking on ‘Materials’ on the model explorer. The following 
window pops up in ether cases. 
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Figure 120 

This is the window where material properties are defined. First, let us define the 
concrete property which will be used in the design. Put any name for the material 
in the text field in front of ‘Material Name’. But, it is important to make sure that 
the concrete with the defined material name is assigned for the footing. For this 
particular problem, let the name of the concrete to be used be ‘C25’. Since we are 
defining a concrete, the ‘Material Type’ should be set to ‘Concrete’.  

The unit weight of reinforced concrete may vary depending of the design code of 
your country. Thus, enter the unit weight of reinforced concrete stipulated in your 
country code in the text field in front of ‘Weight per Unit Volume’. For this 
particular example, we will use 25kN/m3. 

For C-25 concrete, the modulus of elasticity according to BS 8110-1197 is around 
29GPa. Thus, enter this value in the text field in front of ‘Modulus of Elasticity, 
E’. If you selected another design code in step 1 while creating the model, you 
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should refer to actual value of this parameter from the code and enter it accordingly. 
Be aware of the units though. 

The values of Poisson’s ratio and coefficient of thermal expansion may also be 
defined in the design code and should be entered accordingly. For this particular 
problem, a value of 0.2 for ‘Poisson’s Ratio, U’ and a value of 10x10-6/oC for 
‘Coefficient of Thermal Expansion, A’ will be entered. The ‘Shear Modulus, G’ 
will be automatically calculated in an uneditable text field. 

The grade of concrete for this particular problem is C-25 which is a concrete with 
28 day characteristics cube compressive strength of 25MPa. The concrete 
designation may be different for different country codes but the concept is the 
same. Therefore, enter 25 in the text field in front of ‘Concrete Cube 
Compressive Strength, fcu’. 

If a lightweight concrete is used, check on ‘Lightweight Concrete’ and enter the 
corresponding ‘Shear Strength Reduction Factor’ in the space provided. 

When you press on ‘OK’, a concrete material with the above properties will be 
added to the list of materials. This material will be assigned for the footing before 
the analysis. 

After defining the concrete property, the program returns to the window shown in 
Fig. 119. To define a rebar property, we will follow the same procedure as we 
followed while defining the concrete property. Since a new rebar property will be 
defined, click on the ‘Add New Material…’ button. A ‘Material Property Data’ 
window pops up and when you change the ‘Material Type’ to ‘Rebar’, the window 
appears to look like the following. 
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Figure 121 

 

Change the ‘Material Name’ to any name you want. Here, we name it ‘S300’. The 
material type should be ‘Rebar’. The weight per unit volume of steel is stipulated 
in the design code. For BS 8110-1197, the weight per unit volume is 77.0085kN/m3. 
Thus, enter this value in the text field in front of ‘Weight per Unit Volume’. The 
modulus of elasticity for reinforcement bars according to the same design code is 
200GPa. Thus enter this value in the text field in front of ‘Modulus of Elasticity, 
E’ considering the unit. 

In the ‘Other Properties for Rebar Materials’ box, two quantities are mentioned: 
minimum yield stress and minimum tensile stress for the reinforcing material. The 
values of these parameters will be specified in the design code which you defined 
earlier. If the code assumes that the rebar material exhibits elastic perfectly plastic 
behavior, the values of these two quantities will be the same. The grade of steel to 
be used for this particular example is S-300. The yield stress for this type of 
reinforcement bar is 300MPa. Since the design code of my country assumes that 
rebars exhibit elastic perfectly plastic behavior, the minimum tensile stress will also 
be 300MPa. Thus enter 300 in both text fields in front of the ‘Minimum yield 
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stress, Fy’ and ‘Minimum Tensile Stress, Fu’. Then press ‘OK’ in both 
‘Material Property Data’ and ‘Materials’ windows concluding the material 
definition step. 

STEP 3: Defining Footing and Column Properties 

After defining the material properties, the footing and column properties can be 
defined. This definition can take place in two ways: from the menu bar and from 
the model explorer. In SAFE software, footings are modelled as ‘footings’ and 
foundation columns are modelled as ‘stiff’.  

To define footing and column properties from the menu bar, go to ‘Define’ menu 
and click on ‘Slab Properties…’. The following window will pop up. 

 
Figure 122 

In the ‘Slab Property’ box, two foundation components are listed. The names in 
this box for your particular design may be different from the list of names in the 
box. The ‘FOOTING’ corresponds to the bottom slab portion of the foundation 
and ‘STIFF’ corresponds to the foundation column. The ‘Add New Property…’ 
button prompts the user to enter new properties for the footing and foundation 
column while the ‘Add Copy of Property…’ copies the property of an existing 
slap. The ‘Modify/Show Property…’ allows the user to show the property of an 
existing component with the possibility of modification. When the ‘Delete 
Property’ button is active, it allows the user to delete an existing slab property. 

In this case, we use the ‘Modify/Show Property…’ button. However, one can 
also use the ‘Add New Property…’ button. To use ‘Modify/Show Property…’ 
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button, highlight the foundation component to be modified like the ‘FOOTING’ 
is highlighted in Fig. 122 and click on this button. Since ‘FOOTING’ is 
highlighted, we will be modifying the footing property. The following window 
appears after the click. 

 
Figure 123 

The ‘Property Name’ will be automatically assigned to ‘FOOTING’. The ‘Slab 
Material’ should be set to the concrete grade which is defined in step 2. Since the 
name of the concrete material defined in step 2 for this particular problem is ‘C25’, 
a material with this name should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Footing’ as we are 
modifying the footing property. The ‘Thickness’ value should be set to the same 
value as the one which is used while creating the model. Since the thickness of the 
footing is 500mm, this value is entered in the text field corresponding to 
‘Thickness’. As footings are modelled as thick plates, check the ‘Thick Plate’ 
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option. The ‘Orthotropic’ check box is selected when a footing with irregular 
dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window in Fig. 11 gets activated. Now, the property of the 
foundation column will be modified. To do this, highlight ‘STIFF’ in the ‘Slab 
Property’ box and click on the ‘Modify/Slab Property…’ button. The following 
window appears after the click. 

 
Figure 124 

The ‘Property Name’ will be automatically assigned to ‘STIFF’. The ‘Slab 
Material’ should be set to the concrete grade which is defined in step 2. Since the 
name of the concrete material defined in step 2 for this particular problem is ‘C25’, 
a material with this name should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Stiff’ as we are 
modifying the footing property. The ‘Thickness’ value should be set to the same 
value as the thickness of the footing which is 500mm, this value is entered in the 
text field corresponding to ‘Thickness’. As foundation columns are modelled as 
thick plates, check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is 
selected when a column with irregular dimension is to be used. 
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When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window in Fig. 122 gets activated. Again press ‘OK’ and exit the 
window for defining the footing and foundation column. 

STEP 4: Defining Load Patterns, Load Cases and Load Combinations 

The loads on the foundation should be defined accordingly before the analysis. 
First, the load pattern should be defined. This can be done from the ‘Define’ menu 
or from the ‘Model Explorer’. This time, we will do it from the model explorer. 
In the model explorer, expand ‘Load Definitions’ and you will see ‘Load 
Patterns’. When you expand ‘Load Patterns’, you will see ‘DEAD’ and ‘LIVE’. 
At the end, the model explorer appears to look like: 

 
Figure 125 

Now, right click on ‘Load Patterns’ and click on ‘New Load Pattern’ and the 
following window pops up. 
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Figure 126 

In the ‘Load Patterns’ window, two load patterns are already defined: ‘DEAD’ 
and ‘LIVE’. The ‘Type’ of the ‘Load’ should also be changed accordingly. There 
are many options for type of loading. The ‘Type’ for dead loads should be set to 
‘DEAD’ and for live loads ‘LIVE’. If there are other types of load patterns on the 
foundation such as earth quake load, you can add the load pattern with the ‘Add 
Load Pattern’ button. You can also delete any undesirable load pattern using the 
‘Delete Load Pattern’ button. Since in this example, we have only dead and live 
loads, we will leave the existing load patterns as they are. The ‘Self Weight 
Multiplier’ value should also be changed accordingly. This value imparts the option 
whether to include or leave the self-weight of the foundation in addition to external 
loads. If the self-weight of the foundation is already included as an external dead 
load or if you want to exclude the effect of self-weight from the analysis, the value 
under ‘Self Weight Multiplier’ should be set to zero. In this example, we will 
consider the self-weight as an additional load to the external dead load. Thus, the 
value under ‘Self Weight Multiplier’ for the ‘DEAD’ load is one. For the ‘LIVE’ 
load, it will be zero. Press ‘OK’ and the window will be exited. 

After this, the load cases will be defined. Load cases are used to dictate the way the 
loads are applied (statically or dynamically) or the way the structure responds 
(linearly or non-linearly) for the defined load patterns. To define a load case, go to 
‘Define’ menu and click on ‘Load Cases…’. The following window will pop up 
after the click. 
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Figure 127 

The load patterns which were defined earlier will automatically appear in the list of 
‘Load Case Name’ of the ‘Load Cases’ window. The ‘Load Case Type’ column 
shows the way in which each load pattern will be applied during analysis. If you 
want to modify this, highlight the load pattern for which you are going to change 
the load case type and click on the ‘Modify/Show Case…’ button. If you click 
this button, the following window will appear. In this window, you can change the 
way the load is applied from the ‘Load Case Type’ box. The way the structure 
responds can also be selected from the ‘Analysis Type’ box. This problem ‘Static’ 
is for the ‘Load Case Type’ and ‘Linear’ is selected for the ‘Analysis Type’ since 
the load is static and the foundation responds linearly. The scale factor for the dead 
load in the ‘Loads Applied’ box will be left as one. Press ‘OK’ and exit the window. 

The load case type for the live load should also be ‘Linear Static’. Otherwise, it 
should be changed by clicking the ‘Modify/Show Case…’ button to linear static 
case. If both the load case types are as desired click ‘OK’ and exit the ‘Load Cases’ 
window. 
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Figure 128 

Definition of the load combinations will be the next step. Two load combinations 
will be considered in this example for ultimate limit state and serviceability limit 
state. To define load combinations, go to ‘Define’ menu and click on ‘Load 
Combinations…’ and the following window pops up. 

 
Figure 129 
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New load combinations will be added through the ‘Add New Combo…’ button. 
Here, two load combinations will be added; one for the ultimate limit state the other 
for the serviceability limit state. When the ‘Add New Combo…’ button is clicked, 
the following window appears. 

 
Figure 130 

In the ‘Load Combination Data’ window, any name can be given for the load 
combination. The ‘Combination Type’ should be set to ‘Linear Add’ as the 
component loads (dead and live) will be added linearly. However, there are also 
other options from the drop down menu in front of ‘Combination Type’. In the 
window shown in Fig. 130, the two loads (dead and live) should be activated below 
the ‘Load Name’ column of the ‘Define Combination of Load Case/Combo 
Results’ box. The values in the ‘Scale Factor’ column correspond to the partial 
safety factors for load for the failure mode under consideration. These partial safety 
factors are specified in the design code of your country. In the design code of my 
country, the partial safety factor for dead loads for ultimate limit sate case is 1.3 for 
the cases where there are only dead and live loads. For such load patterns, the partial 
safety factor for live loads for ultimate limit state case is 1.6. In this particular 
problem, the loads are already factored and for convenience, they are defined as 
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live loads. The only un-factored load is the self-weight which will be considered as 
dead load. The self-weight is considered as a dead load while defining the load 
patterns by making the self-weight multiplier to be equal to one. Thus, enter a value 
of 1.3 in front of ‘DEAD’ and 1 in front of ‘LIVE’ in ‘Scale Factor’ column. The 
failure condition which is being under consideration can be defined by selecting 
and deselecting the check boxes in the ‘Design Selection’ box. Since the above 
scale factors are for the ultimate limit state, check on ‘Strength (Ultimate)’.  

STEP 6: Drawing Actual Column Dimensions and Design Strips 

The column shape and dimensions can be changed at this stage. The column is 
shown at the center of the plan view in Fig.118 with somewhat darker color. Since 
a single column dimension is entered and since, in this problem, there are two types 
of column sizes, the column dimensions should be revised. The dimension of the 
second column should be adjusted to 350X350mm. 

To change the dimensions of the second column, the existing column should be 
deleted and another column with the right dimension should be drawn. So, carefully 
select the second column. At the bottom left corner of the window, it should 
display, ‘1 Areas, 4 Edges selected’. Otherwise, you should press the ‘Esc’ key 
and select again. Once, the column is selected, delete it using the ‘Delete’ key. 

To draw a new column of actual dimensions, go to the ‘Draw’ menu and click on 
‘Quick Draw Slabs/Areas Around Points’ or simply click on the equivalent icon 

 from the left hand side toolbar. After the click, the following window will be 
displayed. 

 
Figure 131 

In this window, the ‘Shape of Object’ should be ‘Rectangular Slab’ and set the 
‘Property’ to ‘STIFF’ as we will be drawing a foundation column. The dimension 
of the column are 0.35m in both x-direction and y-directions. Thus, set the ‘X 
Dimension [m]’ and ‘Y Dimension [m]’ values to 0.35. With great care, move 
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the cursor to the center of the second column and when you see a small red cross, 
make one left click and close the ‘Quick Draw Areas Around Points’ window. 

Design strips determine the way in which different quantities related to the 
reinforcement calculation are calculated. Forces are integrated across the design 
strips. Thus, the larger the width of coverage of the design strips within the given 
structure, the higher will be the calculated values of the bending moments and shear 
forces. Thus, an optimum width of strip is required compromising the safety and 
economical requirements. The width of the design strip will be specified in the 
design code. According to the code of my country, the width of column strips for 
combined foundations should extend up to a distance of 0.5 times the depth from 
the face of the support in the direction of the line connecting the two columns (x-
direction). The area between the column strips in y-direction should be covered 
with middle strips. In the transverse direction (x-direction), the whole length should 
be covered with a column strip. These design strips in X and Y direction are usually 
defined in SAFE software as layer A and layer B. Thus, the column strip at the first 
column in y-direction will have the following dimensions when the strip is drawn 
from bottom to top: ‘Start Width Left [m]’ = 0.15m, ‘Start Width Right [m]’ = 
0.15+0.5/2=0.40m, ‘End Width Left [m]’ = 0.15m, ‘End Width Right [m]’ = 
0.15+0.5/2=0.40m. 

For combined footings, the existing design strips drawn by the program itself can 
be used. You can display the design strips by setting the display options by clicking 
on ‘Set Display Options…’ from the ‘View’ menu or by simultaneously clicking 
on ‘Ctrl’ and ‘W’ keys or by just clicking on the set display options icon  from 
the tool bar below the menu bar. This results in the following window: 
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Figure 132 

Then, check on ‘Labels’, ‘Show Width’ and ‘Show Stations’ in the ‘Design Strip 
Objects’ box and check both ‘Design Strip Layer A’ and ‘Design Strip Layer B’ 
and press ‘OK’ and the following window appears displaying the design strips in 
the two directions. 

 
Figure 133 
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STEP 7: Assigning Slab Data, Support Data and Load Data 

The slab data, support data, and load data which are defined in the previous steps 
should be assigned to the corresponding structural component. The way to do this 
is first to select the component and next to assign the slab property, support 
property or loads accordingly. The selection can be done by clicking on the 
component from the plan view or through the ‘Select’ menu. The latter option 
assures that the component is selected exactly as selection by clicking may result in 
incorrect selection. Thus, all the selections here will be done from the ‘Select’ 
menu. The assignments will be discussed as follows: 

f. Assigning slab data to the footing 
Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘Footing’ and 
press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Slab Data’>’Properties…’. Then select ‘FOOTING’ and 
press ‘OK’. 
 

g. Assigning slab data to the foundation column 
Select the foundation column through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘Stiff’ and press 
‘OK’. Then assign the footing property through the following strings of commands 
‘Assign’>’Slab Data’>’Properties…’. Then select ‘STIFF’ and press ‘OK’. 
 

h. Assigning support data to the footing 
Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘Footing’ and 
press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Support Data’>’Soil Properties…’. Then select ‘SOIL’ 
and press ‘OK’. 
 

i. Assigning reinforcement data to the design strips 
Select each design strip through the following strings of commands 
‘Select’>’Select’>’Properties’>Design Strip Layers…’. Then select ‘A’ or ‘B’ 
(one at a time) and press ‘OK’. When you right click on the selected strip layer, the 
‘Slab-Type Area Object Information’ window pops up. In the ‘Design’ tab of 
this window, set the ‘Rebar Material’ to ‘S300’ and press ‘OK’. Do this for both 
strips. 

j. Assigning load on the foundation column 
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The loads are already assigned on the foundation column. However the dimension 
of the second column should be modified. To do this, right click at the center of 
the second column. In the ‘Loads’ tab of the appearing window, click on ‘Assign 
Loads’ button then select ‘Force Loads’ then press ‘OK’. 

 
Figure 134 

 
Then select ‘LIVE’, enter its value accordingly and in the right direction (axis), then 
select ‘Replace to Existing Loads’ and press ‘OK’. While doing this, the 
foundation column dimensions should be entered in the ‘Size of Load for 
Punching Shear’ box of ‘Point Loads’ window. In this example, since the live 
load is 1000kN for the second column, this should be entered in the Gravity 
Direction and the values of ‘Load Size in X Dimension (mm)’ and ‘Load Size 
in Y Dimension (mm)’ should both be set to 350. 
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STEP 8: Running the Analysis 

After this, the analysis can be run. But, make sure that the footing and the 
foundation column are assigned with the correct rebar material. To do this, right 
click anywhere in the plan view of the footing and the ‘Slab-Type Area Object 
Information’ window will pop-up. 

 
Figure 135 

In the ‘Design’ tab of this window, set the value of ‘Rebar Material’ to ‘S300’. 
Do this for the column foundation, and both design strips as well. After this, go to 
the ‘Run’ menu and click on the ‘Run Analysis & Design’ command or simply 
click on the ‘F5’ key. When you do this, you will be prompted to save the model, if 
you haven’t already don this. When you save the model, the following window 
showing the displacement of the soil in a banded figure will be displayed. 

STEP 9: Displaying the Output 

 

After the analysis is run the following output will be displayed on the plan view 
window. 
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Figure 136 

To display the punching shear ratio, go to the ‘Display’ menu and click on ‘Show 
Punching Shear Design’. After this, the punching shear ratio will be displayed in 
the plan view around the foundation column as in the following figure. 

 
Figure 137 

As can be noticed from the figure, the punching shear ratio is 1.5443 for the first 
column and 0.9814 for the second column. Generally, a punching shear ratio less 
than one indicates the concrete thickness is adequate to resist punching shear and 
a value greater than one indicates that the punching shear capacity is exceeded 
somewhere along the critical section. For economical design, it is recommended to 
keep the punching shear ratio between 0.95 and 1 as very small values of punching 
shear ratio means excess concrete thickness is used. However, if the punching shear 
ratio is greater than one, the thickness of the concrete should be increased and the 
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foundation should be re-designed. In this problem, since the punching shear ratio 
at column 1 is greater than one, the footing depth should be revised. However, 
since this is just an illustration of how to design foundations with SAFE, we will 
proceed as if the depth of the footing was adequate for punching shear. A detailed 
quantitative description of the foundation design can also be obtained by right 
clicking on the plan view shown in Fig 137 as shown below. Several trial may be 
made by zooming in and out to get the quantitative description. 

 
Figure 138 

Through the ‘Display’ menu, relevant quantities can be displayed on the screen. 
For instance, the ‘Display’>’Show Strip Forces’ command or by simply clicking 
the ‘F8’ key, the following window will be displayed. 
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Figure 139 

In this window, the ‘Load Case/Load Combination’ box provides with radio 
buttons to select for which particular load case or load combination that we want 
to display the output. The ‘Component’ box contains four radio buttons to select 
which quantity to display. The ‘Show Forces For These Strip Layers’ box allows 
us to select the strip layer for which the quantity is displayed. Both strip layers can 
be selected at the same time. From the ‘Scaling’ box, we can select whether 
automatic scaling or user defined scaling is used while displaying the diagram. The 
‘Display Options’ box allows us to fill or not to fill the diagram and to display or 
not to display the values on the diagram. For the preferences shown in Fig. 30, the 
following diagram will be displayed. 
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Figure 140 

The ‘Display’>’Show Slab Design…’ command results in the window shown in 
Fig 141. In this window, several options can be set in order to display the footing 
design in the way we wanted to. The ‘Choose Display Type’ box allows us to 
select the ‘Design Basis’ between ‘Strip Based’ and ‘Finite Element Based’. 
Unless some differences in the way the design is displayed, there is no difference in 
the amount of reinforcement between these selections. Through the ‘Display 
Type’ in the same box, it can be selected whether to display flexural reinforcement 
or shear reinforcement. This box also allows us to impose or not to impose 
minimum reinforcement during the design. The ‘Rebar Location Shown’ box 
allows us to select which reinforcement, top or bottom or both, to be displayed. 
The ‘Reinforcing Display Type’ box allows us to set the manner in which the 
amount of reinforcement is displayed. The option whether to show the reinforcing 
envelop diagram and the reinforcing extent can be set by the check boxes in the 
‘Reinforcing Diagram’ window. The strip layer direction for which the amount 
of reinforcement is displayed can be chosen from the ‘Choose Strip Direction’ 
box. The ‘Display Options’ box allows us whether to display output in filled 
diagram or not and whether the values at controlling stations will be displayed or 
not. If we want to display the amount of reinforcement above some specified 
reinforcement bar area or spacing, we can use the options in the ‘Show Rebar 
Above Specified Value’ box. When the ‘Typical Uniform Reinforcing 
Specified Below’ radio button is selected, the ‘Typical Uniform Reinforcing’ 
box get activated. In this box, we can set a specific value above which the 
reinforcement amount will be displayed. The reinforcement diagram output, for the 
options set in Fig. 141, will be shown below in fig. 142. 
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Figure 141 

 
Figure 142 
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As can be noticed from the footing design diagram in fig. 142, the top 
reinforcement across strip layer A is 1834mm2/m and 0mm2/m for bottom 
reinforcement at the location indicated by the vertical line. 

The design outputs can also be displayed in tabular format by clicking on the ‘Show 
Tables…’ menu item from the ‘Display’ menu or by just clicking on the equivalent 

icon  from the tool bar below the menu bar and the following window will 
pop up. 

 
Figure 143 

In this window, we can select any of the model definitions or analysis results or 
design results and press ‘OK’ to display the quantity which we want to have a look 
at. By using the right hand side buttons in the window, the load patterns and the 
load cases can be selected. 

STEP 10: Detailing 

After running the analysis and after checking that the results are reasonable, the 
detailing will be done. However, before running the detailing, the detailing 
preferences can be set from the ‘Detailing’ menu. From the ‘Detailing 
Preferences…’, the likes of dimensional units and material quantity units can be 
selected. From ‘Slab/Mat Detailing Preferences…’, the likes of rebar 
curtailment options, the rebar detailing options, rebar selection rules and preferred 
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rebar sizes can be selected. The ‘Drawing Sheet Set-up…’ menu allows us to set-
up the contents of the drawing sheet. The ‘Drawing Format Properties…’ allows 
us to set some formats in which the output displayed. 

 

To run the detailing, go to ‘Run’ menu and click on ‘Run Detailing…’ or 
simultaneously press  ‘Shift’ and ‘F5’ keys or just click on the run detailing icon 

 from the tool bar just below the menu bar. Then, the ‘Run Detailing 
Options’ window pops up so that we set the detailing options. Set the detailing 
options which you want and click ‘OK’. 

Once the detailing is run, the detailing can be displayed. The detailing display 
options can be best accessed from the ‘Model Explorer’. When expanded in full, 
the ‘Detailing’ tab of the model explorer looks like: 

 
Figure 144 
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By clicking on any of the options from the detailing tab, a desired detailing can be 
displayed. For instance, by double clicking on the ‘Footing Table’, the following 
detail of footing can be shown. 

 
Figure 145 

In this detail, the diameter of the reinforcement which is used is 10mm. If you want 
to change the diameter…. 

Apart from this detail, other details can also be shown.  

STEP 11: Reporting 

The last step of foundation design is reporting. Before creating the report, the 
report preferences should be set up. To do this, go to the ‘File’ menu and click on 
‘Report Set-up…’ and the following window pops up. 

In this ‘Report Setup Data’ window, the user preferences regarding the reporting 
such as the report output type, the report page orientation and the report items can 
be set along with the load patterns and load combinations. Once the preference is 
set, the report can be created by clicking on ‘Create Report’ command in the ‘File’ 
menu. The ‘Advanced Report Writer’ command in the same menu can be used to 
set some advanced reporting formats. 
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Figure 146 

This concludes the tutorial for the design of single footing using the built-in model. 
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3.2. Using Grids 
 

STEP 1: Creating the Model 

To create a footing model by using a grid, there are three ways. Go to ‘File’ menu 

and click on ‘New Model …’ or just click on the icon  . This icon is the first 
among the list of icons just below the menu bar or simply click on the ‘Ctrl’ and 
‘N’ keys simultaneously (Ctrl+N). 

Performing one of the above three ways results in the popping-up of the 
following ‘New Model Initialization’ window. 

This window consists of two parts: the ‘Design Data’ part and the ‘Initial Model’ 
part. In the ‘Design Data’, there are ‘Design Code’, ’Design Preferences’, 
‘Project Information’ and ‘Units’. 

The ‘Design Code’ consists of a list of selected design codes from many countries. 
Depending on the suitability of the code for your country, you may select one 
among the list of codes. The design code which follows similar design philosophy 
to my country code is BS 8110-1997. So, this design code is selected. 

Design a trapezoidal combined footing shown in the figure below 

 
• Ultimate bearing capacity of the soil : 100kPa 
• Allowable settlement of the soil : 10mm 
• Grade of concrete: C-30 (30MPa 28-day characteristics cube strength) 
• Grade of reinforcement bar (rebar): S-400 (400MPa characteristics yield 

strength) 
• Overall thickness of the foundation: 600mm 
• Concrete cover : 50mm 
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After selecting the design code, it is better to first select the units to be used in the 
design and analysis process. These units can be selected by clicking on the 
‘Modify/Show’ button in front of ‘Units’. The following window pops up when 
the button is clicked. To choose metric units, click on ‘Metric Defaults’ button. 
The click results in metric units for best practices to be selected. It can be observed 
that, even though all the units are metric, they are not consistent. To select a 
preferred consistent unit, click on the ‘Consistent Units’ button. In this ‘Units’ 
window, the decimal places and minimum number of significant digits for any 
quantity can also be modified. 

 

Figure 147 

By clicking on the ‘Modify/Show’ button in front of the ‘Project Information’, 
information regarding the project, the company and the model can be entered. 

By clicking on the ‘Modify/Show’ button in front of the ‘Design Preferences’, 
the user preferences regarding the design code, concrete cover for slabs and beams, 
post-tensioning can be changed. The following ‘Design Preferences’ window 
pops-up when the button is clicked. The ‘Min. Cover Slabs’ tab of the window 
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may be of interest for this particular problem as footings will be modelled as slabs. 
Thus, click on this tab. This is the tab where the concrete cover and preferred rebar 
size will be entered. 

 

Figure 148 

In the ‘Min. Cover Slabs’ tab, for ‘Non-Prestressed Reinforcement’ , both the 
‘Clear Cover Top’ and ‘Clear Cover Bottom’ should be set to 50mm as the 
concrete cover in this design problem stated to be 50mm. The ‘Preferred Bar Size’ 
can be set to any reasonable value. Here, the ‘Preferred Bar Size’ is set to 20 which 
is the diameter of the rebar in mm which will be used as the main reinforcement in 
the foundation. Leave the rest at they are. 
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Figure 149 

Once everything is set correctly in the ‘Design Data’ box, go to the ‘Initial Model’ 
box and select the suitable model. Since an isolated (single) footing will be designed 
from grids click on the big square button just above ‘Grid Only’. The button itself 
shows crossing grids. When the button is clicked, the following ‘Coordinate 
System Definition’ window, shown in fig. 150, will pop up.  

The footing in this example is trapezoidal with two columns. The grids which will 
be created will be boundaries of the outer edges of the footing and the outer edges 
of the foundation column. As a result, there is uneven spacing between the grids 
and there will be slanting grids. To create such slanting grids with uneven spacing, 
it is better to create it by clicking the ‘Edit Grid’ button. When you click this button, 
a ‘Coordinate System’ window will pop up. In the ‘Display Grid Data as’ box, 
two radio buttons are there to choose between ‘Ordinate’ and ‘Spacing’. These 
are the options how the location of different grids is defined. If the ‘Ordinate’ 
option is selected, the X and Y-coordinates of the grids will be entered. If the 
‘Spacing’ option is selected, the spacing between the grids will be selected. If the 
grids are irregular in shape with non-vertical and non-horizontal grids, they can be 
defined in the ‘General Grid Data’ box by entering the XY coordinates of the 
starting and ending points of the grids. Regular grids can also be defined by this 
option too. For this particular example, we will use the ‘General Grid Data’ box. 
To use this ‘General Grid Data’ box, first delete the existing coordinates from ‘X 
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Grid Data’ and ‘Y Grid Data’ by clicking on the left hand side arrow and pressing 
the ‘Delete’ key. 

 
Figure 150 

In this example, the values which will be entered are shown in the coordinates of 
the starting point (X1, Y1) and the coordinates of the ending point (X2, Y2) for all 
the grid lines in the following table. Here, the bottom left corner of the footing will 
be considered as the origin of the coordinate system. 

Grid 
ID. 

X1 Y1 X2 Y2 Description 

1 0 0 5 1 Bottom edge 
2 0 1.55 5 1.55 Bottom grid for column1 
3 0 2.15 5 2.15 Top grid for column1 
4 0 3.7 5 2.7 Top edge 
5 0 1.65 5 1.65 Bottom grid for column2 
6 0 2.05 5 2.05 Top grid for column 2 
A 0 0 0 3.7 Left edge 
B 0.6 0 0.6 3.7 Right grid for column1 
C 4.6 0 4.6 3.7 Left grid for column2 
D 5 0 5 3.7 Right edge 
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Figure 151 

The ‘Model Datum’ is the level of the model in z-direction. Any value can be set 
to this. Set the ‘Story Height Above’ value to some reasonable non zero value, say 
2, and set the ‘Story Height Below’ to 0 as there will be no story below the footing. 
Then press ‘OK’ and the grids will be displayed on the ‘Plan View’ window as 
below: 
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Figure 152 

STEP 2: Defining Material Properties 

The materials which are involved in the design of the footing should be defined 
before the analysis. These materials are the concrete, the reinforcement bar (rebar) 
and the soil support. Thus, these properties will be defined here. 

The material definition can be carried out in two ways. 

The first one is through the ‘Define’ menu in the menu bar. The other one through 
the model explorer on the left hand side of the home window. To define material 
properties through the former method, click on ‘Define’ menu and again click on 
‘Materials…’ resulting in the following window depending on prior material 
definitions. 

The list in the ‘Materials’ box may not be exactly as it appears in your widow. 
However, that doesn’t bring any change in the outcome of the design process as 
you can customize this list any time. 

The ‘Add New Material Quick…’ button allows you to define materials quickly 
from a list of pre-defined materials. The ‘Add New Material’ button allows you 
to define materials by changing their properties. The ‘Add Copy of Material’ 
button allows you to define a material with same property as an already defined 
material. The ‘Modify/Show Material’ button displays the property of an already 
defined material with the possibility of modification. The ‘Delete Material’ button, 
when active, deletes a defined material property. 
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Figure 153 

For this particular problem, we will modify the existing ‘C30’ concrete using the 
‘Modify/Show Material’ button and define a new rebar property through the 
‘Add New Material’ button.  

Highlight ‘C30’ in the ‘Materials’ box and click on the ‘Modify/Show Material’ 
button. This can also be achieved by right clicking on ‘Materials’ on the model 
explorer. The following window will pop up. 

This is the window where concrete properties will be modified. Put any name for 
the material in the text field in front of ‘Material Name’. But, it is important to 
make sure that the concrete with the defined material name is assigned for the 
footing. For this particular problem, let us keep the name of the concrete as ‘C30’. 
Since we are defining a concrete, the ‘Material Type’ should be set to ‘Concrete’.  

The unit weight of reinforced concrete may vary depending of the design code of 
your country. Thus, enter the unit weight of reinforced concrete stipulated in your 
country code in the text field in front of ‘Weight per Unit Volume’. For this 
particular example, we will use 25kN/m3. 
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Figure 154 

For C-30 concrete, the modulus of elasticity according to BS 8110-1197 is around 
32GPa. Thus, enter this value in the text field in front of ‘Modulus of Elasticity, 
E’. If you selected another design code in step 1 while creating the model, you 
should refer to actual value of this parameter from the code and enter it accordingly. 
Be aware of the units though. 

The values of Poisson’s ratio and coefficient of thermal expansion may also be 
defined in the design code and should be entered accordingly. For this particular 
problem, a value of 0.2 for ‘Poisson’s Ratio, U’ and a value of 10x10-6/oC for 
‘Coefficient of Thermal Expansion, A’ will be entered. The ‘Shear Modulus, G’ 
will be automatically calculated in an un-editable text field. 

The grade of concrete for this particular problem is C-30. C-30 is a concrete with 
28 day characteristics cube compressive strength of 30MPa. The concrete 
designation may be different for different country codes but the concept is the 
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same. Therefore, enter 30 in the text field in front of ‘Concrete Cube 
Compressive Strength, fcu’. 

If a lightweight concrete is used, check on ‘Lightweight Concrete’ and enter the 
corresponding ‘Shear Strength Reduction Factor’ in the space provided. 

When you press on ‘OK’, a concrete material with the above properties will be 
added to the list of materials. This material will be assigned for the footing before 
the analysis. 

After modifying the concrete property, the program returns to the window shown 
in Fig. 44. To define a rebar property, we will follow the same procedure as we 
followed while defining the concrete property. Since a new rebar property will be 
defined, click on the ‘Add New Material…’ button. A ‘Material Property Data’ 
window pops up and when you change the ‘Material Type’ to ‘Rebar’, the window 
appears to look like the following. 

 
Figure 155 
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Change the ‘Material Name’ to any name you want. Here, we name it ‘S400’. The 
material type should be ‘Rebar’. The weight per unit volume of steel is stipulated 
in the design code. For BS 8110-1197, the weight per unit volume is 77.0085kN/m3. 
Thus, enter this value in the text field in front of ‘Weight per Unit Volume’. The 
modulus of elasticity for reinforcement bars according to the same design code is 
200GPa. Thus enter this value in the text field in front of ‘Modulus of Elasticity, 
E’ considering the unit. 

In the ‘Other Properties for Rebar Materials’ box, two quantities are mentioned: 
minimum yield stress and minimum tensile stress for the reinforcing material. The 
values of these parameters will be specified in the design code which you defined 
earlier. If the code assumes that the rebar material exhibits elastic perfectly plastic 
behavior, the values of these two quantities will be the same. The grade of steel to 
be used for this particular example is S-400. The yield stress for this type of 
reinforcement bar is 400MPa. Since the design code of my country assumes that 
rebars exhibit elastic perfectly plastic behavior, the minimum tensile stress will also 
be 400MPa. Thus enter 400 in both text fields in front of the ‘Minimum yield 
stress, Fy’ and ‘Minimum Tensile Stress, Fu’. Then press ‘OK’ in both 
‘Material Property Data’ and ‘Materials’ windows concluding the material 
definition step. 

The other property which should be defined is the soil support. To define the soil 
properties, go to the ‘Define’ menu and click on ‘Soil Subgrade Properties’ menu 
item and the following window appears. 

 
Figure 156 
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By using the buttons in this window, a new soil property or copy of soil property 
can be added. An existing soil property can also be modified or deleted. For this 
problem, let us add a new soil property by using the ‘Add New Property…’ 
button. Thus, click on this button and the following window pops up.  

 
Figure 157 

In this window, set the property name to ‘SOIL’ and change the subgrade modulus 
to 10,000kN/m3. Because, the subgrade modulus which can be assume by the ratio 
of the bearing capacity by the allowable settlement for this particular example is so. 
Then press ‘OK’ in both the ‘Soil Subgrade Property Data’ and ‘Soil Subgrade 
Properties’ windows. 

STEP 3: Defining Footing and Column Properties 

After defining the material properties, the footing and column properties can be 
defined. This definition can take place in two ways: from the menu bar and from 
the model explorer. In SAFE software, footings are modelled as ‘footings’ and 
foundation columns are modelled as ‘stiff’.  

To define footing and column properties from the menu bar, go to ‘Define’ menu 
and click on ‘Slab Properties…’. The following window will pop up. 

The ‘Add New Property…’ button prompts the user to enter new properties for 
the footing and foundation column while the ‘Add Copy of Property…’ copies 
the property of an existing slap. The ‘Modify/Show Property…’ allows the user 
to show the property of an existing component with the possibility of modification. 
When the ‘Delete Property’ button is active, it allows the user to delete an existing 
slab property. 
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Figure 158 

In this case, we use the ‘Add New Property…’ button to add new slab properties 
for the footing and foundation column. Click the button and the following window 
will pop up. 

 
Figure 159 

The ‘Property Name’ can be assigned with any name; but, in this case, the property 
name which will be used is ‘FOOTING’. The ‘Slab Material’ should be set to the 
concrete grade which is defined in step 2. Since the name of the concrete material 
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defined in step 2 for this particular problem is ‘C30’, a material with this name 
should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Footing’. The 
‘Thickness’ value should be set to the thickness of the footing defined in the 
example. Since the thickness of the footing is 600mm, this value is entered in the 
text field corresponding to ‘Thickness’. As footings are modelled as thick plates, 
check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected when a 
footing with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Now, the property of the foundation 
column will be added. To do this, again click on the ‘Add New Property…’ button. 
The following window appears after the click. 

 
Figure 160 

The ‘Property Name’ can be any name but we use ‘STIFF’. The ‘Slab Material’ 
should be set to the concrete grade which is defined in step 2. Since the name of 
the concrete material defined in step 2 for this particular problem is ‘C30’, a material 
with this name should be selected from the list. 
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In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Stiff’ as we are 
defining the property of column. The ‘Thickness’ value should be equal to the 
footing thickness which is 600mm. This value should be entered in the text field 
corresponding to ‘Thickness’. As foundation columns are modelled as thick plates, 
check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected when a 
column with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Again press ‘OK’ and exit the window for 
defining the footing and foundation column. 

STEP 4: Defining Load Patterns, Load Cases and Load Combinations 

The loads on the foundation should be defined accordingly before the analysis. 
First, the load pattern should be defined. This can be done from the ‘Define’ menu 
or from the ‘Model Explorer’. This time, we will do it from the model explorer. 
In the model explorer, expand ‘Load Definitions’ and you will see ‘Load 
Patterns’. When you expand ‘Load Patterns’, you will see ‘DEAD’ and ‘LIVE’. 
At the end, the model explorer appears to look like: 
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Figure 161 

Now, right click on ‘Load Patterns’ and click on ‘New Load Pattern’ and the 
following window pops up. 

 
Figure 162 

In the ‘Load Patterns’ window, two load patterns are already defined: ‘DEAD’ 
and ‘LIVE’. The ‘Type’ of the ‘Load’ should also be changed accordingly. There 
are many options for type of loading. The ‘Type’ for dead loads should be set to 
‘DEAD’ and for live loads ‘LIVE’. If there are other types of load patterns on the 
foundation such as earth quake load, you can add the load pattern with the ‘Add 
Load Pattern’ button. You can also delete any undesirable load pattern using the 
‘Delete Load Pattern’ button. Since in this example, we have only dead and live 
loads, we will leave the existing load patterns as they are. The ‘Self Weight 
Multiplier’ value should also be changed accordingly. This value imparts the option 
whether to consider or ignore the self-weight of the foundation in addition to 
external loads. If the self-weight of the foundation is already included as an external 
dead load or if you want to exclude the effect of self-weight from the analysis, the 
value under ‘Self Weight Multiplier’ should be set to zero. In this example, we 
will consider the self-weight as an additional load to the external dead load. Thus, 
the value under ‘Self Weight Multiplier’ for the ‘DEAD’ load is one. For the 
‘LIVE’ load, it will be zero. Press ‘OK’ and the window will be exited. 

After this, the load cases will be defined. Load cases are used to dictate the way the 
loads are applied (statically or dynamically) or the way the structure responds 
(linearly or non-linearly) for the defined load patterns. To define a load case, go to 
‘Define’ menu and click on ‘Load Cases…’. The following window will pop up 
after the click. 
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Figure 163 

The load patterns which were defined earlier will automatically appear in the list of 
‘Load Case Name’ of the ‘Load Cases’ window. The ‘Load Case Type’ column 
shows the way in which each load pattern will be applied during analysis. If you 
want to modify this, highlight the load pattern for which you are going to change 
the load case type and click on the ‘Modify/Show Case…’ button. If you click 
this button, the following window will appear. In this window, you can change the 
way the load is applied from the ‘Load Case Type’ box. The way the structure 
responds can also be selected from the ‘Analysis Type’ box. This problem ‘Static’ 
is for the ‘Load Case Type’ and ‘Linear’ is selected for the ‘Analysis Type’ since 
the load is static and the foundation responds linearly. The scale factor for the dead 
load in the ‘Loads Applied’ box will be left as one. Press ‘OK’ and exit the window. 

The load case type for the live load should also be ‘Linear Static’. Otherwise, it 
should be changed by clicking the ‘Modify/Show Case…’ button to linear static 
case. If both the load case types are as desired click ‘OK’ and exit the ‘Load Cases’ 
window. 
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Figure 164 

Definition of the load combinations will be the next step. Two load combinations 
will be considered in this example for ultimate limit state and serviceability limit 
state. To define load combinations, go to ‘Define’ menu and click on ‘Load 
Combinations…’ and the following window pops up. 

 
Figure 165 
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New load combinations will be added through the ‘Add New Combo…’ button. 
Here, two load combinations will be added; one for the ultimate limit state the other 
for the serviceability limit state. When the ‘Add New Combo…’ button is clicked, 
the following window appears. 

 
Figure 166 

In the ‘Load Combination Data’ window, any name can be given for the load 
combination. The ‘Combination Type’ should be set to ‘Linear Add’ as the 
component loads (dead and live) will be added linearly. However, there are also 
other options from the drop down menu in front of ‘Combination Type’. In the 
window shown in Fig. 166, the two loads (dead and live) should be activated below 
the ‘Load Name’ column of the ‘Define Combination of Load Case/Combo 
Results’ box. The values in the ‘Scale Factor’ column correspond to the partial 
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safety factors for load for the failure mode under consideration. These partial safety 
factors are specified in the design code of your country. In the design code of my 
country, the partial safety factor for dead loads for ultimate limit sate case is 1.3 and 
for serviceability limit state is 1 for the cases where there are only dead and live 
loads. For such load patterns, the partial safety factor for live loads for ultimate 
limit sate case is 1.6 and for serviceability limit state is 1. Thus, enter a value of 1.3 
in front of ‘DEAD’ and 1.6 in front of ‘LIVE’ in ‘Scale Factor’ column. The 
failure condition which is being under consideration can be defined by selecting 
and deselecting the check boxes in the ‘Design Selection’ box. Since the above 
scale factors are for the ultimate limit state, check on ‘Strength (Ultimate)’. The 
‘Load Combination Data’ window for the serviceability limit state looks like the 
following window. 

 
Figure 167 



 

159  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

STEP 6: Drawing the Footing Components and Design Strips 

The footing, the foundation column and a point where the loads will be applied on 
the foundation column should now be drawn on the grid. 

iv. Drawing the footing 
Since the footing will be drawn around points and since the footing is 
rectangular, go to the ‘Draw’ menu and click on ‘Draw Slabs/Areas’ or 

simply click on the equivalent icon  on the left hand side tool bar. The 
following window will appear on the screen after the click. 

 
Figure 168 

Making sure that the ‘Property’ is set to ‘FOOTING’, and the ‘Edge 
Drawing Type’ to ‘Straight Line’, click on the grid where the four corners 
of the footing will be located. Repeating the click at the first click point will 
draw a trapezoidal foundation. 

v. Drawing the foundation column 
While the window in fig 168 is active, change the ‘Property’ to ‘STIFF’ and 
click on the grid where the four corners of the foundation columns will be 
located. Repeating the click at the first click for both foundation columns 
will draw the foundation columns with their respective sizes. Note that, the 
first column is 0.6mX0.6m while the second column is 0.4mX0.4m. 

vi. Drawing the point on the foundation column where the load will be applied 
Go to ‘Draw’ menu and click on ‘Draw Points’, then click on the mid-point 
of the foundation columns and the points will be created. If the cursor could 
not snap to the midpoint, you can adjust the ‘Snap Options’ from the 
‘Draw’ menu. 

After this, the design strips will be drawn. Design strips determine the way in which 
different quantities related to the reinforcement calculation are calculated. Forces 
are integrated across the design strips. Thus, the larger the width of coverage of the 
design strips within the given structure, the higher will be the calculated values of 
the bending moments and shear forces. Thus, an optimum width of strip is required 
compromising the safety and economical requirements. The width of the design 
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strip will be specified in the design code. According to the code of my country, the 
width of design strips for isolated foundations is 1m. Thus, a one meter design strip 
will be drawn in both X and Y directions on the foundation. These design strips in 
X and Y direction are usually defined in SAFE software as layer A and layer B. 

To draw the design strip, go to the ‘Draw’ menu and click on ‘Design Strips’ or 

simply click on the equivalent icon from the left hand sided tool bar and the 
following window pops up. 

 
Figure 169 

In this window, the ‘Strip Layer’ should be selected to be either ‘A’ or ‘B’. But if 
‘A’ is for design strip in X direction ‘B’ should be for Y direction and vice versa. 
Since we are drawing a strip around the column to consider maximum moment and 
shear forces, the ‘Strip Design Type’ should be set to ‘Column Strip’. Since the 
whole footing area should be covered with design strip in x-direction, the width of 
the strip in x-direction will be 3.7m at the start and 1.7m at the end. Since, the 
footing is symmetrical about the centerline in x-direction, the ‘Start Width Left [m]’ 
and ‘Start Width Right [m]’ values will be 1.85 while the ‘End Width Left [m]’ and 
‘End Width Right [m]’ values will be 0.85. To draw the design strip in the X 
direction, without closing the window, left click at the center of left side of the 
footing on the plan view parallel to the Y axis and again left click at the center of 
the parallel side and right click. This creates a design strip in X direction. In doing 
so, if you can’t snap to the center of the side of the footing, you can modify the 
snap options by clicking on the ‘Snap Options…’ command from the ‘Draw’ 
menu and adjusting the options which you want to snap to.  

The design strip in Y direction can also be drawn in a similar procedure after 
changing the ‘Strip Layer’ to ‘B’. The design strips in y direction extend for a 
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distance of half of the depth from the face of the support for each column. Thus, 
the widths of the strips for each column 1 and column 2 are shown in Fig. 170(a) 
and 170(b) respectively. When you make the click to draw the strips make sure that 
you click at the bottom first and then at the top for both design strips. 

 

(a)                                               (b) 
Figure 170 

Middle strips should also be drawn between the column strips in y-direction 
(transverse direction). To draw middle strips, change the ‘Strip Design Type’ in 
the ‘Draw Design Strips’ window to ‘Middle Strip’ and enter the right values of 
the widths of the middle strips to the right and to the left of the point from which 
you will start drawing the strips. For this example, if we start drawing the middle 
strip from x = 2.5m, the values of ‘Start Width Left [m]’, ‘Start Width Right 
[m]’, ‘End Width Left [m]’ and ‘End Width Right [m]’ are 1.6,1.8,1.6 and 1.8 
respectively. So, enter these values and draw the middle strip between the two 
column strips. 

You can display the design strips by setting the display options by clicking on ‘Set 
Display Options…’ from the ‘View’ menu or by simultaneously clicking on ‘Ctrl’ 
and ‘W’ keys or by just clicking on the set display options icon  from the tool 
bar below the menu bar. This results in the following window: 
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Figure 171 

Then, check on ‘Labels’, ‘Show Width’ and ‘Show Stations’ in the ‘Design Strip 
Objects’ box and press ‘OK’ and after drawing dimension lines by using the 
command ‘Draw’>’Draw Dimension Lines’, the following window appears 
displaying the design strips in the two directions. 

 
Figure 172 
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STEP 7: Assigning Slab Data, Support Data and Load Data 

The slab data, support data, and load data which are defined in the previous steps 
should be assigned to the corresponding structural component. The way to do this 
is first to select the component and next to assign the slab property, support 
property or loads accordingly. The selection can be done by clicking on the 
component from the plan view or through the ‘Select’ menu. The latter option 
assures that the component is selected exactly as selection by clicking may result in 
incorrect selection. Thus, all the selections here will be done from the ‘Select’ 
menu. The assignments will be discussed as follows: 

 
d. Assigning support data to the footing 

Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘FOOTING’ 
and press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Support Data’>’Soil Properties…’. Then select ‘SOIL’ 
and press ‘OK’. 
 

e. Assigning reinforcement data to the design strips 
Select each design strip through the following strings of commands 
‘Select’>’Select’>’Properties’>Design Strip Layers…’. Then select ‘A’ or ‘B’ 
(one at a time) and press ‘OK’. When you right click on the selected strip layer, the 
‘Slab-Type Area Object Information’ window pops up. In the ‘Design’ tab of 
this window, set the ‘Rebar Material’ to ‘S400’ and press ‘OK’. Do this for both 
strips. 
 

f. Assigning load on the foundation columns 
To assign load on the foundation columns, right click on the point at the center of 
each foundation column (one at a time) and a ‘Point Object Information’ window 
pops up. In this window, click on the ‘Loads’ tab.  
 
The dead load and the live load can be assigned through the ‘Assign Load…’ 
button. The procedure is: click on ‘Assign Load…’ button, then select ‘Force 
Loads’ then press ‘OK’ then select either ‘DEAD’ or ‘LIVE’ depending on which 
loads you want to enter their values then enter their values accordingly (both the 
concentrated load and the bending moment) and in the right direction (axis), then 
select ‘Add to Existing Loads’ and press ‘OK’. While doing this, the foundation 
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column dimensions should be entered in the ‘Size of Load for Punching Shear’ 
box of ‘Point Loads’ window.  
 

 
Figure 173 

 
You can also delete any forces which are wrongly entered through ‘Delete 
Existing Loads’ radio button option. In this example, the dead concentrated load 
is 439kN and the live load is 125kN for the column1. For the second column, the 
dead concentrated load is 380kN and the live concentrated load is 100kN for the 
second column. These values are entered accordingly and the final values for the 
second column are shown in Fig 173. 

STEP 8: Running the Analysis 

After this, the analysis can be run. But, make sure that the footing and the 
foundation column are assigned with the correct rebar material. To do this, right 
click anywhere in the plan view of the footing and the ‘Slab-Type Area Object 
Information’ window will pop-up. 
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Figure 174 

In the ‘Design’ tab of this window, set the value of ‘Rebar Material’ to ‘S400’. 
Do this for the column foundation, and both design strips as well. After this, go to 
the ‘Run’ menu and click on ‘Run Analysis & Design’ command or simply click 
on the ‘F5’ key. When you do this, you will be prompted to save the model, if you 
haven’t already done this. 

STEP 9: Displaying the Output 

After running the analysis the following output diagram will be displayed on the 
plan view window. 



 

166  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

 
Figure 175 

To display the punching shear ratio, go to the ‘Display’ menu and click on ‘Show 
Punching Shear Design’. After this, the punching shear ratio will be displayed in 
the plan view around the foundation column as in the following figure. 

 
Figure 176 

As can be noticed from the figure, the punching shear ratio is for the first column 
is 1.0826 and for the second column is 1.1421. Generally, a punching shear ratio 
less than one indicates the concrete thickness is adequate to resist punching shear 
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and a value greater than one indicates that the punching shear capacity is exceeded 
somewhere along the critical section. For economical design, it is recommended to 
keep the punching shear ratio between 0.95 and 1 as very small values of punching 
shear ratio means excess concrete thickness is used. However, if the punching shear 
ratio is greater than one, the thickness of the concrete should be increased and the 
foundation should be re-designed. Since the objective of this tutorial is to show you 
how to design foundations with SAFE, we will proceed with the design process as 
if the depth was adequate for punching shear requirement. A detailed quantitative 
description of the foundation design for each column can also be obtained by right 
clicking on the plan view. The detailed description for the first column is shown in 
Fig 177. Several trial may be made by zooming in and out to get the quantitative 
description. 

 
Figure 177 

Through the ‘Display’ menu, relevant quantities can be displayed on the screen. 
For instance, the ‘Display’>’Show Strip Forces’ command or by simply clicking 
the ‘F8’ key, the following window will be displayed. 
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Figure 178 

In this window, the ‘Load Case/Load Combination’ box provides with radio 
buttons to select for which particular load case or load combination that we want 
to display the output. The ‘Component’ box contains four radio buttons to select 
which quantity to display. The ‘Show Forces For These Strip Layers’ box allows 
us to select the strip layer for which the quantity is displayed. Both strip layers can 
be selected at the same time. From the ‘Scaling’ box, we can select whether 
automatic scaling or user defined scaling is used while displaying the diagram. The 
‘Display Options’ box allows us to fill or not to fill the diagram and to display or 
not to display the values on the diagram. For the preferences shown in Fig. 68, the 
following diagram will be displayed. 



 

169  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

 
Figure 179 

The ‘Display’>’Show Slab Design…’ command results in the window shown in 
Fig 180. In this window, several options can be set in order to display the footing 
design in the way we wanted to. The ‘Choose Display Type’ box allows us to 
select the ‘Design Basis’ between ‘Strip Based’ and ‘Finite Element Based’. 
Unless some differences in the way the design is displayed, there is no difference in 
the amount of reinforcement between these selections. Through the ‘Display 
Type’ in the same box, it can be selected whether to display flexural reinforcement 
or shear reinforcement. This box also allows us to impose or not to impose 
minimum reinforcement during the design. The ‘Rebar Location Shown’ box 
allows us to select which reinforcement, top or bottom or both, to be displayed. 
The ‘Reinforcing Display Type’ box allows us to set the manner in which the 
amount of reinforcement is displayed. The option whether to show the reinforcing 
envelop diagram and the reinforcing extent can be set by the check boxes in the 
‘Reinforcing Diagram’ window. The strip layer direction for which the amount 
of reinforcement is displayed can be chosen from the ‘Choose Strip Direction’ 
box. The ‘Display Options’ box allows us whether to display output in filled 
diagram or not and whether the values at controlling stations will be displayed or 
not. If we want to display the amount of reinforcement above some specified 
reinforcement bar area or spacing, we can use the options in the ‘Show Rebar 
Above Specified Value’ box. When the ‘Typical Uniform Reinforcing 
Specified Below’ radio button is selected, the ‘Typical Uniform Reinforcing’ 
box get activated. In this box, we can set a specific value above which the 
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reinforcement amount will be displayed. The reinforcement diagram output, for the 
options set in Fig. 180, will be shown below in fig. 181. 

 
Figure 180 
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Figure 181 

As can be noticed from the footing design diagram in fig. 71, the top reinforcement 
across strip layer A is around 0mm2/m for bottom reinforcement and 1348mm2/m 
for top reinforcement. 

The design outputs can also be displayed in tabular format by clicking on the ‘Show 
Tables…’ menu item from the ‘Display’ menu or by just clicking on the equivalent 

icon  from the tool bar below the menu bar and the following window will 
pop up. 
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Figure 182 

In this window, we can select any of the model definitions or analysis results or 
design results and press ‘OK’ to display the quantity which we want to have a look 
at. By using the right hand side buttons in the window, the load patterns and the 
load cases can be selected. 

STEP 10: Detailing 

After running the analysis and after checking that the results are reasonable, the 
detailing will be done. However, before running the detailing, the detailing 
preferences can be set from the ‘Detailing’ menu. From the ‘Detailing 
Preferences…’, the likes of dimensional units and material quantity units can be 
selected. From ‘Slab/Mat Detailing Preferences…’, the likes of rebar 
curtailment options, the rebar detailing options, rebar selection rules and preferred 
rebar sizes can be selected. The ‘Drawing Sheet Set-up…’ menu allows us to set-
up the contents of the drawing sheet. The ‘Drawing Format Properties…’ allows 
us to set some formats in which the output displayed. 
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To run the detailing, go to ‘Run’ menu and click on ‘Run Detailing…’ or 
simultaneously press  ‘Shift’ and ‘F5’ keys or just click on the run detailing icon 

 from the tool bar just below the menu bar. Then, the ‘Run Detailing 
Options’ window pops up so that we set the detailing options. Set the detailing 
options which you want and click ‘OK’. 

Once the detailing is run, the detailing can be displayed. The detailing display 
options can be best accessed from the ‘Model Explorer’. When expanded in full, 
the ‘Detailing’ tab of the model explorer looks like: 

 
Figure 183 

By clicking on any of the options from the detailing tab, a desired detailing can be 
displayed. For instance, by double clicking on the ‘Footing Table’, the following 
detail of footing can be shown. In the detail, the foundation is displayed as a 
rectangular footing, which is not in accordance with the actual geometry. Thus, 
good judgment is required while utilizing the design results. 
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Figure 184 

In this detail, the diameter of the reinforcement which is used is 10mm. If you want 
to change the diameter…. 

Apart from this detail, other details can also be shown.  

STEP 11: Reporting 

The last step of foundation design is reporting. Before creating the report, the 
report preferences should be set up. To do this, go to the ‘File’ menu and click on 
‘Report Set-up…’ and the following window pops up. 

In this ‘Report Setup Data’ window, the user preferences regarding the reporting 
such as the report output type, the report page orientation and the report items can 
be set along with the load patterns and load combinations. Once the preference is 
set, the report can be created by clicking on ‘Create Report’ command in the ‘File’ 
menu. The ‘Advanced Report Writer’ command in the same menu can be used to 
set some advanced reporting formats. 
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Figure 185 

This concludes the tutorial for the design of single footing using the grids. 
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3.3. From AutoCAD 
 

 

 

STEP 
1: 

Creating the Model 

To create a footing model from an AutoCAD file, first draw the plan view of the 
foundation on AutoCAD. In this case, it will be a rectangle with dimensions of 
5.6mX1.8m (footing) and three squares (foundation columns). When you draw the 
plan view on AutoCAD, make sure that you are drawing it on a new layer. If you 
want the origin of the SAFE mode to coincide with the center of the circular 
foundation, make the center of the circle coincide with the global origin of the 
AutoCAD file when you draw it. Then save the AutoCAD file in DXF format. To 
save an AutoCAD file in DXF format, go to ‘File’ menu in the AutoCAD file and 
click on ‘Save As’. At the bottom of the upcoming window, just below the text 
field where you will enter the file name, you will see ‘Files of type’ with a drop-
down menu list. From the drop down menu list, select the option which has ‘(.dxf)’ 
at the end. Then enter the file name and save it at any location in your computer 
where you can easily remember close it. This saves the file in DXF format. 

Design the combined foundation shown below with the given parameters: 

 
• Ultimate bearing capacity of the soil : 100kN/m2 
• Maximum allowable settlement of the foundation: 10mm 
• Grade of concrete: C-20 (20MPa 28-day characteristics cube strength) 
• Grade of reinforcement bar (rebar): S-460 (460MPa characteristics yield 

strength) 
• Overall thickness of the foundation: 600mm 
• Concrete cover : 50mm 
• All the given loads are factored (ultimate) loads. 
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Once you saved the AutoCAD file in DXF format, open the SAFE software and 
when you use the command ‘File’>’Import’>’.DXF/.DWG Architectural Plan’ 
or when you simultaneously click on ‘Ctrl’+’Shift’+’I’ keys, and you will be 
prompted to open a file.  Open the DXF file from the location where you saved it 
and the following window will pop up. 

In this window, just change the ‘CAD Drawing Units’ to ‘m’ since in the 
AutoCAD file is the model is drawn in meter units. Then press ‘OK’. 

 

Figure 186 

Then, the following model appears in the plan view. As can be noted, the left 
bottom corner of the footing coincides with the origin of the coordinate system. 
To achieve this, make sure that that this corner coincides with the origin of the 
Global coordinate system while drawing the plan view on the AutoCAD. 
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Figure 187 

After the model is created, the preferences regarding the units, the design codes 
and concrete cover should be entered. To change the units, click on ‘Units…’ 
button which is found in the right bottom corner of the main window and the 
following widow will pop up. In this window, click on ‘Metric Defaults’ and press 
‘OK’ as we will be using metric units. If you want to use U.S. units click on ‘U.S. 
Defaults’ and if you want to use a particular metric or U.S. unit consistently click 
on ‘Consistent Units…’ and select that particular unit which you want to use 
consistently. 

.  
Figure 188 
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To select the design code and other design preferences, go to ‘Design’ menu and 
click on ‘Design Preferences…’ and the following window will pop up. In the 
‘Code’ tab of this window, change the ‘Design Code’ to ‘BS 8110-1997’ or any 
other code which you want to design the circular foundation with. In the ‘Min. 
Cover Slabs’ tab, for ‘Non-Prestressed Reinforcement’ , both the ‘Clear Cover 
Top’ and ‘Clear Cover Bottom’ should be set to 50mm as the concrete cover in 
this design problem stated to be 50mm. The ‘Preferred Bar Size’ can be set to any 
reasonable value. Here, the ‘Preferred Bar Size’ is set to #14 which is the bar 
number which will be used as the main reinforcement in the foundation. Leave the 
rest as they are and press ‘OK’. 

 
Figure 189 

STEP 2: Defining Material Properties 

The materials which are involved in the design of the footing should be defined 
before the analysis. These materials are the concrete, the reinforcement bar (rebar) 
and the soil support. Thus, these properties will be defined here. 

The material definition can be carried out in two ways. 

The first one is through the ‘Define’ menu in the menu bar. The other one through 
the model explorer on the left hand side of the home window. To define material 
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properties through the former method, click on ‘Define’ menu and again click on 
‘Materials…’ resulting in the following window depending on prior material 
definitions. 

The list in the ‘Materials’ box may not be exactly as it appears in your widow. 
However, that doesn’t bring any change in the outcome of the design process as 
you can customize this list any time. 

The ‘Add New Material Quick…’ button allows you to define materials quickly 
from a list of pre-defined materials. The ‘Add New Material’ button allows you 
to define materials by changing their properties. The ‘Add Copy of Material’ 
button allows you to define a material with same property as an already defined 
material. The ‘Modify/Show Material’ button displays the property of an already 
defined material with the possibility of modification. The ‘Delete Material’ button, 
when active, deletes a defined material property. 

 
Figure 190 

For this particular problem, we will add new concrete and a rebar materials using 
the ‘Add New Material…’ button. Thus click on this button and the following 
window will pop up. 

This is the window where concrete properties will be modified. Put any name for 
the material in the text field in front of ‘Material Name’. But, it is important to 
make sure that the concrete with the defined material name is assigned for the 
footing. For this particular problem, let us use the name of the concrete as ‘C20’. 
Since we are defining a concrete, the ‘Material Type’ should be set to ‘Concrete’.  

The unit weight of reinforced concrete may vary depending of the design code of 
your country. Thus, enter the unit weight of reinforced concrete stipulated in your 
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country code in the text field in front of ‘Weight per Unit Volume’. For this 
particular example, we will use 25kN/m3. 

 

 
Figure 191 

For C-20 concrete, the modulus of elasticity according to BS 8110-1197 is around 
27GPa. Thus, enter this value in the text field in front of ‘Modulus of Elasticity, 
E’. If you selected another design code in step 1 while creating the model, you 
should refer to actual value of this parameter from the code and enter it accordingly. 
Be aware of the units though. 

The values of Poisson’s ratio and coefficient of thermal expansion may also be 
defined in the design code and should be entered accordingly. For this particular 
problem, a value of 0.2 for ‘Poisson’s Ratio, U’ and a value of 10x10-6/oC for 
‘Coefficient of Thermal Expansion, A’ will be entered. The ‘Shear Modulus, G’ 
will be automatically calculated in an un-editable text field. 

The grade of concrete for this particular problem is C-20. C-20 is a concrete with 
28 day characteristics cube compressive strength of 20MPa. The concrete 
designation may be different for different country codes but the concept is the 
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same. Therefore, enter 20 in the text field in front of ‘Concrete Cube 
Compressive Strength, fcu’. 

If a lightweight concrete is used, check on ‘Lightweight Concrete’ and enter the 
corresponding ‘Shear Strength Reduction Factor’ in the space provided. 

When you press on ‘OK’, a concrete material with the above properties will be 
added to the list of materials. This material will be assigned for the footing before 
the analysis. 

After adding a new concrete property, the program returns to the window shown 
in Fig. 190. To define a rebar property, we will follow the same procedure as we 
followed while defining the concrete property. Since a new rebar property will be 
defined, click on the ‘Add New Material…’ button. A ‘Material Property Data’ 
window pops up and when you change the ‘Material Type’ to ‘Rebar’, the window 
appears to look like the following. 

 
Figure 192 

Change the ‘Material Name’ to any name you want. Here, we name it ‘S460’. The 
material type should be ‘Rebar’. The weight per unit volume of steel is stipulated 
in the design code. For BS 8110-1197, the weight per unit volume is 77.0085kN/m3. 
Thus, enter this value in the text field in front of ‘Weight per Unit Volume’. The 
modulus of elasticity for reinforcement bars according to the same design code is 
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200GPa. Thus enter this value in the text field in front of ‘Modulus of Elasticity, 
E’ considering the unit. 

In the ‘Other Properties for Rebar Materials’ box, two quantities are mentioned: 
minimum yield stress and minimum tensile stress for the reinforcing material. The 
values of these parameters will be specified in the design code which you defined 
earlier. If the code assumes that the rebar material exhibits elastic perfectly plastic 
behavior, the values of these two quantities will be the same. The grade of steel to 
be used for this particular example is S-460. The yield stress for this type of 
reinforcement bar is 460MPa. Since the design code of my country assumes that 
rebars exhibit elastic perfectly plastic behavior, the minimum tensile stress will also 
be 460MPa. Thus enter 460 in both text fields in front of the ‘Minimum yield 
stress, Fy’ and ‘Minimum Tensile Stress, Fu’. Then press ‘OK’ in both 
‘Material Property Data’ and ‘Materials’ windows concluding the material 
definition step. 

The other property which should be defined is the soil support. To define the soil 
properties, go to the ‘Define’ menu and click on ‘Soil Subgrade Properties’ menu 
item and the following window appears. 

 
Figure 193 

By using the buttons in this window, a new soil property or copy of soil property 
can be added. An existing soil property can also be modified or deleted. For this 
problem, let us add a new soil property by using the ‘Add New Property…’ 
button. Thus, click on this button and the following window pops up.  
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Figure 194 

In this window, set the property name to ‘SOIL’ and change the subgrade modulus 
to 10,000kN/m3. Because, the subgrade modulus which can be assume by the ratio 
of the bearing capacity by the allowable settlement for this particular example is so. 
Then press ‘OK’ in both the ‘Soil Subgrade Property Data’ and ‘Soil Subgrade 
Properties’ windows. 

STEP 3: Defining Footing and Column Properties 

After defining the material properties, the footing and column properties can be 
defined. This definition can take place in two ways: from the menu bar and from 
the model explorer. In SAFE software, footings are modelled as ‘footings’ and 
foundation columns are modelled as ‘stiff’.  

To define footing and column properties from the menu bar, go to ‘Define’ menu 
and click on ‘Slab Properties…’. The following window will pop up. 

The ‘Add New Property…’ button prompts the user to enter new properties for 
the footing and foundation column while the ‘Add Copy of Property…’ copies 
the property of an existing slap. The ‘Modify/Show Property…’ allows the user 
to show the property of an existing component with the possibility of modification. 
When the ‘Delete Property’ button is active, it allows the user to delete an existing 
slab property. 
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Figure 195 

In this case, we use the ‘Add New Property…’ button to add new slab properties 
for the footing and foundation column. Click the button and the following window 
will pop up. 

 
Figure 196 

The ‘Property Name’ can be assigned with any name; but, in this case, the property 
name which will be used is ‘FOOTING’. The ‘Slab Material’ should be set to the 
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concrete grade which is defined in step 2. Since the name of the concrete material 
defined in step 2 for this particular problem is ‘C20’, a material with this name 
should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Footing’. The 
‘Thickness’ value should be set to the thickness of the footing defined in the 
example. Since the thickness of the footing is 600mm, this value is entered in the 
text field corresponding to ‘Thickness’. As footings are modelled as thick plates, 
check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected when a 
footing with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Now, the property of the foundation 
column will be added. To do this, again click on the ‘Add New Property…’ button. 
The following window appears after the click. 

 
Figure 197 

The ‘Property Name’ can be any name but we use ‘STIFF’. The ‘Slab Material’ 
should be set to the concrete grade which is defined in step 2. Since the name of 
the concrete material defined in step 2 for this particular problem is ‘C20’, a material 
with this name should be selected from the list. 
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In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Stiff’ as we are 
defining the property of column. The ‘Thickness’ value should be thickness of the 
footing which is 600mm. This value should be entered in the text field 
corresponding to ‘Thickness’. As foundation columns are modelled as thick plates, 
check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected when a 
column with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Again press ‘OK’ and exit the window for 
defining the footing and foundation column. 

STEP 4: Defining Load Patterns, Load Cases and Load Combinations 

The loads on the foundation should be defined accordingly before the analysis. 
First, the load pattern should be defined. This can be done from the ‘Define’ menu 
or from the ‘Model Explorer’. This time, we will do it from the model explorer. 
In the model explorer, expand ‘Load Definitions’ and you will see ‘Load 
Patterns’. When you expand ‘Load Patterns’, you will see ‘DEAD’ and ‘LIVE’. 
At the end, the model explorer appears to look like: 

 
Figure 198 
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Now, right click on ‘Load Patterns’ and click on ‘New Load Pattern’ and the 
following window pops up. 

 
Figure 199 

In the ‘Load Patterns’ window, two load patterns are already defined: ‘DEAD’ 
and ‘LIVE’. The ‘Type’ of the ‘Load’ should also be changed accordingly. There 
are many options for type of loading. The ‘Type’ for dead loads should be set to 
‘DEAD’ and for live loads ‘LIVE’. If there are other types of load patterns on the 
foundation such as earth quake load, you can add the load pattern with the ‘Add 
Load Pattern’ button. You can also delete any undesirable load pattern using the 
‘Delete Load Pattern’ button. Since in this example, we have only dead and live 
loads, we will leave the existing load patterns as they are. The ‘Self Weight 
Multiplier’ value should also be changed accordingly. This value imparts the option 
whether to consider or ignore the self-weight of the foundation in addition to 
external loads. If the self-weight of the foundation is already included as an external 
dead load or if you want to exclude the effect of self-weight from the analysis, the 
value under ‘Self Weight Multiplier’ should be set to zero. In this example, we 
will consider the self-weight as an additional load to the external dead load. Thus, 
the value under ‘Self Weight Multiplier’ for the ‘DEAD’ load is one. For the 
‘LIVE’ load, it will be zero. Press ‘OK’ and the window will be exited. 

After this, the load cases will be defined. Load cases are used to dictate the way the 
loads are applied (statically or dynamically) or the way the structure responds 
(linearly or non-linearly) for the defined load patterns. To define a load case, go to 
‘Define’ menu and click on ‘Load Cases…’. The following window will pop up 
after the click. 
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Figure 200 

The load patterns which were defined earlier will automatically appear in the list of 
‘Load Case Name’ of the ‘Load Cases’ window. The ‘Load Case Type’ column 
shows the way in which each load pattern will be applied during analysis. If you 
want to modify this, highlight the load pattern for which you are going to change 
the load case type and click on the ‘Modify/Show Case…’ button. If you click 
this button, the following window will appear. In this window, you can change the 
way the load is applied from the ‘Load Case Type’ box. The way the structure 
responds can also be selected from the ‘Analysis Type’ box. This problem ‘Static’ 
is for the ‘Load Case Type’ and ‘Linear’ is selected for the ‘Analysis Type’ since 
the load is static and the foundation responds linearly. The scale factor for the dead 
load in the ‘Loads Applied’ box will be left as one. Press ‘OK’ and exit the window. 

The load case type for the live load should also be ‘Linear Static’. Otherwise, it 
should be changed by clicking the ‘Modify/Show Case…’ button to linear static 
case. If both the load case types are as desired click ‘OK’ and exit the ‘Load Cases’ 
window. 
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Figure 201 

Definition of the load combinations will be the next step. Since the loads are 
factored, only one load combination will be considered. To define load 
combination, go to ‘Define’ menu and click on ‘Load Combinations…’ and the 
following window pops up. 

 
Figure 202 
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New load combinations will be added through the ‘Add New Combo…’ button. 
The load combination which will be considered is factoring only the self-weight 
which is considered as a dead load and the other factored loads will be considered 
as live loads for convenience and the scaling factor for the live loads will be one. 
When the ‘Add New Combo…’ button is clicked, the following window appears. 

 
Figure 203 

In the ‘Load Combination Data’ window, any name can be given for the load 
combination. The ‘Combination Type’ should be set to ‘Linear Add’ as the 
component loads (dead and live) will be added linearly. However, there are also 
other options from the drop down menu in front of ‘Combination Type’. In the 
window shown in Fig. 203, the two loads (dead and live) should be activated below 
the ‘Load Name’ column of the ‘Define Combination of Load Case/Combo 
Results’ box. The values in the ‘Scale Factor’ column correspond to the partial 
safety factors for load for the failure mode under consideration. These partial safety 
factors are specified in the design code of your country. In the design code of my 
country, the partial safety factor for dead loads for ultimate limit sate case is 1.3 for 
the case where there are only dead and live loads. For such load patterns, the partial 
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safety factor for live loads for ultimate limit sate case would have been 1.6. But, in 
this case, since the loads are already factored and for convenience reason since the 
factored loads are considered as live loads, a scaling factor of unity will be used. 
Thus, enter a value of 1.3 in front of ‘DEAD’ and 1 in front of ‘LIVE’ in ‘Scale 
Factor’ column. The failure condition which is being under consideration can be 
defined by selecting and deselecting the check boxes in the ‘Design Selection’ box. 
The serviceability limit state will not be considered for this case. 

STEP 6: Drawing the Footing Components and Design Strips 

The footing, the foundation column and a point where the loads will be applied on 
the foundation column should now be drawn on the grid. 

j. Drawing the footing 
The footing will be drawn as a rectangular slab. Thus, go to the ‘Draw’ menu 
and click on ‘Draw Rectangular Slabs/Areas…’ or click on the equivalent 

icon from the left hand side tool bar and the following window will pop 
up. 

 
Figure 204 

Make sure that the ‘Property’ is set to ‘FOOTING’ and click at one corner 
of the footing. Then, without releasing the click, drag into the opposite 
corner and release the click. This draws a rectangular footing. 

iv. Drawing the foundation column 
While the window in fig 204 is active, change the ‘Property’ to ‘STIFF’ and 
draw the three columns by following a similar procedure which you used 
while drawing the footing. 

v. Drawing the points on the foundation columns where the load will be applied 
Go to ‘Draw’ menu and click on ‘Draw Points’, then click on the mid-point 
of each of the footing and the points will be created. If the cursor could not 
snap to the midpoint, you can adjust the ‘Snap Options’ from the ‘Draw’ 
menu. 

After this, the design strips will be drawn. Design strips determine the way in which 
different quantities related to the reinforcement calculation are calculated. Forces 
are integrated across the design strips. Thus, the larger the width of coverage of the 
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design strips within the given structure, the higher will be the calculated values of 
the bending moments and shear forces. Thus, an optimum width of strip is required 
compromising the safety and economical requirements. The width of the design 
strip will be specified in the design code. According to the code of my country, the 
width of design strips for combined foundations in the longitudinal direction 
should cover the whole area of the footing. In this particular problem, the width of 
the strips in x-direction is 1.8m. The design strips in the transverse direction will be 
defined for each column and should extend to a distance of half the depth of the 
footing from the face of the column on each side. These design strips in X and Y 
direction are usually defined in SAFE software as layer A and layer B. 

To draw the design strip, go to the ‘Draw’ menu and click on ‘Design Strips’ or 

simply click on the equivalent icon from the left hand sided tool bar and the 
following window pops up. 

 
Figure 205 

In this window, the ‘Strip Layer’ should be selected to be either ‘A’ or ‘B’. But if 
‘A’ is for design strip in X direction ‘B’ should be for Y direction and vice versa. 
The window in fug 205 is for the design strip in X direction. The ‘Draw Design 
Strips’ windows for column1 and column3 in the transverse direction are shown 
in fig. 206(a) and for column2 in the same direction is shown in fig. 206(b). 

(a)                                                           (b) 
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Figure 206 

Since we are drawing a strip around the column to consider maximum moment and 
shear forces, the ‘Strip Design Type’ should be set to ‘Column Strip’. While 
drawing the design strips, if you can’t snap to the intended points on the footing, 
you can modify the snap options by clicking on the ‘Snap Options…’ command 
from the ‘Draw’ menu and adjusting the options which you want to snap to. Or 
you can use other ways to draw the design strips. The design strip in Y direction 
can also be drawn in a similar procedure after changing the ‘Strip Layer’ to ‘B’. 

You can display the design strips by setting the display options by clicking on ‘Set 
Display Options…’ from the ‘View’ menu or by simultaneously clicking on ‘Ctrl’ 
and ‘W’ keys or by just clicking on the set display options icon  from the tool 
bar below the menu bar. This results in the following window: 

 
Figure 207 

Then, check on ‘Labels’, ‘Show Width’ and ‘Show Stations’ in the ‘Design Strip 
Objects’ box and press ‘OK’ and after drawing dimension lines by using the 
command ‘Draw’>’Draw Dimension Lines’, the following window appears 
displaying the design strips in the two directions. 
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Figure 208 

STEP 7: Assigning Slab Data, Support Data and Load Data 

The slab data, support data, and load data which are defined in the previous steps 
should be assigned to the corresponding structural component. The way to do this 
is first to select the component and next to assign the slab property, support 
property or loads accordingly. The selection can be done by clicking on the 
component from the plan view or through the ‘Select’ menu. The latter option 
assures that the component is selected exactly as selection by clicking may result in 
incorrect selection. Thus, all the selections here will be done from the ‘Select’ 
menu. The assignments will be discussed as follows: 

d. Assigning support data to the footing 
Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘FOOTING’ 
and press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Support Data’>’Soil Properties…’. Then select ‘SOIL’ 
and press ‘OK’. 
 

e. Assigning reinforcement data to the design strips 
Select each design strip through the following strings of commands 
‘Select’>’Select’>’Properties’>Design Strip Layers…’. Then select ‘A’ or ‘B’ 
(one at a time) and press ‘OK’. When you right click on the selected strip layer, the 
‘Slab-Type Area Object Information’ window pops up. In the ‘Design’ tab of 
this window, set the ‘Rebar Material’ to ‘S460’ and press ‘OK’. Do this for both 
strips. 
 

f. Assigning load on the foundation column 
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To assign load on the foundation column, right click on the point at the center of 
the foundation column and a ‘Point Object Information’ window pops up. In this 
window, click on the ‘Loads’ tab.  
 
The dead load and the live load can be assigned through the ‘Assign Load…’ 
button. The procedure is: click on ‘Assign Load…’ button, then select ‘Force 
Loads’ then press ‘OK’ then select either ‘DEAD’ or ‘LIVE’ depending on which 
loads you want to enter their values then enter their values accordingly (both the 
concentrated load and the bending moment) and in the right direction (axis), then 
select ‘Add to Existing Loads’ and press ‘OK’. While doing this, the foundation 
column dimensions should be entered in the ‘Size of Load for Punching Shear’ 
box of ‘Point Loads’ window.  
 

 
Figure 209 

 
You can also delete any forces which are wrongly entered through ‘Delete 
Existing Loads’ radio button option. In this example, since the factored 
concentrated load is 100kN and since the bending moment about y-axis is 10kNm, 
these values are entered in the Gravity Direction for the concentrated load and 
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along y-axis for the bending moment and the final values are shown in the above 
figure. 

STEP 8: Running the Analysis 

After this, the analysis can be run. But, make sure that the footing and the 
foundation column are assigned with the correct rebar material. To do this, right 
click anywhere in the plan view of the footing and the ‘Slab-Type Area Object 
Information’ window will pop-up. 

 
Figure 210 

In the ‘Design’ tab of this window, set the value of ‘Rebar Material’ to ‘S460’. 
Do this for the column foundation, and both design strips as well. After this, go to 
the ‘Run’ menu and click on the ‘Run Analysis’ command. 

STEP 9: Displaying the Output 

Once the analysis is run, the output will be displayed. Particularly, the punching 
shear design is of great importance as the footing cannot be designed without the 
punching shear requirement being adequately satisfied. To do this, go to the ‘Run’ 
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menu and click on ‘Run Analysis & Design’ command or simply click on the ‘F5’ 
key. When you do this, you will be prompted to save the model, if you haven’t 
already don this. When you save the model, the following window showing the 
displacement of the soil in a banded figure will be displayed. 

 
Figure 211 

To display the punching shear ratio, go to the ‘Display’ menu and click on ‘Show 
Punching Shear Design’. After this, the punching shear ratio will be displayed in 
the plan view around the foundation column as in the following figure. 

 
Figure 212 

As can be noticed from the figure, the punching shear ratio is 0.1426 for the first 
column, 0.1564 for the second column and 0.0537 for the third column. Generally, 
a punching shear ratio less than one indicates the concrete thickness is adequate to 
resist punching shear and a value greater than one indicates that the punching shear 
capacity is exceeded somewhere along the critical section. For economical design, 
it is recommended to keep the punching shear ratio between 0.95 and 1 as very 
small values of punching shear ratio means excess concrete thickness is used. 
However, if the punching shear ratio is greater than one, like in this example, the 
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thickness of the concrete should be increased or the grade of the concrete should 
be increased and the foundation should be re-designed. A detailed quantitative 
description of the foundation design can also be obtained by right clicking any of 
the columns shown in Fig 213 as shown below. Several trial may be made by 
zooming in and out to get the quantitative description. 

 
Figure 213 

Through the ‘Display’ menu, relevant quantities can be displayed on the screen. 
For instance, the ‘Display’>’Show Strip Forces’ command or by simply clicking 
the ‘F8’ key, the following window will be displayed. 
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Figure 214 

In this window, the ‘Load Case/Load Combination’ box provides with radio 
buttons to select for which particular load case or load combination that we want 
to display the output. The ‘Component’ box contains four radio buttons to select 
which quantity to display. The ‘Show Forces For These Strip Layers’ box allows 
us to select the strip layer for which the quantity is displayed. Both strip layers can 
be selected at the same time. From the ‘Scaling’ box, we can select whether 
automatic scaling or user defined scaling is used while displaying the diagram. The 
‘Display Options’ box allows us to fill or not to fill the diagram and to display or 
not to display the values on the diagram. For the preferences shown in Fig. 68, the 
following diagram will be displayed. 
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Figure 215 

The ‘Display’>’Show Slab Design…’ command results in the window shown in 
Fig 216. In this window, several options can be set in order to display the footing 
design in the way we wanted to. The ‘Choose Display Type’ box allows us to 
select the ‘Design Basis’ between ‘Strip Based’ and ‘Finite Element Based’. 
Unless some differences in the way the design is displayed, there is no difference in 
the amount of reinforcement between these selections. Through the ‘Display 
Type’ in the same box, it can be selected whether to display flexural reinforcement 
or shear reinforcement. This box also allows us to impose or not to impose 
minimum reinforcement during the design. The ‘Rebar Location Shown’ box 
allows us to select which reinforcement, top or bottom or both, to be displayed. 
The ‘Reinforcing Display Type’ box allows us to set the manner in which the 
amount of reinforcement is displayed. The option whether to show the reinforcing 
envelop diagram and the reinforcing extent can be set by the check boxes in the 
‘Reinforcing Diagram’ window. The strip layer direction for which the amount 
of reinforcement is displayed can be chosen from the ‘Choose Strip Direction’ 
box. The ‘Display Options’ box allows us whether to display output in filled 
diagram or not and whether the values at controlling stations will be displayed or 
not. If we want to display the amount of reinforcement above some specified 
reinforcement bar area or spacing, we can use the options in the ‘Show Rebar 
Above Specified Value’ box. When the ‘Typical Uniform Reinforcing 
Specified Below’ radio button is selected, the ‘Typical Uniform Reinforcing’ 
box get activated. In this box, we can set a specific value above which the 
reinforcement amount will be displayed. The reinforcement diagram output, for the 
options set in Fig. 108, will be shown below in fig. 109. 
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Figure 216 

 
Figure 217 

As can be noticed from the footing design diagram in fig. 71, the top reinforcement 
across strip layer A is around 0mm2/m for top reinforcement and 1008smm2/m 
for bottom reinforcement. 
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The design outputs can also be displayed in tabular format by clicking on the ‘Show 
Tables…’ menu item from the ‘Display’ menu or by just clicking on the equivalent 

icon  from the tool bar below the menu bar and the following window will 
pop up. 

 
Figure 218 

In this window, we can select any of the model definitions or analysis results or 
design results and press ‘OK’ to display the quantity which we want to have a look 
at. By using the right hand side buttons in the window, the load patterns and the 
load cases can be selected. 

STEP 10: Detailing 

After running the analysis and after checking that the results are reasonable, the 
detailing will be done. However, before running the detailing, the detailing 
preferences can be set from the ‘Detailing’ menu. From the ‘Detailing 
Preferences…’, the likes of dimensional units and material quantity units can be 
selected. From ‘Slab/Mat Detailing Preferences…’, the likes of rebar 
curtailment options, the rebar detailing options, rebar selection rules and preferred 



 

204  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

rebar sizes can be selected. The ‘Drawing Sheet Set-up…’ menu allows us to set-
up the contents of the drawing sheet. The ‘Drawing Format Properties…’ allows 
us to set some formats in which the output displayed. 

To run the detailing, go to ‘Run’ menu and click on ‘Run Detailing…’ or 
simultaneously press  ‘Shift’ and ‘F5’ keys or just click on the run detailing icon 

 from the tool bar just below the menu bar. Then, the ‘Run Detailing 
Options’ window pops up so that we set the detailing options. Set the detailing 
options which you want and click ‘OK’. 

Once the detailing is run, the detailing can be displayed. The detailing display 
options can be best accessed from the ‘Model Explorer’. When expanded in full, 
the ‘Detailing’ tab of the model explorer looks like: 

 
Figure 219 

By clicking on any of the options from the detailing tab, a desired detailing can be 
displayed. For instance, by double clicking on the ‘Footing Table’, the following 
detail of footing can be shown. 
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Figure 220 

In this detail, the diameter of the reinforcement which is used is 10mm. If you want 
to change the diameter…. 

Apart from this detail, other details can also be shown.  

STEP 11: Reporting 

The last step of foundation design is reporting. Before creating the report, the 
report preferences should be set up. To do this, go to the ‘File’ menu and click on 
‘Report Set-up…’ and the following window pops up. 

In this ‘Report Setup Data’ window, the user preferences regarding the reporting 
such as the report output type, the report page orientation and the report items can 
be set along with the load patterns and load combinations. Once the preference is 
set, the report can be created by clicking on ‘Create Report’ command in the ‘File’ 
menu. The ‘Advanced Report Writer’ command in the same menu can be used to 
set some advanced reporting formats. 
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Figure 221 

This concludes the tutorial for the design of single footing using a model 
imported from AutoCAD. 

  



Design of Mat Foundation 
          
           Week 7-9
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4. Mat Foundation 
 

In this part of the tutorial, a mat foundation will be designed by using an imported 
model from AutoCAD. This is an advantageous procedure because geometrical 
asymmetries, different sizes of columns and different loadings can be 
accommodated by drawing a single AutoCAD drawing. Designing mat foundations 
from the built-in model is beneficial when the column dimensions and loadings are 
identical which may not often be the case. Thus, this procedure of designing 
foundations will not be considered in this tutorial. Of course, there is a possibility 
for modification of the inbuilt model once it is created. And creating mat 
foundation models by using grids may involve creating several grid lines especially 
when the geometry is asymmetrical and column dimensions are not identical. Thus, 
this way of creation of models will not be discussed. However, if these ways of 
creating the model are mandatory, the procedure of creating is no different from 
that of combined foundations which are discussed earlier. 

 

STEP 1: Creating the Model 

Design the mat foundation shown below with the given parameters: 

 
• Ultimate bearing capacity of the soil : 100kN/m2 
• Maximum allowable settlement of the foundation: 10mm 
• Grade of concrete: C-25 (25MPa 28-day characteristics cube strength) 
• Grade of reinforcement bar (rebar): S-400 (400MPa characteristics yield strength) 
• Overall thickness of the foundation: 1000mm 
• Concrete cover : 50mm 
• All the given loads are factored (ultimate) loads. 
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To create a footing model from an AutoCAD file, first draw the plan view of the 
foundation on AutoCAD. In this case, a rectangle with dimension of 10mX20m 
and a number of squares representing the foundation columns. When you draw the 
plan view on AutoCAD, make sure that you are drawing it on a new layer. If you 
want the origin of the SAFE mode to coincide with the center of the circular 
foundation, make the center of the circle coincide with the global origin of the 
AutoCAD file when you draw it. Then save the AutoCAD file in DXF format. To 
save an AutoCAD file in DXF format, go to ‘File’ menu in the AutoCAD file and 
click on ‘Save As’. At the bottom of the upcoming window, just below the text 
field where you will enter the file name, you will see ‘Files of type’ with a drop-
down menu list. From the drop down menu list, select the option which has ‘(.dxf)’ 
at the end. Then enter the file name and save it at any location in your computer 
where you can easily remember close it. This saves the file in DXF format. 

Once you saved the AutoCAD file in DXF format, open the SAFE software and 
when you use the command ‘File’>’Import’>’.DXF/.DWG Architectural Plan’ 
or when you simultaneously click on ‘Ctrl’+’Shift’+’I’ keys, and you will be 
prompted to open a file.  Open the DXF file from the location where you saved it 
and the following window will pop up. 

In this window, just change the ‘CAD Drawing Units’ to ‘m’ since in the 
AutoCAD file is the model is drawn in meter units. Then press ‘OK’. 
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Figure 222 

Then, the following model appears in the plan view. 

 
Figure 223 



 

210  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

After the model is created, the preferences regarding the units, the design codes 
and concrete cover should be entered. To change the units, click on ‘Units…’ 
button which is found in the right bottom corner of the main window and the 
following widow will pop up. In this window, click on ‘Metric Defaults’ and press 
‘OK’ as we will be using metric units. If you want to use U.S. units click on ‘U.S. 
Defaults’ and if you want to use a particular metric or U.S. unit consistently click 
on ‘Consistent Units…’ and select that particular unit which you want to use 
consistently. 

 

Figure 224 

To select the design code and other design preferences, go to ‘Design’ menu and 
click on ‘Design Preferences…’ and the following window will pop up. In the 
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‘Code’ tab of this window, change the ‘Design Code’ to ‘BS 8110-1997’ or any 
other code which you want to design the circular foundation with. In the ‘Min. 
Cover Slabs’ tab, for ‘Non-Prestressed Reinforcement’ , both the ‘Clear Cover 
Top’ and ‘Clear Cover Bottom’ should be set to 50mm as the concrete cover in 
this design problem stated to be 50mm. The ‘Preferred Bar Size’ can be set to any 
reasonable value. Here, the ‘Preferred Bar Size’ is set to #14 which is the bar 
number which will be used as the main reinforcement in the foundation. Leave the 
rest as they are and press ‘OK’. 

 
Figure 225 

STEP 2: Defining Material Properties 

The materials which are involved in the design of the footing should be defined 
before the analysis. These materials are the concrete, the reinforcement bar (rebar) 
and the soil support. Thus, these properties will be defined here. 

The material definition can be carried out in two ways. 

The first one is through the ‘Define’ menu in the menu bar. The other one through 
the model explorer on the left hand side of the home window. To define material 
properties through the former method, click on ‘Define’ menu and again click on 
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‘Materials…’ resulting in the following window depending on prior material 
definitions. 

The list in the ‘Materials’ box may not be exactly as it appears in your widow. 
However, that doesn’t bring any change in the outcome of the design process as 
you can customize this list any time. 

The ‘Add New Material Quick…’ button allows you to define materials quickly 
from a list of pre-defined materials. The ‘Add New Material’ button allows you 
to define materials by changing their properties. The ‘Add Copy of Material’ 
button allows you to define a material with same property as an already defined 
material. The ‘Modify/Show Material’ button displays the property of an already 
defined material with the possibility of modification. The ‘Delete Material’ button, 
when active, deletes a defined material property. 

 
Figure 226 

For this particular problem, we will add new concrete and a rebar materials using 
the ‘Add New Material…’ button. Thus click on this button and the following 
window will pop up. 

This is the window where concrete properties will be modified. Put any name for 
the material in the text field in front of ‘Material Name’. But, it is important to 
make sure that the concrete with the defined material name is assigned for the 
footing. For this particular problem, let us use the name of the concrete as ‘C25’. 
Since we are defining a concrete, the ‘Material Type’ should be set to ‘Concrete’.  

The unit weight of reinforced concrete may vary depending of the design code of 
your country. Thus, enter the unit weight of reinforced concrete stipulated in your 
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country code in the text field in front of ‘Weight per Unit Volume’. For this 
particular example, we will use 25kN/m3. 

 

 
Figure 227 

For C-20 concrete, the modulus of elasticity according to BS 8110-1197 is around 
29GPa. Thus, enter this value in the text field in front of ‘Modulus of Elasticity, 
E’. If you selected another design code in step 1 while creating the model, you 
should refer to actual value of this parameter from the code and enter it accordingly. 
Be aware of the units though. 

The values of Poisson’s ratio and coefficient of thermal expansion may also be 
defined in the design code and should be entered accordingly. For this particular 
problem, a value of 0.2 for ‘Poisson’s Ratio, U’ and a value of 10x10-6/oC for 
‘Coefficient of Thermal Expansion, A’ will be entered. The ‘Shear Modulus, G’ 
will be automatically calculated in an un-editable text field. 

The grade of concrete for this particular problem is C-25 which is a concrete with 
28 day characteristics cube compressive strength of 20MPa. The concrete 
designation may be different for different country codes but the concept is the 
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same. Therefore, enter 25 in the text field in front of ‘Concrete Cube 
Compressive Strength, fcu’. 

If a lightweight concrete is used, check on ‘Lightweight Concrete’ and enter the 
corresponding ‘Shear Strength Reduction Factor’ in the space provided. 

When you press on ‘OK’, a concrete material with the above properties will be 
added to the list of materials. This material will be assigned for the footing before 
the analysis. 

After adding a new concrete property, the program returns to the window shown 
in Fig. 226 To define a rebar property, we will follow the same procedure as we 
followed while defining the concrete property. Since a new rebar property will be 
defined, click on the ‘Add New Material…’ button. A ‘Material Property Data’ 
window pops up and when you change the ‘Material Type’ to ‘Rebar’, the window 
appears to look like the following. 

 
Figure 228 

Change the ‘Material Name’ to any name you want. Here, we name it ‘S400’. The 
material type should be ‘Rebar’. The weight per unit volume of steel is stipulated 
in the design code. For BS 8110-1197, the weight per unit volume is 77.0085kN/m3. 
Thus, enter this value in the text field in front of ‘Weight per Unit Volume’. The 
modulus of elasticity for reinforcement bars according to the same design code is 
200GPa. Thus enter this value in the text field in front of ‘Modulus of Elasticity, 
E’ considering the unit. 
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In the ‘Other Properties for Rebar Materials’ box, two quantities are mentioned: 
minimum yield stress and minimum tensile stress for the reinforcing material. The 
values of these parameters will be specified in the design code which you defined 
earlier. If the code assumes that the rebar material exhibits elastic perfectly plastic 
behavior, the values of these two quantities will be the same. The grade of steel to 
be used for this particular example is S-400. The yield stress for this type of 
reinforcement bar is 400MPa. Since the design code of my country assumes that 
rebars exhibit elastic perfectly plastic behavior, the minimum tensile stress will also 
be 400MPa. Thus enter 400 in both text fields in front of the ‘Minimum yield 
stress, Fy’ and ‘Minimum Tensile Stress, Fu’. Then press ‘OK’ in both 
‘Material Property Data’ and ‘Materials’ windows concluding the material 
definition step. 

The other property which should be defined is the soil support. To define the soil 
properties, go to the ‘Define’ menu and click on ‘Soil Subgrade Properties’ menu 
item and the following window appears. 

 
Figure 229 

By using the buttons in this window, a new soil property or copy of soil property 
can be added. An existing soil property can also be modified or deleted. For this 
problem, let us add a new soil property by using the ‘Add New Property…’ 
button. Thus, click on this button and the following window pops up.  
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Figure 230 

In this window, set the property name to ‘SOIL’ and change the subgrade modulus 
to 10,000kN/m3. Because, the subgrade modulus which can be assume by the ratio 
of the bearing capacity by the allowable settlement for this particular example is so. 
Then press ‘OK’ in both the ‘Soil Subgrade Property Data’ and ‘Soil Subgrade 
Properties’ windows. 

STEP 3: Defining Footing and Column Properties 

After defining the material properties, the footing and column properties can be 
defined. This definition can take place in two ways: from the menu bar and from 
the model explorer. In SAFE software, footings are modelled as ‘footings’ and 
foundation columns are modelled as ‘stiff’.  

To define footing and column properties from the menu bar, go to ‘Define’ menu 
and click on ‘Slab Properties…’. The following window will pop up. 

The ‘Add New Property…’ button prompts the user to enter new properties for 
the footing and foundation column while the ‘Add Copy of Property…’ copies 
the property of an existing slap. The ‘Modify/Show Property…’ allows the user 
to show the property of an existing component with the possibility of modification. 
When the ‘Delete Property’ button is active, it allows the user to delete an existing 
slab property. 
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Figure 231 

In this case, we use the ‘Add New Property…’ button to add new slab properties 
for the footing and foundation column. Click the button and the following window 
will pop up. 

 
Figure 232 

The ‘Property Name’ can be assigned with any name; but, in this case, the property 
name which will be used is ‘Mat’. The ‘Slab Material’ should be set to the concrete 
grade which is defined in step 2. Since the name of the concrete material defined in 
step 2 for this particular problem is ‘C25’, a material with this name should be 
selected from the list. 
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In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Mat’. The 
‘Thickness’ value should be set to the thickness of the footing defined in the 
example. Since the thickness of the footing is 1000mm, this value is entered in the 
text field corresponding to ‘Thickness’. As footings are modelled as thick plates, 
check the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected when a 
footing with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Now, the property of the foundation 
column will be added. To do this, again click on the ‘Add New Property…’ button. 
The following window appears after the click. 

 
Figure 233 

The ‘Property Name’ can be any name but we use ‘STIFF’. The ‘Slab Material’ 
should be set to the concrete grade which is defined in step 2. Since the name of 
the concrete material defined in step 2 for this particular problem is ‘C25’, a material 
with this name should be selected from the list. 

In the ‘Analysis Property Data’ box, ‘Type’ should be set to ‘Stiff’ as we are 
defining the property of column. The ‘Thickness’ value should equal to the 
thickness of the mat. As foundation columns are modelled as thick plates, check 
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the ‘Thick Plate’ option. The ‘Orthotropic’ check box is selected when a column 
with irregular dimension is to be used. 

When you press ‘OK’, the ‘Slab Property Data’ window will be exited and the 
‘Slab Properties’ window gets activated. Again press ‘OK’ and exit the window for 
defining the footing and foundation column. 

STEP 4: Defining Load Patterns, Load Cases and Load Combinations 

The loads on the foundation should be defined accordingly before the analysis. 
First, the load pattern should be defined. This can be done from the ‘Define’ menu 
or from the ‘Model Explorer’. This time, we will do it from the model explorer. 
In the model explorer, expand ‘Load Definitions’ and you will see ‘Load 
Patterns’. When you expand ‘Load Patterns’, you will see ‘DEAD’ and ‘LIVE’. 
At the end, the model explorer appears to look like: 

 
Figure 234 

Now, right click on ‘Load Patterns’ and click on ‘New Load Pattern’ and the 
following window pops up. 
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Figure 235 

In the ‘Load Patterns’ window, two load patterns are already defined: ‘DEAD’ 
and ‘LIVE’. The ‘Type’ of the ‘Load’ should also be changed accordingly. There 
are many options for type of loading. The ‘Type’ for dead loads should be set to 
‘DEAD’ and for live loads ‘LIVE’. If there are other types of load patterns on the 
foundation such as earth quake load, you can add the load pattern with the ‘Add 
Load Pattern’ button. You can also delete any undesirable load pattern using the 
‘Delete Load Pattern’ button. Since in this example, we have only dead and live 
loads, we will leave the existing load patterns as they are. The ‘Self Weight 
Multiplier’ value should also be changed accordingly. This value imparts the option 
whether to consider or ignore the self-weight of the foundation in addition to 
external loads. If the self-weight of the foundation is already included as an external 
dead load or if you want to exclude the effect of self-weight from the analysis, the 
value under ‘Self Weight Multiplier’ should be set to zero. In this example, we 
will consider the self-weight as an additional load to the external dead load. Thus, 
the value under ‘Self Weight Multiplier’ for the ‘DEAD’ load is one. For the 
‘LIVE’ load, it will be zero. Press ‘OK’ and the window will be exited. 

After this, the load cases will be defined. Load cases are used to dictate the way the 
loads are applied (statically or dynamically) or the way the structure responds 
(linearly or non-linearly) for the defined load patterns. To define a load case, go to 
‘Define’ menu and click on ‘Load Cases…’. The following window will pop up 
after the click. 
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Figure 236 

The load patterns which were defined earlier will automatically appear in the list of 
‘Load Case Name’ of the ‘Load Cases’ window. The ‘Load Case Type’ column 
shows the way in which each load pattern will be applied during analysis. If you 
want to modify this, highlight the load pattern for which you are going to change 
the load case type and click on the ‘Modify/Show Case…’ button. If you click 
this button, the following window will appear. In this window, you can change the 
way the load is applied from the ‘Load Case Type’ box. The way the structure 
responds can also be selected from the ‘Analysis Type’ box. This problem ‘Static’ 
is for the ‘Load Case Type’ and ‘Linear’ is selected for the ‘Analysis Type’ since 
the load is static and the foundation responds linearly. The scale factor for the dead 
load in the ‘Loads Applied’ box will be left as one. Press ‘OK’ and exit the window. 

The load case type for the live load should also be ‘Linear Static’. Otherwise, it 
should be changed by clicking the ‘Modify/Show Case…’ button to linear static 
case. If both the load case types are as desired click ‘OK’ and exit the ‘Load Cases’ 
window. 
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Figure 237 

Definition of the load combinations will be the next step. Since the loads are 
factored, only one load combination will be considered. To define load 
combination, go to ‘Define’ menu and click on ‘Load Combinations…’ and the 
following window pops up. 

 
Figure 238 
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New load combinations will be added through the ‘Add New Combo…’ button. 
The load combination which will be considered is factoring only the self-weight 
which is considered as a dead load and the other factored loads will be considered 
as live loads for convenience and the scaling factor for the live loads will be one. 
When the ‘Add New Combo…’ button is clicked, the following window appears. 

 
Figure 239 

In the ‘Load Combination Data’ window, any name can be given for the load 
combination. The ‘Combination Type’ should be set to ‘Linear Add’ as the 
component loads (dead and live) will be added linearly. However, there are also 
other options from the drop down menu in front of ‘Combination Type’. In the 
window shown in Fig. 239, the two loads (dead and live) should be activated below 
the ‘Load Name’ column of the ‘Define Combination of Load Case/Combo 
Results’ box. The values in the ‘Scale Factor’ column correspond to the partial 
safety factors for load for the failure mode under consideration. These partial safety 
factors are specified in the design code of your country. In the design code of my 
country, the partial safety factor for dead loads for ultimate limit sate case is 1.3 for 
the case where there are only dead and live loads. For such load patterns, the partial 
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safety factor for live loads for ultimate limit sate case would have been 1.6. But, in 
this case, since the loads are already factored and for convenience reason since the 
factored loads are considered as live loads, a scaling factor of unity will be used. 
Thus, enter a value of 1.3 in front of ‘DEAD’ and 1 in front of ‘LIVE’ in ‘Scale 
Factor’ column. The failure condition which is being under consideration can be 
defined by selecting and deselecting the check boxes in the ‘Design Selection’ box. 
The serviceability limit state will not be considered for this case. 

STEP 6: Drawing the Footing Components and Design Strips 

The footing, the foundation column and a point where the loads will be applied on 
the foundation column should now be drawn on the grid. 

k. Drawing the mat 
The footing will be drawn as a rectangular slab. Thus, go to the ‘Draw’ menu 
and click on ‘Draw Rectangular Slabs/Areas…’ or click on the equivalent 

icon from the left hand side tool bar and the following window will pop 
up. 

 
Figure 240 

Make sure that the ‘Property’ is set to ‘Mat’ and click at one corner of the 
footing. Then, without releasing the click, drag into the opposite corner and 
release the click. This draws a rectangular footing. 

vi. Drawing the foundation column 
While the window in fig 240 is active, change the ‘Property’ to ‘STIFF’ and 
draw the three columns by following a similar procedure which you used 
while drawing the footing. 

vii. Drawing the points on the foundation columns where the load will be applied 
Go to ‘Draw’ menu and click on ‘Draw Points’, then click on the mid-point 
of each of the footing and the pointss will be created. If the cursor could not 
snap to the midpoint, you can adjust the ‘Snap Options’ from the ‘Draw’ 
menu. 

After this, the design strips will be drawn. Design strips determine the way in which 
different quantities related to the reinforcement calculation are calculated. Forces 
are integrated across the design strips. Thus, the larger the width of coverage of the 
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design strips within the given structure, the higher will be the calculated values of 
the bending moments and shear forces. Thus, an optimum width of strip is required 
compromising the safety and economical requirements. The width of the design 
strip will be specified in the design code. According to the code of my country, the 
width of design strips for combined foundations in the longitudinal direction 
should cover the whole area of the footing. In this particular problem, the width of 
the strips in x-direction is 1.8m. The design strips in the transverse direction will be 
defined for each column and should extend to a distance of half the depth of the 
footing from the face of the column on each side. These design strips in X and Y 
direction are usually defined in SAFE software as layer A and layer B. 

To draw the design strip, go to the ‘Draw’ menu and click on ‘Design Strips’ or 

simply click on the equivalent icon from the left hand sided tool bar and the 
following window pops up. Column strips of width 2m around each column will 
be drawn in both directions. The remaining spaces between the columns strips will 
be filled with middle strips. 

 
Figure 241 

In this window, the ‘Strip Layer’ should be selected to be either ‘A’ or ‘B’. But if 
‘A’ is for design strip in X direction ‘B’ should be for Y direction and vice versa. 
The window in fug 241 is for the column strip in Y direction. The column strip in 
X direction can be drawn by just changing the ‘Strip Layer’ to ‘B’. The ‘Draw 
Design Strips’ windows for middle strips in X and Y directions are shown in fig. 
242(a) and fig. 2242(b) respectively. 



 

226  BY: ASAYE CHEMEDA       (E-mail: asayechemeda@yahoo.com) 
 

AMBO UNIVERSITY                         CIVIL ENGINEERING DEPARTMENT 2016 

(b)                                                           (b) 
Figure 242 

You can display the design strips by setting the display options by clicking on ‘Set 
Display Options…’ from the ‘View’ menu or by simultaneously clicking on ‘Ctrl’ 
and ‘W’ keys or by just clicking on the set display options icon  from the tool 
bar below the menu bar. This results in the following window: 

 
Figure 243 

Then, check on ‘Labels’, ‘Show Width’ and ‘Show Stations’ in the ‘Design Strip 
Objects’ box and press ‘OK’ and after drawing dimension lines by using the 
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command ‘Draw’>’Draw Dimension Lines’, the following window appears 
displaying the design strips in the two directions. 

 
Figure 244 

STEP 7: Assigning Slab Data, Support Data and Load Data 

The slab data, support data, and load data which are defined in the previous steps 
should be assigned to the corresponding structural component. The way to do this 
is first to select the component and next to assign the slab property, support 
property or loads accordingly. The selection can be done by clicking on the 
component from the plan view or through the ‘Select’ menu. The latter option 
assures that the component is selected exactly as selection by clicking may result in 
incorrect selection. Thus, all the selections here will be done from the ‘Select’ 
menu. The assignments will be discussed as follows: 

g. Assigning support data to the footing 
Select the footing through the following strings of commands 
‘Select’>’Select’>’Properties’>’Slab Properties…’. Then select ‘FOOTING’ 
and press ‘OK’. Then assign the footing property through the following strings of 
commands ‘Assign’>’Support Data’>’Soil Properties…’. Then select ‘SOIL’ 
and press ‘OK’. 
 

h. Assigning reinforcement data to the design strips 
Select each design strip through the following strings of commands 
‘Select’>’Select’>’Properties’>Design Strip Layers…’. Then select ‘A’ or ‘B’ 
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(one at a time) and press ‘OK’. When you right click on the selected strip layer, the 
‘Slab-Type Area Object Information’ window pops up. In the ‘Design’ tab of 
this window, set the ‘Rebar Material’ to ‘S400’ and press ‘OK’. Do this for all 
strips. 
 

i. Assigning load on the foundation column 
To assign load on the foundation column, right click on the point at the center of 
the foundation column and a ‘Point Object Information’ window pops up. In this 
window, click on the ‘Loads’ tab.  
 
The dead load and the live load can be assigned through the ‘Assign Load…’ 
button. The procedure is: click on ‘Assign Load…’ button, then select ‘Force 
Loads’ then press ‘OK’ then select either ‘DEAD’ or ‘LIVE’ depending on which 
loads you want to enter their values then enter their values accordingly (both the 
concentrated load and the bending moment) and in the right direction (axis), then 
select ‘Add to Existing Loads’ and press ‘OK’. While doing this, the foundation 
column dimensions should be entered in the ‘Size of Load for Punching Shear’ 
box of ‘Point Loads’ window.  
 

 
Figure 245 
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You can also delete any forces which are wrongly entered through ‘Delete 
Existing Loads’ radio button option. In this example, for column 1, since the 
factored concentrated load is 500kN and since the bending moments about x-axis 
and y-axis respectively are 70kNm and 100kNm, these values are entered in the 
Gravity Direction for the concentrated load and along the respective axes for the 
bending moment and the final values are shown in the above figure. The loading 
for the rest columns will be entered in a similar way. 

STEP 8: Running the Analysis 

After this, the analysis can be run. But, make sure that the footing and the 
foundation column are assigned with the correct rebar material. To do this, right 
click anywhere in the plan view of the footing and the ‘Slab-Type Area Object 
Information’ window will pop-up. 

 
Figure 246 

In the ‘Design’ tab of this window, set the value of ‘Rebar Material’ to ‘S400’. 
Do this for all column foundations, and all design strips as well. After this, go to 
the ‘Run’ menu and click on the ‘Run Analysis’ command. 

STEP 9: Displaying the Output 
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Once the analysis is run, the output will be displayed. Particularly, the punching 
shear design is of great importance as the footing cannot be designed without the 
punching shear requirement being adequately satisfied. To do this, go to the ‘Run’ 
menu and click on ‘Run Analysis & Design’ command or simply click on the ‘F5’ 
key. When you do this, you will be prompted to save the model, if you haven’t 
already don this. When you save the model, the following window showing the 
displacement of the soil in a banded figure will be displayed. 

 
Figure 247 

To display the punching shear ratio, go to the ‘Display’ menu and click on ‘Show 
Punching Shear Design’. After this, the punching shear ratio will be displayed in 
the plan view around the foundation column as in the following figure. 

 
Figure 248 
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As can be noticed from the figure, the punching shear ratio is 0.164 for the first 
column, ‘N/C’ for the second, fifth and eighth columns. This usually happens 
when the column dimension is not entered when the loads are assigned or when 
the mat thickness is inappropriate. In this example, all the column dimensions are 
entered correctly and the reason for the appearance of ‘N/C’ on some of the 
columns is due to inappropriate mat thickness. For the rest columns, the punching 
shear ratio is well below unity. Generally, a punching shear ratio less than one 
indicates the concrete thickness is adequate to resist punching shear and a value 
greater than one indicates that the punching shear capacity is exceeded somewhere 
along the critical section. For economical design, it is recommended to keep the 
punching shear ratio between 0.95 and 1 as very small values of punching shear 
ratio means excess concrete thickness is used.  

Thus, to get an acceptable punching shear ratio, change the thickness of the slab to 

600mm. To do this, first unlock the model by pressing button    from the list of 
buttons below the menu bar. Then, go to the ‘Define’ menu and click on ‘Slab 
Properties’. After this, highlight ‘Mat’ and ‘STIFF’ one at a time and click on 
‘Show/Modify Properties’ button and change the value for ‘Thickness’ to ‘600’. 

After this, if you click on ‘Run’ > ‘Run Analysis & Design’, the following window 
will appear. 

 
Figure 249 
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If you click on ‘Display’ > ‘Show Punching Shear Design’, the following will be 
displayed on the screen. 

 
Figure 250. 

It can be seen from the above punching shear design diagram that all the punching 
shear ratios are acceptable. 

Through the ‘Display’ menu, relevant quantities can be displayed on the screen. 
For instance, the ‘Display’>’Show Strip Forces’ command or by simply clicking 
the ‘F8’ key, the following window will be displayed. 
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Figure 251 

In this window, the ‘Load Case/Load Combination’ box provides with radio 
buttons to select for which particular load case or load combination that we want 
to display the output. The ‘Component’ box contains four radio buttons to select 
which quantity to display. The ‘Show Forces For These Strip Layers’ box allows 
us to select the strip layer for which the quantity is displayed. Both strip layers can 
be selected at the same time. From the ‘Scaling’ box, we can select whether 
automatic scaling or user defined scaling is used while displaying the diagram. The 
‘Display Options’ box allows us to fill or not to fill the diagram and to display or 
not to display the values on the diagram. For the preferences shown in Fig. 251, 
the following diagram will be displayed. 
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Figure 252 

The ‘Display’>’Show Slab Design…’ command results in the window shown in 
Fig 254. In this window, several options can be set in order to display the footing 
design in the way we wanted to. The ‘Choose Display Type’ box allows us to 
select the ‘Design Basis’ between ‘Strip Based’ and ‘Finite Element Based’. 
Unless some differences in the way the design is displayed, there is no difference in 
the amount of reinforcement between these selections. Through the ‘Display 
Type’ in the same box, it can be selected whether to display flexural reinforcement 
or shear reinforcement. This box also allows us to impose or not to impose 
minimum reinforcement during the design. The ‘Rebar Location Shown’ box 
allows us to select which reinforcement, top or bottom or both, to be displayed. 
The ‘Reinforcing Display Type’ box allows us to set the manner in which the 
amount of reinforcement is displayed. The option whether to show the reinforcing 
envelop diagram and the reinforcing extent can be set by the check boxes in the 
‘Reinforcing Diagram’ window. The strip layer direction for which the amount 
of reinforcement is displayed can be chosen from the ‘Choose Strip Direction’ 
box. The ‘Display Options’ box allows us whether to display output in filled 
diagram or not and whether the values at controlling stations will be displayed or 
not. If we want to display the amount of reinforcement above some specified 
reinforcement bar area or spacing, we can use the options in the ‘Show Rebar 
Above Specified Value’ box. When the ‘Typical Uniform Reinforcing 
Specified Below’ radio button is selected, the ‘Typical Uniform Reinforcing’ 
box get activated. In this box, we can set a specific value above which the 
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reinforcement amount will be displayed. The reinforcement diagram output, for the 
options set in Fig. 253, will be shown below in fig. 254. 

 
Figure 253 

 
Figure 254 
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The design outputs can also be displayed in tabular format by clicking on the ‘Show 
Tables…’ menu item from the ‘Display’ menu or by just clicking on the equivalent 

icon  from the tool bar below the menu bar and the following window will 
pop up. 

 
Figure 255 

In this window, we can select any of the model definitions or analysis results or 
design results and press ‘OK’ to display the quantity which we want to have a look 
at. By using the right hand side buttons in the window, the load patterns and the 
load cases can be selected. 

STEP 10: Detailing 

After running the analysis and after checking that the results are reasonable, the 
detailing will be done. However, before running the detailing, the detailing 
preferences can be set from the ‘Detailing’ menu. From the ‘Detailing 
Preferences…’, the likes of dimensional units and material quantity units can be 
selected. From ‘Slab/Mat Detailing Preferences…’, the likes of rebar 
curtailment options, the rebar detailing options, rebar selection rules and preferred 
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rebar sizes can be selected. The ‘Drawing Sheet Set-up…’ menu allows us to set-
up the contents of the drawing sheet. The ‘Drawing Format Properties…’ allows 
us to set some formats in which the output displayed. 

To run the detailing, go to ‘Run’ menu and click on ‘Run Detailing…’ or 
simultaneously press  ‘Shift’ and ‘F5’ keys or just click on the run detailing icon 

 from the tool bar just below the menu bar. Then, the ‘Run Detailing 
Options’ window pops up so that we set the detailing options. Set the detailing 
options which you want and click ‘OK’. 

Once the detailing is run, the detailing can be displayed. The detailing display 
options can be best accessed from the ‘Model Explorer’. When expanded in full, 
the ‘Detailing’ tab of the model explorer looks like: 

 
Figure 256 
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By clicking on any of the options from the detailing tab, a desired detailing can be 
displayed. For instance, by double clicking on the ‘Rebar Plan’, the following detail 
of footing can be shown. 

 
Figure 257 

In this detail, the diameter of the reinforcement which is used is 10mm. If you want 
to change the diameter…. 

Apart from this detail, other details can also be shown.  

STEP 11: Reporting 

The last step of foundation design is reporting. Before creating the report, the 
report preferences should be set up. To do this, go to the ‘File’ menu and click on 
‘Report Set-up…’ and the following window pops up. 

In this ‘Report Setup Data’ window, the user preferences regarding the reporting 
such as the report output type, the report page orientation and the report items can 
be set along with the load patterns and load combinations. Once the preference is 
set, the report can be created by clicking on ‘Create Report’ command in the ‘File’ 
menu. The ‘Advanced Report Writer’ command in the same menu can be used to 
set some advanced reporting formats. 
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Figure 258 

This concludes the tutorial for the design of single footing using a model 
imported from AutoCAD. 

 



Design of Pile and Pile Cap 
          
          Week 8-10



Here is the link to design pile and pile cap
 

https://www.youtube.com/watch?v=bAChWRTOlXY&list=PLxle8F-wJI7OjnpifedqKj5SoR1Ea5QoG&index=5







